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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

• Thorough knowledge of planning and production processes

• Thorough knowledge of Oracle Bills of Material

• Working experience with Oracle Bills of Material

• Knowledge of the manufacturing processes

• Thorough knowledge and proficiency in navigating Oracle applications

• Working experience with inventory items and bills of material, planning
and forecasts, product with offered-options

• Thorough knowledge of setting up items and bills of material as well as
the typical business requirements for processing engineering changes.

• Working experience with Oracle Engineering and Oracle Bills Of
Material.

Prerequisites

• Oracle Inventory

• Defining & Maintaining Items (Inventory)

• Creating Bill of Materials (BOMs)

• Creating Bills of Material (e-class)

• R11i – Setting Up and Implementing Engineering

How This Course Is Organized

R11i, Implement and Use Oracle Engineering and Bill of Materials is an
instructor-led course featuring lecture and hands-on exercises.  Online
demonstrations and written practice sessions reinforce the concepts and skills
introduced.
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Related Publications

Oracle Publications

Title Part Number

Oracle Bills of Material User’s Guide, Release 11i A75087-01

Oracle Engineering User’s Guide, Release 11i A75090-01

Oracle Inventory User’s Guide A83507-01

Oracle Bills of Material User’s Guide A75087-01

Oracle Master Scheduling/MRP and Oracle Supply Chain Planning User’s Guide
A82941-01

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implement and Use Oracle Engineering and Bill of Materials Table of Contents
xiii

(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Maintaining Engineering
Items
Chapter 1



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle BOM and Engineering: Defining and Maintaining Engineering Items
Chapter 1 - Page 2

R11i Oracle BOM and Engineering: Defining and
Maintaining Engineering Items

Copyright   Oracle Corporation,  2000. All rights reserved.
®

R11i Oracle BOM and Engineering:
Defining and Maintaining

Engineering Items

R11i Oracle BOM and Engineering:
Defining and Maintaining
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ObjectivesObjectives

After completing this course you should be able to do
the following:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups

After completing this course you should be able to do
the following:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Using Oracle Applications Help
 Within a Window

Using Oracle Applications Help
 Within a Window

Any window launched from the Oracle Navigator will
link to online help. Select Help—>Window Help from
the menu bar. Oracle Applications Help displays
detailed information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
Note: The Library topic contains help for products.

Any window launched from the Oracle Navigator will
link to online help. Select Help—>Window Help from
the menu bar. Oracle Applications Help displays
detailed information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
Note: The Library topic contains help for products.

Help Note

You can launch Oracle Help using the toolbar “?” icon only from a window that is
open from the Navigator. If you launch Oracle Help from a window that is opened
via the menu bar, a button, or pop up window, you will receive a http://404 - no
data found error.
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Searching Oracle Applications HelpSearching Oracle Applications Help

1. From any window within an Oracle Application
select Help—>Window Help from the menu bar.

2. The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Find field and click Find.
4. Select a topic to view detailed information.
Note: Select Search Instructions for help when
searching Oracle Applications Help.

1. From any window within an Oracle Application
select Help—>Window Help from the menu bar.

2. The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Find field and click Find.
4. Select a topic to view detailed information.
Note: Select Search Instructions for help when
searching Oracle Applications Help.

Help Note

You can only launch Oracle Help using the toolbar “?” icon from a window that is
open from the Navigator. If you launch Oracle Help from a window that is opened
via the menu bar, a button, or pop up window, you will receive a http://404 - no
data found error.
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Engineering and Manufacturing ItemsEngineering and Manufacturing Items

• Engineering items are items that your engineering
function creates and that are not ready for
production (created in Oracle Engineering).

• Manufacturing items are items you use in
production (created in Oracle Inventory).

• Engineering items are items that your engineering
function creates and that are not ready for
production (created in Oracle Engineering).

• Manufacturing items are items you use in
production (created in Oracle Inventory).
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Engineering and Manufacturing ItemsEngineering and Manufacturing Items

How do they differ?
• Engineering items have the item attribute

engineering item selected.
• Manufacturing items have the item attribute

engineering item.
• Engineering items are not visible in Oracle

Inventory.

How do they differ?
• Engineering items have the item attribute

engineering item selected.
• Manufacturing items have the item attribute

engineering item.
• Engineering items are not visible in Oracle

Inventory.

Engineering and Manufacturing Items
Engineering flag is not visible in Oracle Inventory.
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Engineering and Manufacturing Items

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Engineering and Manufacturing ItemsEngineering and Manufacturing Items
Perform the same item functions with engineering
items that you do with production items, including
the following:

– Create item revisions
– Perform stock movements and valuation
– Perform cost rollup
– Perform material planning
– Sell and ship to customers
– Buy on purchase orders or internal

requisitions
– Make on and issue to discrete jobs and

repetitive schedules

Perform the same item functions with engineering
items that you do with production items, including
the following:

– Create item revisions
– Perform stock movements and valuation
– Perform cost rollup
– Perform material planning
– Sell and ship to customers
– Buy on purchase orders or internal

requisitions
– Make on and issue to discrete jobs and

repetitive schedules
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Engineering and Manufacturing Items
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Engineering and Manufacturing ItemsEngineering and Manufacturing Items

• Prototype items that are not ready for production.• Prototype items that are not ready for production.

ItemsItems

EngineeringEngineering ProductionProduction

Engineering and Manufacturing Items
The windows that you use to create engineering and manufacturing items are
identical. They differ only in the following ways:

• You create and change engineering items using the Oracle Engineering
windows. You can create and change manufacturing items using the
Oracle Inventory forms.

• When your engineering items are ready for production, you can transfer or
copy them to Oracle Inventory as manufacturing items. When you transfer
an engineering item, it becomes a manufacturing item. When you copy an
engineering item, it remains and you create a manufacturing item with a
different item number.
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Engineering Master ItemEngineering Master Item

• With the Master Item window, you can define and
update items and the attributes associated with
them e.g., description, lead time, unit of measure
(UOM), lot control, and etc).

• With the Master Item window, you can define and
update items and the attributes associated with
them e.g., description, lead time, unit of measure
(UOM), lot control, and etc).

Engineering Master Item

Use this window to create and change engineering items in the same way that you
use the corresponding Oracle Inventory window to create and change production
items.

(N) Prototypes > Items > Master Items

(Help) Oracle Inventory > Items > Defining Items



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle BOM and Engineering: Defining and Maintaining Engineering Items
Chapter 1 - Page 13

Engineering Master Item

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Engineering Master ItemEngineering Master Item

Main
Inventory
Bill of Materials
(BOM)
Costing
Purchasing

Receiving
Physical attributes
General
MPS/MRP
Planning

Lead times
WIP
OM
Invoicing
Service
Web option

Much of the information for an item is optional. You
define only the information you need to maintain the
item in the following tabs:

Much of the information for an item is optional. You
define only the information you need to maintain the
item in the following tabs:
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AgendaAgenda
• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Item TemplatesItem Templates

• Templates are defined sets of attributes that you
can reuse to create many similar items. Templates
make initial item definition easier.

• If attribute item template is null, it will not change
a pre-set item attribute.

• When you apply a template to an item, you copy all
existing, non-blank attribute values from the
template to the item.

• You may apply multiple templates to a single item.
The last values assigned are retained, and blanks
don’t overlay assigned values.

• Item templates change item attributes
consistently.

• Templates are defined sets of attributes that you
can reuse to create many similar items. Templates
make initial item definition easier.

• If attribute item template is null, it will not change
a pre-set item attribute.

• When you apply a template to an item, you copy all
existing, non-blank attribute values from the
template to the item.

• You may apply multiple templates to a single item.
The last values assigned are retained, and blanks
don’t overlay assigned values.

• Item templates change item attributes
consistently.
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Engineering Master ItemEngineering Master Item

Assemble to
order (ATO)
Model
ATO Option
Class
ATO Item
Finished Good
Kit
Purchased
Reference Item
Subassembly

Supply Item
Freight
Product Family
Outside
Processing
Item
Pick to Order
(PTO) Model
PTO Option
Class

 Templates provided by Oracle Templates provided by Oracle
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Item Template SummaryItem Template Summary

• The Find button on the Find Item Templates
window displays the searched template summary
information in the Item Templates Summary
window.
– Template
– Description
– Organization
– Item status
– Primary UOM
– User item type
– Bills of Material item type
– Checkboxes for status codes

• The Find button on the Find Item Templates
window displays the searched template summary
information in the Item Templates Summary
window.
– Template
– Description
– Organization
– Item status
– Primary UOM
– User item type
– Bills of Material item type
– Checkboxes for status codes

Items Templates

Use this window to create and change item attribute templates. Use the same item
templates in Oracle Engineering as in Oracle Inventory.

(N) Prototypes > Items > Template (B) Find > Item Templates
Summary (B) Open or (B) New

(Help) Oracle Inventory > Items > Defining Items
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Item Template Summary WindowItem Template Summary Window

• The Open button utilizes existing template
information.

• The New button allows for the entering of a new
template.

• The Open button utilizes existing template
information.

• The New button allows for the entering of a new
template.

(N) Prototypes > Items > Template (B) Find > Item Templates
Summary (B) Open or (B) New

(Help) Oracle Inventory > Items > Defining Items
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Copying From TemplatesCopying From Templates

• Use the copy function from the tools menu in the
Engineering Master Item window. This opens the
Copy From window, where you can use to copy
item attributes from one item to another or from a
template.

• You can also create a hybrid template by copying
attributes from multiple templates.

• Use the copy function from the tools menu in the
Engineering Master Item window. This opens the
Copy From window, where you can use to copy
item attributes from one item to another or from a
template.

• You can also create a hybrid template by copying
attributes from multiple templates.

(N) Prototypes > Items > Master Items (M) Tools, Copy From

(N) Prototypes > Items > Template (B) New (M) Copy Template

(Help) Oracle Inventory > Items > Defining Items
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Searching Engineering ItemsSearching Engineering Items

Use the Item Search window to search for items
based on any combination of criteria you specify:

– Having a particular cross-reference
– Item category
– Purchasing information
– Quantity types
– Item catalog
– Matching specified inventory detail, or having

a specified descriptive element value
– Related to or that are substitutes for a

specified item

Use the Item Search window to search for items
based on any combination of criteria you specify:

– Having a particular cross-reference
– Item category
– Purchasing information
– Quantity types
– Item catalog
– Matching specified inventory detail, or having

a specified descriptive element value
– Related to or that are substitutes for a

specified item

(N) Prototypes > Items > Item Search (B) Find

(Help) Oracle Inventory > Items > Searching for Items
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Searching Engineering Items
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Searching Engineering ItemsSearching Engineering Items

You can specify as much or as little criteria as you
want.
You can specify as much or as little criteria as you
want.
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Search ResultsSearch Results

View search results in the Item Search window.
– Item
– Description
– Organization
– UOM

View search results in the Item Search window.
– Item
– Description
– Organization
– UOM
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Review QuestionReview Question

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template
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Answer to Review QuestionAnswer to Review Question

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template

Which window allows users to define and update
items?
1. Manual Items Define
2. Cross Reference Item
3. Allocation Items
4. Master Item
5. Find Item Template
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Review QuestionReview Question

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons
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Answer to Review QuestionAnswer to Review Question

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons

The Item Templates Summary window has the
following buttons:
1. Engineering and Inventory buttons
2. Utility and  Item buttons
3. Search and Query buttons
4. New and Open buttons
5. Error and Existing buttons
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Viewing Item InformationViewing Item Information

• View revisions, attributes, and categories using
the Find Item Information window

• Depending on the function security assigned to
your responsibility, view the information for:
– Single organization only
– Single organization and its master

organization
– All organizations

• View revisions, attributes, and categories using
the Find Item Information window

• Depending on the function security assigned to
your responsibility, view the information for:
– Single organization only
– Single organization and its master

organization
– All organizations

(N) Prototypes > Items > View Item Details

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Viewing Item RevisionsViewing Item Revisions

The Revisions button displays:
– Revision
– Description
– Organization
– Dates and time
– Engineering change orders (ECOs)

The Revisions button displays:
– Revision
– Description
– Organization
– Dates and time
– Engineering change orders (ECOs)

(N) Prototypes > Items > View Item Details (B) Revisions

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Viewing Item Attributes
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Viewing Item AttributesViewing Item Attributes

The Attributes button displays:
– Description of the item
– Group
– Attribute
– Organization
– Value
– Control level

The Attributes button displays:
– Description of the item
– Group
– Attribute
– Organization
– Value
– Control level

(N) Prototypes > Items > View Item Details (B) Attributes

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Viewing Item Categories
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Viewing Item CategoriesViewing Item Categories

The Categories button displays:
– Category set
– Organization
– Category
– Control level

The Categories button displays:
– Category set
– Organization
– Category
– Control level

(N) Prototypes > Items > View Item Details (B) Categories

(Help) Oracle Inventory > Items > Viewing Item Attributes
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Item Status Codes:
Status Attributes

Item Status Codes:
Status Attributes

• Use statuses to control values of certain item
attributes which affect the functionality of an item.

• A status code controls certain item attributes
designated as status attributes.

• When you update the definition of a status, all
items to which it is assigned are also updated.

• Use statuses to control values of certain item
attributes which affect the functionality of an item.

• A status code controls certain item attributes
designated as status attributes.

• When you update the definition of a status, all
items to which it is assigned are also updated.

XYZXYZ

Item Status and Status Codes

An Item Status Code has a user-defined set of Yes/No values for the status
attributes. The values are applied to the status attributes when you choose an Item
Status Code when defining an item. For example, assume you define an Item
Status named Prototype with all status attributes set to Yes except for Customer
Orders Enabled. Next, you define another Item Status, Active, with all status
attributes set to Yes. In the beginning of a product development cycle, assign the
status code Prototype to an item so that you cannot place the item on a sales order.
Later, assign the status code Active to allow all functions for the item.

Pending Statuses

Use pending statuses to automatically update an item's status on a specified date.
For each item, specify a list of pending statuses and the corresponding effective
dates.
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Item Status Codes:
Status Attributes

Item Status Codes:
Status Attributes

The status attributes are:The status attributes are:

XYZXYZ

BOM allowed
Build in WIP
Customer orders
enabled
Transactable

Internal orders
enabled
Invoicable
Purchasable
Stockable

Change Responsibility: (N) Oracle Inventory > Setup > Items > Status
Codes

(Help) Oracle Inventory > Setting Up > Item Setup and Control >
Defining Item Status Codes
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Organization AssignmentsOrganization Assignments

• Use the Organization Assignment window to
assign an item to an organization.
– Displays

– Organization
– Name
– Primary UOM
– The Assign All button/individual assign

check boxes.
– The Org Attributes button launches the

Engineering Organization Item window.

• Use the Organization Assignment window to
assign an item to an organization.
– Displays

– Organization
– Name
– Primary UOM
– The Assign All button/individual assign

check boxes.
– The Org Attributes button launches the

Engineering Organization Item window.

Enabling Organization Assignments

Use this window to enable engineering items and inventory items in organizations
in the same way that you use the corresponding Oracle Inventory window to
enable production items in organizations. It is not recommended to check Assign
All. There are many times items should not be assigned to an organization,
especially an engineering item.

(N) Prototypes > Items > Master Item (M) Tools > Organization
Assignment (B) Assign All

(Help) Oracle Inventory > Items > Assigning Items to Organizations
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Creating and Changing Engineering
Organization Items

Creating and Changing Engineering
Organization Items

The Engineering Organization Item window allows
users to create and change item attributes in
organizations using the the following tabs:

The Engineering Organization Item window allows
users to create and change item attributes in
organizations using the the following tabs:

Main
Inventory
Bill of Materials
(BOM)
Costing
Purchasing

Receiving
Physical attributes
General
MPS/MRP
Planning

Lead times
WIP
OM
Invoicing
Service
Web option

Creating and Changing Engineering Organization Items

Use this window to create and change item attributes in organizations in the same
way that you use the corresponding Oracle Inventory window to create and
change production item attributes in organizations.

(N) Prototypes > Items > Master Item (M) Tools > Organization
Assignment (B) Org Attributes

(Help) Oracle Inventory > Items > Assigning Items to Organizations
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Creating Item Catalog GroupsCreating Item Catalog Groups

• Define a catalog group with the Item Catalog
window.

• Use descriptive elements for searching or to
standardize descriptions.

•  Displays
– Name
– Description
– Inactive on

• Define a catalog group with the Item Catalog
window.

• Use descriptive elements for searching or to
standardize descriptions.

•  Displays
– Name
– Description
– Inactive on

Creating Item Catalog Groups

Use the same item catalog groups in Oracle Engineering to work with engineering
items that you use in Oracle Inventory to work with production items.

(N) Prototypes > Items > Catalog Groups

(Help) Oracle Inventory > Setting Up > Item Setup and Control > Item
Cataloging > Defining Item Catalog Groups
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Review QuestionReview Question

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual
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Answer to Review QuestionAnswer to Review Question

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual

When viewing items the three viewing functions
include:
1. Summary, searched, and process sets
2. Attributes, revisions, and categories
3. Defined, template, and production
4. Assigned, material, and organization
5. Inventory, BOM, and manual
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Review QuestionReview Question

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Oracle BOM and Engineering: Defining and Maintaining Engineering Items
Chapter 1 - Page 43

Answer to Review Question

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Answer to Review QuestionAnswer to Review Question

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables

All of the following are tabs in the Engineering
Organization Item window except:
1. Purchasing
2. General
3. Physical attributes
4. Web options
5. Payables
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Creating Cross ReferencesCreating Cross References

• Cross-reference types define relationships
between items and entities such as old item
numbers or supplier item numbers.

• For example, you can create a cross-reference
type old to track the old item numbers, and a type
supplier to track supplier part numbers.

• Cross-reference types define relationships
between items and entities such as old item
numbers or supplier item numbers.

• For example, you can create a cross-reference
type old to track the old item numbers, and a type
supplier to track supplier part numbers.
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Creating Cross References
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Creating Cross ReferencesCreating Cross References

• Cross Reference Types window displays
– Type
– Description
– Inactive on

• The Assign button displays.
– Items
– Organizations
– Values
– Descriptions

• Cross Reference Types window displays
– Type
– Description
– Inactive on

• The Assign button displays.
– Items
– Organizations
– Values
– Descriptions

(N) Prototypes > Items > Cross References
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Related ItemsRelated Items

• Define relationships between items.
• This allows you to search for items through these

relationships.
• The New button

– Allows you to enter a new relationship.
– From/to associations

• The Find button
– Allows you to search relationships.

• Define relationships between items.
• This allows you to search for items through these

relationships.
• The New button

– Allows you to enter a new relationship.
– From/to associations

• The Find button
– Allows you to search relationships.

(N) Prototypes > Items > Related Items

(Help) Oracle Inventory > Items > Defining Item Relationships
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Item Documents
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Item DocumentsItem Documents

• Use the Documents window to add existing
documents, or create new attachments in the
document catalog. Use the same corresponding
Oracle Inventory window to create and change
production items.

• These documents will then be available for use as
attachments from the Attachments window.

• Creating a document in the Documents window is
much like creating an attachment in the
Attachments window with the addition of security,
usage, and effective date information.

• Use the Documents window to add existing
documents, or create new attachments in the
document catalog. Use the same corresponding
Oracle Inventory window to create and change
production items.

• These documents will then be available for use as
attachments from the Attachments window.

• Creating a document in the Documents window is
much like creating an attachment in the
Attachments window with the addition of security,
usage, and effective date information.
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Guided Practice AGuided Practice A

1. Creating Engineering Items

1. Use the following table to create engineering items.
(N) Prototypes > Items > Master Items (displays the Engineering
Master Item window) Enter the item number, description, and user item
type. If a flexfield is displayed click the OK button. XX represents your
initials or team. Note the item number may require five numbers after your
initials e.g., XX1000 = XX10000.
2. Save the item.
3. Assign the items to an organization that your instructor specifies e.g.,
M2.
Tools > Org Assignment > e.g., M2 checkbox  (displays the
Organization Assignment window)
4. Save the item and close the window.
5. Choose the new record icon.

Copied items

1. Enter the item number and description.
2. Copy the item. Tools > Copy From, enter copy item number (B)
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Done button (displays the Copy From window).
3. Save the item.
4. Assign the items to an organization (see above navigation path).
5. Save the item.
6. Choose the new record icon.

Item Number Description User Item Type Copied Item
XX1000 Pentium Computer  Finished Good
XX1010 17" Monitor  Purchased Item
XX1020 101 Keyboard XX1010
XX1030 Mouse XX1010
XX1040 CPU Chassis Subassembly
XX2010 Motherboard XX1040
XX2011 New Motherboard XX2010
XX2020 Serial Board XX1010
XX2030 1.6GB Hard Drive XX1010
XX2040 3.5 Disk Drive XX1010
XX3010 Blank Board XX1010
XX3020 586 133mhz IC XX1010
XX3030 Resistor XX1010
XX3031 New Resistor XX3030
XX3040 Integrated Circuit XX1010
XX3041 Item to Delete XX1010 (Do
not assign an organization for XX3041)

2. Using the Master Items window

1. Query all of your items. Choose view and select query by example,
enter.
2. Enter XX% and from the menu bar choose view and select query by
example, run.
3. Query all Pentium computers.
4. Query all of your items in the organization that your instructor assigned.
(N) Organization Items, verify that your items are in the assigned
organization.

3. Using (N) View item detail, view one or more of your items
(displays the Find Item Information window).
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1. Enter your query and choose the Attributes button. What group does
 the engineering item belong to? What is the value?

4. Try to define your items using an Oracle Inventory
responsibility that your instructor assigns. What is the result?

Repeat steps 1-3. Although in step 1 add PR at the end of the numbers to
differentiate them from the item numbers in Oracle Engineering e.g.,
XX1000 = XX1000PR.
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AgendaAgenda

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups

• Using Oracle Applications Help
• Creating engineering items
• Copying from item templates
• Searching for engineering items
• Viewing item information and revising item

attributes
• Enabling organization assignments
• Creating item catalog groups
• Creating cross references, relationships and

documents
• Creating deletion groups
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Deleting Product Information
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Deleting Product Information

ItemsItems

Bills ofBills of
material andmaterial and
componentscomponents

DeleteDelete

ArchiveArchive

Routings andRoutings and
OperationsOperations

Deletion Groups

When you decide that product information is no longer useful, or input
incorrectly, you can delete or archive it.

• If you delete information, you remove it from the active data storage area
and you cannot:

– Manipulate or view it on forms.

– Retrieve it again by any means.

• If you archive information, you store deleted information in another
storage area of the database. Oracle Applications provides no functions for
you to:

– View the archived information.

– Restore the archived information to the active data storage area.
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Information That You Can Delete
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Information That You Can Delete

OracleOracle
InventoryInventory

OracleOracle
Bills of MaterialBills of Material

OracleOracle
EngineeringEngineering

 Production
and Bill
Routing

 Production Bills
of Material,

Routing,
Component, and

Operation Bill
Routing

 Engineering
items, Bills of

Material,
Routing,

Component,
Operation, Bill
Routing, and

Item Bill Routing

Information That You Can Delete

Set up groups of entities to check, delete and optionally archive. Entities can
include items, bills of material, components, routings, or operations.
What entities you can delete depends on what Oracle application you are currently
using and what applications you have installed.

• If you are using Oracle Bills of Material, you can delete only bills,
routings, components, and operations.

• If you are using Oracle Engineering, you can delete any engineering entity
except ECOs.

• If you are using Oracle Inventory and you do not have Bills of Material
installed, you can only delete manufacturing items.

• If you are using Inventory and you do have Bills of Material installed, you
can delete only items, bills, and routings.

Using Oracle Engineering, you can delete all of the information types that you
can delete using Oracle Inventory and BOM, but for  engineering data only. In
addition, you can delete engineering change order information.
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Deletion Process
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Deletion Process

Delete
requests

Delete
constraints

----------------------------

----------------------------
----------------------------

----------------------------

----------------------------
----------------------------

----------------------------
ErrorError

OKOK

Deletion Process

Deleting physically removes information from the database tables. Deleted bill or
routing information can be archived to database tables. (You cannot archive item-
level information.) You can then write custom programs to report on the archived
data. Summary information is saved for all deletion groups. You can report on
deletion groups.

Several deletion constraints are installed with BOM. However, you can define
custom deletion constraints. If what you are attempting to delete does not pass
deletion constraints, it is not deleted. For example, you can define a constraint that
prevents you from deleting a bill of material for an assembly that has an item
status of active.

When you delete an entire bill, you delete all the components for the assembly
along with their reference designators and substitute items. When you delete a
routing, all operations are deleted. For both bills and routings, any links to
attachments are severed.

Oracle Work in Process reflects any changes to the bills or routings using the
delete functionality only if you re-explode the bill or routing in Work in Process.
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Deletion Group Details
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Deletion Group DetailsDeletion Group Details

• Engineering Deletion Group window
– Group name, type, description, last submitted,

and archive enable box.
– Entities to delete: Details and Results tab.

– Details
– Item, description, organization, type,

alternative
– Results

– Item, description, status, date

• Engineering Deletion Group window
– Group name, type, description, last submitted,

and archive enable box.
– Entities to delete: Details and Results tab.

– Details
– Item, description, organization, type,

alternative
– Results

– Item, description, status, date

(N) Prototypes > Items > Delete Groups

(Help) Oracle Bills of Material >  > Bills of Material > Deleting Items
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Deletion Group Details and Results
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Deletion Group Details and ResultsDeletion Group Details and Results

• The Error button reviews why the deletion failed
(constraints defined in setup).

• The delete Group button submits the deletion
group to the concurrent manager.

• The Check Group button verifies whether any
deletion constraints are violated.

• The Error button reviews why the deletion failed
(constraints defined in setup).

• The delete Group button submits the deletion
group to the concurrent manager.

• The Check Group button verifies whether any
deletion constraints are violated.

Errors

Change Responsibility: (N) Oracle BOM > Delete Groups (B) Errors

(Help) Oracle Bills of Material > Reports and Processes > Delete
Items Report
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For Reviewing History and Purging ECOs
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For Reviewing History and Purging ECOsFor Reviewing History and Purging ECOs

How?
• By submitting a request to view information about

deletion groups.
– Selecting the request or request set to be

submitted.
– Defining a submission schedule
– Providing completion options

How?
• By submitting a request to view information about

deletion groups.
– Selecting the request or request set to be

submitted.
– Defining a submission schedule
– Providing completion options

Change Responsibility: (N) Oracle Bills of Material > Reports > Delete
Groups

In Engineering: (N) ECOs > Delete

(Help) Oracle Bills of Material > Reports and Processes > Delete
Items Report
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Review QuestionReview Question
What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.

What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.
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Answer to Review QuestionAnswer to Review Question
What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.

What is the correct deletion process?
1. Press the Check Group button and acknowledge
that you deleted the correct item.
2. Archive the request, create a delete group, and
then delete the item.
3. Create the delete group, add items to the group,
save the delete group, check group for deletion
constraints violations, and submit for deletion.
4. Create request delete group, request identifies
delete constraints, and the item goes in the trash.
5. Create request delete group, archive the request,
and identify the item.
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Review QuestionReview Question

Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.

Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.
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Answer to Review QuestionAnswer to Review Question

Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.

Creating documents in the Documents window is
much like creating an attachment in the Attachment
window, but with the addition of:
1. Better functionality, saving ability, and easy of use.
2. Security, usage, and effective date information.
3. Multi tasking, help references, and visibility.
4. Windows, folders, and opening and collapsing
trees.
5. Security, sequencing, and effective date
information.
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Summary
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SummarySummary

In this lesson, you should have learned how to:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups

In this lesson, you should have learned how to:
• Create engineering items
• Copy from item templates
• Search for engineering items
• View item information and revise item attributes
• Enable organization assignments
• Create item catalog groups
• Create cross references, relationships and

documents
• Create deletion groups
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Guided Practice B
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Guided Practice BGuided Practice B

1. Create a deletion group component XX3010 from subassembly
XX2010 (N) Prototypes > Delete Group

1. Enter XXDELETE as the group.
2. Enter XXDELETE group as the description.
3. Select item as the type.
4. Select XX3041 as the item from the LOV.
5. The description, organization and type will default.
7. Choose the disk icon to save.

2. Check the delete group for constraint violations (seeded or
user defined) (N) Prototypes > Delete Group (B) Check Group
button

1. Record request number.
2. From the menu bar choose view and select requests.
3. Choose the Find button (verify that the request is completed normal) close

window.
4. Re-query your deletion group.
5. Choose the Results tab and verify that the status is OK.

3. Perform the deletion (N) Prototypes > Delete Group (B)
Delete Group button
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1. Record request number.
2. From the menu bar choose view and select requests.
3. Choose the Find button (verify that the request is completed normal)
close window.
4. In the Master Item window re-query your item and verify that it was
deleted.

4. Try deleting another item that you created. Was there any
deletion constraints?
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Chapter 2
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R11i Creating Bills of Material
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Creating Bills of Material
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Creating Bills of MaterialCreating Bills of Material

Release 11iRelease 11i
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Agenda
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AgendaAgenda

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material
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Component ObjectivesComponent Objectives

After completing this component, you should be able
to do the following:
• Create bills of material
• Copy and change bills of material
• Compare bills of material
• Transfer engineering product information to

production
• Copy engineering product information to

production
• Perform a mass change operation

After completing this component, you should be able
to do the following:
• Create bills of material
• Copy and change bills of material
• Compare bills of material
• Transfer engineering product information to

production
• Copy engineering product information to

production
• Perform a mass change operation
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AgendaAgenda

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material
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Using Oracle Applications Help
Within a Window

Using Oracle Applications Help
Within a Window

Any window launched from the Oracle Navigator will
link to online help. Select Help—>Window Help from
the menu bar. Oracle Applications Help displays
detailed information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
Note: The Library topic contains help for products.

Any window launched from the Oracle Navigator will
link to online help. Select Help—>Window Help from
the menu bar. Oracle Applications Help displays
detailed information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
Note: The Library topic contains help for products.

Help Note
You can launch Oracle Help using the toolbar “?” icon only from a window that
is open from the Navigator.  If you launch Oracle Help from a window that is
opened via the menu bar, a button, or pop up window, you will receive a
http://404 - no data found error.
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Searching Oracle Applications HelpSearching Oracle Applications Help

1. From any window within an Oracle Application
select Help—>Window Help from the menu bar.

2. The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Find field and click Find.
4. Select a topic to view detailed information.

Note: Select Search Instructions for help when
searching Oracle Applications Help.

1. From any window within an Oracle Application
select Help—>Window Help from the menu bar.

2. The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Find field and click Find.
4. Select a topic to view detailed information.

Note: Select Search Instructions for help when
searching Oracle Applications Help.
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AgendaAgenda

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material
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Product OverviewProduct Overview

The Oracle engineering products are Oracle Bills of
Material and Oracle Engineering.
Use Oracle Bills of Material to:
• Create and maintain production bills of materials
• Create and maintain production resources,

departments, routings, and lead times
• Perform mass changes
• Delete product information
• Maintain the workday calendar

The Oracle engineering products are Oracle Bills of
Material and Oracle Engineering.
Use Oracle Bills of Material to:
• Create and maintain production bills of materials
• Create and maintain production resources,

departments, routings, and lead times
• Perform mass changes
• Delete product information
• Maintain the workday calendar
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Product Overview
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Product OverviewProduct Overview

Use Oracle Engineering to:
• Create and maintain engineering items
• Create and maintain engineering bills of materials
• Create and maintain engineering routings
• Transfer engineering product information to

production
• Process engineering change orders
• Perform mass changes
• Delete product information

Use Oracle Engineering to:
• Create and maintain engineering items
• Create and maintain engineering bills of materials
• Create and maintain engineering routings
• Transfer engineering product information to

production
• Process engineering change orders
• Perform mass changes
• Delete product information
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Bills of MaterialBills of Material

EEDD

BB CC

AA

Specify Components of BOM
You use bills of material to specify the component items that you use to:

• Manufacture assemblies and subassemblies
• Configure sales orders
• Explode aggregate forecasts
• Calculate standard cost
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Transferring Bills of MaterialTransferring Bills of Material

EngineeringEngineering ProductionProduction

Transferring Product Information
When you decide that engineering information is ready for production, you
transfer the product information—items, bills of material, and routings— from
engineering to manufacturing.
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Mass ChangesMass Changes

EE

CCBB

P1P1

DD MM

EE

CCBB

P2P2

DD MM

EE

CCBB

P3P3

DD MM

Mass Changes
Using mass changes, you can perform the same change to multiple bills of
material. You cannot use the mass change functionality with routings. When
you make mass changes to bills of material, you can perform the following
actions:

• Change information about an existing component
• Add a component
• Replace one component with another
• Disable a component

You can search for all bills of material that contain the component that you want
to change, replace, or delete.
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Oracle Inventory Integration
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Oracle Inventory IntegrationOracle Inventory Integration

OracleOracle
EngineeringEngineering

OracleOracle
InventoryInventory

OracleOracle
Bills of MaterialBills of Material

Oracle Inventory Integration
You can use items that are defined using Oracle Inventory as both assemblies
and components of bills of material.
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Oracle Engineering Integration
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Oracle Engineering IntegrationOracle Engineering Integration

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Oracle Engineering Integration
You can use items that are defined using Oracle Engineering as both assemblies
and components of engineering bills of material.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 17

Oracle Work in Process Integration
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OracleOracle
WIPWIP

Oracle Work in Process IntegrationOracle Work in Process Integration

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Oracle Work In Process Integration
When you create discrete jobs and repetitive schedules, Oracle Work In Process
bases the pick list on the bill of material of the assembly.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 18

Oracle Purchasing Integration
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Oracle Purchasing IntegrationOracle Purchasing Integration

OracleOracle
PurchasingPurchasing

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Oracle Purchasing Integration
You can purchase engineering items.
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Oracle Master Scheduling/MRP Integration
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Oracle Master Scheduling/MRP IntegrationOracle Master Scheduling/MRP Integration

Oracle Supply ChainOracle Supply Chain
PlanningPlanning

Oracle MasterOracle Master
Scheduling/MRPScheduling/MRP

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Oracle Master Scheduling/MRP and Oracle Supply Chain Planning
Integration

The requirements explosion passes demand from bill of material assemblies to
bill of material components.
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Oracle Order Management IntegrationOracle Order Management Integration

OracleOracle
OrderOrder

ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Oracle Order Management Integration
When your customer orders configure-to-order items, Oracle Order
Management uses bills of material to offer choices.
The assemble-to-order processes use model and option class items and bills of
material to create configured items and bills of material unique to a sales order
line.
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• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material
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ObjectivesObjectives

After completing this section, you should be able to
do the following:
• Create bills of material
• Create alternate bills of material
• Copy bills of material
• Compare bills of material

After completing this section, you should be able to
do the following:
• Create bills of material
• Create alternate bills of material
• Copy bills of material
• Compare bills of material
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OverviewOverview

Use bills of material to specify the component
items that you use to:
• Manufacture assemblies and subassemblies (STD)
• Configure sales orders (Model)
• Explode aggregate forecasts (Planning)
• Calculate standard cost (STD)

Use bills of material to specify the component
items that you use to:
• Manufacture assemblies and subassemblies (STD)
• Configure sales orders (Model)
• Explode aggregate forecasts (Planning)
• Calculate standard cost (STD)
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Bills of Material
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EEDD

BB CC

AA

Specify Components of BOM
You use bills of material to specify the component items that you use to:

• Manufacture assemblies and subassemblies
• Configure sales orders
• Explode aggregate forecasts
• Calculate standard cost

Engineering and Manufacturing Bills of Material
Engineering bills of material are bills of material that your engineering function
creates and are not ready for production. Manufacturing bills of material are
bills of material that you use in production. You create engineering bills of
material in Engineering and you create manufacturing bills of material in
Inventory. They differ only in the following ways:

• Engineering bills of material have the check box for the bill of material
attribute Engineering preselected.

• Manufacturing bills of material have not preselected the check box for the
item attribute Engineering.

The forms that you use to create and change engineering and manufacturing
bills of materials are identical. They differ only in the following ways:

• You access them through different navigation paths.
• They have different form titles.
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• You can create and change engineering bills of material using the Oracle
Engineering forms. You can create and change manufacturing bills of
material using the Oracle Bills of Material forms.

• You can use engineering and manufacturing items as components in
engineering bills of material. You can only use manufacturing items as
components in manufacturing bills of material.

• When your engineering bills of material are ready for production, you can
transfer or copy them to Oracle Bills of Material as manufacturing bills of
material. When you transfer a bill of material, the engineering bill of
material becomes a manufacturing bill of material. When you copy a bill
of material, the engineering bill of material remains and you create a
production bill of material with a different assembly item number.
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Types of Bills of Material

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Types of Bills of MaterialTypes of Bills of Material

PlanningPlanning

ModelModel

Option classOption class

StandardStandard

Bill ofBill of
MaterialMaterial

Standard and Option Class Types of Oracle BOM
Oracle Engineering and Oracle Bills of Material use the following four types of
bills of material, each of which consists of one level of components:
Standard
Use standard bills of material to specify components that you use to
manufacture items. For example, you make tomato sauce from tomatoes and oil.
The standard BOM will also establish standard cost.
Model
Use model bills of material to specify classes of options from which your
customers can choose when ordering configurable items.
Planning
Use planning bills of material to specify items that belong to the same product
line.
Option class
Use option class bills of material with model bills of material to specify families
of options from which you customers can choose when ordering configurable
items.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Bill of Material Types
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Example of BOMExample of BOM

PlanningPlanning
BOMBOM

ModelModel
BOMBOM

Option classOption class
BOMBOM

StandardStandard
BOMBOM

Italian foodItalian food

PizzaPizza CalzoneCalzone

SauceSauce ToppingsToppings

Tomato sauceTomato sauce Pesto saucePesto sauce

TomatoesTomatoes Olive oilOlive oil

Connecting Multiple Bills of Material
The bills of material above show:

• A planning bill of material for Italian foods containing items pizza and
calzone as components

• Two model bills of material for pizza and calzone (Pizza contains the
option class components sauce and toppings.)

• Two option class bills of material for sauce and toppings (Sauce contains
standard components tomato sauce and pesto sauce.)

• Two standard bills of material for tomato sauce and pesto sauce (Tomato
sauce contains standard components tomato and oil.)

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Components
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Single Organization Bills of MaterialSingle Organization Bills of Material

Organization 1Organization 1

CCBB

AA

Organization 2Organization 2

Single Organization Bills of Material
You create items in the master organization and assign them to the
manufacturing and distribution organizations in which you use them.
However, you create bills of material in each organization that uses them.
Bills of material are always and only single organization entities.  You can share
the bill of material or copy it across organizations.
You could

• Create a bill of material for item A in organization 1 with components
item B and item C.

• Create a bill of material for item A in organization 2 with components
item B and item C.

You usually create bills of material in the organization that uses them for
manufacturing and use the copy bill of material or common bill of material to
create them in other organizations that need them.
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Primary and Alternate Bills of Material
Each item that has a bill of material has a primary bill of material. If you create
other bills of material for standard and planning items, you refer to them as
alternate bills of material.
A primary bill is a list of the components you most frequently use to build a
product.
An alternate bill is another list of components for the same basic assembly.
Do not create alternate bills of material for model and option class bills of
material because you cannot choose alternate bills of material when you
configure an order.
You identify each alternate bill of material by naming it. For example, you
create the primary bill of material to use when you manufacture the item. Create
another bill of material to use when you rework the item. Name the alternate bill
of material Rework.

• You can create as many alternate bills of material as you need for any
item.

• You must add the name of an alternate bill of material to a list before you
use it.
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Uses in other Oracle Applications
Other Oracle manufacturing applications use primary and alternate bills of
material in the following ways:

• Oracle material planning uses the primary bill of material when it
determines the amount of each item that you need. APS will use alternates
to help planning when constraints are encountered.

• When setting the standard cost of a make item, Oracle Cost Management
can use the primary bill of material. Costs can be rolled up from the
primary or from any selected alternate (it is a roll up parameter).

• When you create discrete jobs and repetitive schedules in Oracle Work in
Process, you can specify which bill of material it should use when creating
the pick list. If you use an alternate bill of material, you may automatically
create a variance.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Primary and Alternate Bills of Material
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Standard Bills of Material
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Standard Bills of MaterialStandard Bills of Material

VGA-AVGA-A

CaseCase Picture tubePicture tube

Creating Standard BOM
Use standard bills of material to specify the components that you use to
manufacture items.
You can order standard items on customer orders and build standard items on
discrete jobs and repetitive schedules. Select Customer Ordered, Customer
Orders Enabled, Internal Ordered, Internal Orders Enabled, and Build WIP in
item attributes.
A kit is a standard item that you typically do not build. You pick and ship the
components when your customer orders the item. Select item attributes
Customer Ordered, Customer Orders Enabled, Internal Ordered, and Internal
Orders. Clear Build in WIP item attribute.
If the assembly BOM Item Type item attribute value is Standard, you can use
those items with BOM Item Type item attribute value of Standard as
components.
A standard bill of material is not the same as a standard operation.
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Phantom Assembly
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Phantom Assemblies in Bills of Material
Phantom assemblies are components in a bill of material that usually represent a
nonstocked subassembly. That is, you may create the phantom assembly in the
manufacturing process, but you do not hold the subassembly in inventory to use
in a later manufacturing process.
Typically in Oracle applications, processes that detect a phantom assembly (for
example, a discrete job pick list) ignore the phantom assembly and substitute the
components for the phantom assembly. Although you may stock a phantom
subassembly, processes that detect a phantom assembly do not detect its
presence in inventory and continue to substitute the components for the
phantom.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Phantoms
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Entering Bills of Material
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Entering Bills of MaterialEntering Bills of Material

Use the Bills of Material window to:
• Create either an engineering or manufacturing bill
• Copy an existing bill
• Reference a common bill

Engineering (N) Prototypes > Bills > Bills
Bills of Material (N) Bills > Bills

Use the Bills of Material window to:
• Create either an engineering or manufacturing bill
• Copy an existing bill
• Reference a common bill

Engineering (N) Prototypes > Bills > Bills
Bills of Material (N) Bills > Bills

Entering Assembly Bill of Material Information
1. Enter the item number. The item must have its BOM Allowed item attribute
selected.
2. If you are creating an alternate bill of material, enter the alternate name.
3. You must first enter alternate names in the Alternates form. If you are
creating the primary bill of material, leave this field blank.
4. For model and option class bills of material, choose Elements and assign item
catalog descriptive elements for the assembly.

Entering Component Bill of Material Information: Main
Item Seq: Defaults from the personal profile value BOM: Component Sequence
Item Increment. The item sequence uniquely identifies each component record.
Operation Seq: The routing step in which you use the component. If the item
has a primary routing, it defaults to the first routing step. If the item does not
have a primary routing, it defaults to 1. Use this field if you perform material
planning by operation sequence or if you want Oracle Work in Process to lower
the inventory balance of discrete job and repetitive schedule components when
you backflush at the completion of an operation. A routing must exist before
this field can contain meaningful values.
Component: The item must have its BOM Allowed item attribute selected.
Note the Item Description, Revision, and UOM.
Quantity: The amount of the component that you need to make one assembly.
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Entering Component Bill of Material Information: Effectivity
Effectivity Dates From: This is the first date you use the component to make
the assembly.
Effectivity Dates To: This is the last date that you will use the component to
make the assembly. If you leave this field clear, you use this component to
make this assembly indefinitely.
ECO: Use this field to view an engineering change order number.

Entering Component Bill of Material Information: Component Details
Yield: Use for standard bills of material. Enter the percentage by which you
want Oracle Material Planning to overplan the component to account for
expected loss. The number should represent the percentage of components that
will survive the build process.
Include in Cost Rollup: Use for standard bills of material. Select the check box
to include the material cost of this component in the standard cost of the
assembly.

Entering Component Bill of Material Information: Material Control
Use the following choices with standard BOM when you want to have WIP
lower the inventory balance of a discrete job and repetitive schedule.
Phantom: Use Phantom to instruct Oracle applications to substitute the
components of this item, for the item when working with this item.
Push: Use when the component should be charged at the beginning of the
assembly or operation. This will lower your inventory at the same time. A
component that must be explicitly issued (pushed) from inventory to the discrete
job (or repetitive schedule).
Operation Pull: Use if you want to decrease component inventory
automatically when you complete the routing step in which you use the
component. You must have indicated the backflush operation in the Operation
Sequence field.
Assembly Pull: Use if you want to decrease component inventory automatically
when you complete a discrete job and repetitive schedule.
Vendor: Use to indicate that you will not lower the inventory balance because
your supplier will provide the material.
Bulk: Use to indicate that you will not lower the inventory balance because
these are expense items.
Subinventory: Use for standard bills of material. Indicate the Subinventory
from which you want Push issues to occur and from which you want Pull issues
to occur. Enter a value only if you want to override the values in the component
item definition.
Locator: Use for standard bills of material. Indicate the Locator from which
you want Push issues to occur and from which you want Pull issues to occur.
Enter this field only if you have indicated that the component is under Locator
control and if you want to override the values in the component item definition.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 35

Entering Component Bill of Material Information: Shipping
Shippable: Select this check box to indicate that the component of a configure-
to-order item is shippable.
Include on Ship Docs: Select this check box to indicate that the component of
configure-to-order item should show on Oracle Order Entry documents.
Required to Ship: Select this check box to indicate that you must include this
component of a pick-to-order item in the first shipment of the pick-to-order
item.
Required for Revenue: Select this check box to prevent invoicing for the pick-
to-order item until you ship this component.

Entering Component Bill of Material Information: Comments
Enter your comments in the Comments field to describe how you use the
component in the assembly.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material > Creating a Bill of Material



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 36

Using Substitute Components

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Using Substitute ComponentsUsing Substitute Components

Use the Substitute Components window to:
• Assign any number of substitute items to each bill

component

Engineering (N) Prototypes > Bills > Bills (B) Substitutes
Bills of Material (N) Bills > Bills (B) Substitutes

Use the Substitute Components window to:
• Assign any number of substitute items to each bill

component

Engineering (N) Prototypes > Bills > Bills (B) Substitutes
Bills of Material (N) Bills > Bills (B) Substitutes

Entering Component Bill of Material Information: Substitute
Components

The following information is for reference and is displayed on several reports;
the non-APS planning and manufacturing processes do not use the information.
(APS will consider substitute components when attempting to plan around
constraints).
Substitute Component: Enter the item numbers of items that can be substituted
for this component.
Quantity: Enter the usage quantity of items that can be substituted for this
component.
Note: Substitute items are used for reference only and are not used for planning.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material >
Assigning Substitute Components
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Using Reference Designators
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Using Reference DesignatorsUsing Reference Designators

Use the Reference Designators window to:
• Enter sequenced comments and instructions that

pertain to a component
• Specify a comment for each reference designator

Engineering (N) Prototypes > Bills > Bills (B) Designators
Bills of Material (N) Bills > Bills (B) Designators

Use the Reference Designators window to:
• Enter sequenced comments and instructions that

pertain to a component
• Specify a comment for each reference designator

Engineering (N) Prototypes > Bills > Bills (B) Designators
Bills of Material (N) Bills > Bills (B) Designators

Using Reference Designators
Use reference designators to specify comments or instructions about how to use
more than one of the same component in the same assembly. For example, the
designators may refer to balloon numbers on a drawing.

Entering Component Bill of Material Information: Reference
Designators

Qty Related: Select this check box to indicate that you can create only as many
reference designators as the usage of the component in the assembly.
Reference Designator: Enter the reference designators or choose Add Range to
create a range of reference designators automatically.
Delete Range: Select this button to delete an existing range of reference
designators.

Add Range
In Oracle Engineering: (N) Prototypes—>Bills—>Bills
(B) Designators—>Add Range
In Oracle Bills of Material: (N) Bills—>Bills
(B) Designators—>Add Range

Adding a Range of Reference Designators
1. Enter a Prefix and a Suffix.
2. Enter the Starting Value and either the Number of Values or the Ending
Value.
3. Click the Add button.
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Delete Range
In Oracle Engineering: (N) Prototypes—>Bills—>Bills
(B) Designators—>Delete Range
In Oracle Bills of Material: (N) Bills—>Bills
(B) Designators—>Delete Range

Deleting a Range of Reference Designators
1. Enter a Prefix and a Suffix.
2. Enter the Starting Value and either the Number of Values or the Ending
Value.
3. Click the Delete button.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material >
Creating Reference Designators
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Bill Details
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Bill DetailsBill Details

Use the Bill Detail window to:
• Enter a description of the bill of material or view a

specific common bill of material

Engineering (N) Prototypes > Bills > Bills (B) Bill Details
Bills of Material (N) Bills > Bills (B) Bill Details

Use the Bill Detail window to:
• Enter a description of the bill of material or view a

specific common bill of material

Engineering (N) Prototypes > Bills > Bills (B) Bill Details
Bills of Material (N) Bills > Bills (B) Bill Details

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material > Creating a Bill of Material
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DemonstrationDemonstration

This demonstration shows you how to create a new
bill of material.
This demonstration shows you how to create a new
bill of material.
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Model/Unit Effectivity

• Define only one BOM for all the unit numbers of an
end item

• Define engineering and manufacturing BOMs with
components effective for a unit number or range
of unit numbers for the end item

• Define ECOs that are effective for a unit number or
range of unit numbers

• Copy and transfer engineering BOMs to
manufacturing for a unit number or a range of
unit numbers

Model/Unit Effectivity
Unit Effectivity is a method of defining product structure, where components
are specified as effective for an end-item unit or a range of end-item units. This
feature is used in a high engineering manufacturing environment such as
aerospace and defense industries. Unit Effectivity is generally used for high
dollar or critical assemblies. You would usually have unit effectivity at top
levels of BOM and date effectivity at lower levels of BOM.
This gives your business an alternative to date effectivity. You can define, plan,
and produce unit effective BOMs and implement unit-effective ECOs. In
addition to date effectivity, you can now define component effectivity for a
range of unit numbers. During planning and production, the system “explodes”
the unit-effective BOMs based on the unit number in the demand. The system
also takes unit-effective ECOs into account during these processes. For
example, you can use all available components before implementing the ECO.

Note
Model/Unit Effectivity is not available unless Oracle Project Manufacturing is
also installed

(Help) Oracle Manufacturing Applications >
Oracle Project Manufacturing > Model/Unit Effectivity
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Model/Unit Effectivity Setup

•Engineering 
•change

ItemItem
definitiondefinition

End-item unit #End-item unit #
definitiondefinition

Set Up

BOMBOM
definitiondefinition

Specify end
item # 

effectivity

ItemItem
definitiondefinition

Master Items Window Master Items Window 
Responsibility: InventoryResponsibility: Inventory

Generate Model/Unit NumberGenerate Model/Unit Number
Window Responsibility: ProjectsWindow Responsibility: Projects

Bill of MaterialsBill of Materials
Window Responsibility:Window Responsibility:

Bills of MaterialBills of Material

ECO WindowECO Window
Responsibility:Responsibility:

EngineeringEngineering

Model/unit # 
effectivity
controls

Serial 
control

Define unique
model/
unit #s

Specify end
item # 

effectivity

Setup Steps for Model/Unit Effectivity
The slide shows the steps needed to set up model/unit effectivity and the
responsibilities for the windows that you will use.
The item needs to be defined Serial Controlled on the Inventory page.
The item effectivity control needs to be defined Model/Unit Number on the
BOM page.

Implementing Considerations for Model/Unit Effectivity
You should ask the following questions to decide whether to implement
model/unit effectivity.

• Does your business need to track your production by unit or date
effectivity?

• Does your business need to plan, procure, or store by unit number?
When you plan by unit number, you are restricted to the master demand
schedule MDS and the MDS creates demand for the material requirement plan
(MRP). You can manually change the MDS if necessary. Forecasts are not
permitted for a model/unit effectivity item.

(Help) Oracle Manufacturing Applications >
Oracle Project Manufacturing > Model/Unit Effectivity >
Generating Model/Unit Numbers
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Example: Unit Effectivity

Unit 001–003Unit 001–003

Unit 001–100Unit 001–100

Unit 001–100Unit 001–100
Unit 001–100Unit 001–100

Unit 001–100Unit 001–100

Unit 001–100Unit 001–100

Unit 010–025Unit 010–025

Unit 010–012Unit 010–012

Unit 001– 012Unit 001– 012

Model/Unit Effectivity
Unit Effectivity introduces the concept of bills that are effective by an end-item
unit number, as opposed to an effectivity by date. This example shows a unit-
effective BOM (for simplicity we did not include date-effective components).
The next slides illustrate the effectivity for certain unit numbers.
When defining a unit-effective BOM, you can have components with date
effectivity and unit effectivity. When defining a date-effective BOM all
components must be date effective; you cannot have components with unit
effectivity.
If your parent has model/unit effectivity, you can have date- and unit-effective
child components. If your parent has date effectivity, you can only have date-
effective child components; you cannot have unit-effective child components.

(Help) Oracle Manufacturing Applications >
Oracle Project Manufacturing > Model/Unit Effectivity >
Model/Unit Effectivity - An Example



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 44

Example: Unit Effectivity

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Example: Unit Effectivity

Unit 001–003Unit 001–003

Unit Unit 027027

Unit 001 –100Unit 001 –100
Unit 001–100Unit 001–100

Unit 001–100Unit 001–100

Unit 001–100Unit 001–100

Unit 010–025Unit 010–025

Unit 010–012Unit 010–012

Unit 001–012Unit 001–012

Model/Unit Effectivity: Unit 027
This example shows the requirements to build Unit 027. You can see that the
components blocked out are the components needed for units 010–025, units
010–003, and units 001–012. All other components are needed to build Unit
027.
Model/unit effectivity allows discrete control over product structure change and
less additions of a part numbers, as well as separating product structure from the
schedule.
Note: You should still follow the “form/fit/function” rules that you have set up
for your business needs.
The model/unit effectivity feature requires that you have Oracle Project
Manufacturing installed, and it should be used in project-oriented
manufacturing and with low-volume schedules. This feature can also be used by
nonproject-oriented manufacturing, but you will still need to have Oracle
Project Manufacturing installed in order to use the feature.
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Viewing Unit EffectivityViewing Unit Effectivity

Use the Bill of Material or the Indented Bill of
Material window to:
• View your components and ranges of effectivity

for the Bill of Material

Bills of Material (N) Bills > Bills (M) View (B) Find
Bills of Material (N) Bills > Indented Bills (B) Find

Use the Bill of Material or the Indented Bill of
Material window to:
• View your components and ranges of effectivity

for the Bill of Material

Bills of Material (N) Bills > Bills (M) View (B) Find
Bills of Material (N) Bills > Indented Bills (B) Find

Bills of Material: Effectivity
Use this window to view your components and ranges of effectivity for the
BOM. This example shows you one level of the BOM and the new tab, Unit
Effectivity.
You can have a quantity of more than 1pc for each unit. You would specify
quantity on the sales order. Each quantity requires a unique serial number.

Indented Bills of Material: Effectivity
Use this window to look at your indented BOMs. The new tab, Unit Effectivity,
shows you the effectivity control for each component in the family tree and
either the date or model/unit From and To values that you have designated for
that component.
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Practice 1-1 OverviewPractice 1-1 Overview

This practice covers the following topics:
• Reviewing a BOM that is model/unit effective
• Viewing the effective components for each unit

This practice covers the following topics:
• Reviewing a BOM that is model/unit effective
• Viewing the effective components for each unit

Practice 1-1
This practice allows you to view a Bill of Material that has model/unit
effectivity set up.
1. Find BOM number SB54111 in the organization P1 Atlanta.
2. Go to the Unit Effectivity information and review which components will be
used for each unit.
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Practice 1-1 SolutionPractice 1-1 Solution

Practice 1-1 Solution
Part 1

Find BOM number SB54111 in the organization P1 Atlanta.
(N) Bill of Material: Bills—>Bills
1. To find the bill of material for the Pump Meter, choose View, then Find.
Type in Item SB54111 and click the Find button.

Part 2
Go to the Unit Effectivity information and review which components will be
used for each unit.
1. Click on the Unit Effectivity tab to review the information.
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Bill of Material RevisionsBill of Material Revisions

Revision ARevision A Revision BRevision B

EEDD

BB CC

AA

NewNewDD

BB CC

AA

Bills of Material: Revisions
A bill of material revision is an item revision and might indicate that the
components of an item have changed. You do not have to use item revisions
when you change bills of material, however, in some industries; it is best to
create a new item revision when you change a bill of material. Oracle
Engineering and Oracle Bills of Material date stamp and time stamp all changes
that you make to bills of material, whether or not you identify the change by
increasing the revision.
The bill of material revision is the same as the item revision. There is no
separate bill of material revision.
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Item RevisionsItem Revisions

Use the Item Revisions window to:
• Define an item revision by entering a revision

identifier and effective date

Engineering (N) Prototypes > Bills > Bills (B) Revision
Bills of Material (N) Bills > Bills (B) Revision

Use the Item Revisions window to:
• Define an item revision by entering a revision

identifier and effective date

Engineering (N) Prototypes > Bills > Bills (B) Revision
Bills of Material (N) Bills > Bills (B) Revision

Entering Item Revisions
Revision: Enter a new Revision Identifier. You can use up to three
alphanumeric characters.
Effective Date: Enter the date the revision becomes effective.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material > Defining Item Revisions
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AlternatesAlternates

Use the Alternates window to:
• Create codes for alternate bills of material

(N) Setup > Alternates

Use the Alternates window to:
• Create codes for alternate bills of material

(N) Setup > Alternates

Alternates
Use this form to create codes for alternate bills of material and for alternate
routings.
An alternate bill describes an alternate list of component items that produce an
assembly.
You can use an alternate code for as many item numbers as you want. You can
use the same alternate code for both a bill of material and a routing for the same
assembly.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Setting Up > Creating Alternates
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Adding AttachmentsAdding Attachments

Use the Attachments window to:
• Add attachments to the bill of material

Engineering (N) Prototypes > Bills > Bills (M) View > Attachments
Bills of Material (N) Bills > Bills (M) View > Attachments

Use the Attachments window to:
• Add attachments to the bill of material

Engineering (N) Prototypes > Bills > Bills (M) View > Attachments
Bills of Material (N) Bills > Bills (M) View > Attachments

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material >
Attaching Files



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 52

Changing Attachments

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Changing AttachmentsChanging Attachments

Use the Bill Documents window to:
• Create and change bill of material attachments

Engineering (N) Prototypes > Bills > Documents
Bills of Material (N) Bills > Documents

Use the Bill Documents window to:
• Create and change bill of material attachments

Engineering (N) Prototypes > Bills > Documents
Bills of Material (N) Bills > Documents

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material >
Defining Bill or Routing Operation Documents
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Document Management Integration

• Complements existing “attachment” feature
• Bridges the gap between product design and

production processes
• Allows engineering-controlled document versions

to be attached to items, ECOs, and BOMs
• Integrates with third party systems to:

– Capture and manage “unstructured” product
information

– Document vaulting capabilities:  Register,
check-in, check-out, secured access

– Version control and history tracking
– Document viewing

Features of Document Management Integration
The Document Management Integration feature enables you to reference formal
engineering-controlled document versions to items, engineering change orders
(ECOs), and bills of material (BOMs). This feature is organization specific.
Product information management has long been considered critical in managing
product design and changes in many industries, including automotive, utilities,
aerospace, and defense. With release 11i, Oracle Engineering offers a suite of
capabilities aimed at bridging the gap between product design and production
process.
For more information reference the Oracle Workflow User’s Guide Release 11i.
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Document Management Integration

BOM/
ENG.

Workflow

ORACLE
APPS

Open
text

DMS1

DMS2

Document Management Integration
Oracle Document Management Integration supports multiple document vaults.
It is integrated with Oracle’s Workflow and Internet documents. These Internet
documents will change to Oracle 8i File Server (FS) format. This integration
works with third-party data management systems (DMS), for example open
text.
This feature is organization specific and cannot be used for information between
organizations.
The document management process will take advantage of any of your seeded
or created workflows.
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Document Management Integration
Process

CreateCreate
ReviewReview

AttachmentAttachment
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Check InCheck InImplement ECOImplement ECO

SGHD-1000 html
Version 1.0

Doc. ManagerDoc. Manager

SGHD-1000 html
Version 2.0

Doc. ManagerDoc. ManagerCheck InCheck In

Document Management Integration Process
The flow diagram above depicts a sample business flow for a typical ECO
process. This business flow illustrates a number of the key integration points
between Oracle Applications and document management systems. The
following steps are the processes involved with an ECO in the example above.
Create a BOM #5000 with SGPC-1000 as the final assembly product.
Reference a new file SGHD-1000.pdf to BOM item SGHD-1000 identified in
BOM #5000. Check file into document management system.
Create ECO SGECO1 to change the quantity of item SGHD-1000 from the
existing quantity of 1 each to 2 each.
Modify Mark-up Specification Document SGHD-1000.html to reflect the
quantity change. Check in and update the new version of document.
Attach the Marked-up Document to ECO SGECO1 and Modified (new version)
document to item SGHD-1000.
Attach document SGECO1.html to a report for the changes made. Oracle
Engineering updates the BOM and implements the ECO.
Notify individuals using Oracle Workflow Notification that SGECO1 has been
implemented with the changes that were made.
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ECO Business Flow
One of the keys to the success of the integration between applications and
document management is utilization of native user interface APIs that are
provided by the document management tools. This includes functions such as
searching for a document using keyword and content searches, moving
documents between folders, looking at the metadata that defines a document,
and so on.
Additionally, you can use the document management functionality to capture
and manage “unstructured” product information.
Reference New Documents
You can reference a local file stored on your file system as a new document.
Once registered, the document can now be managed by the document
management system. You can also use folders to navigate through and organize
your documentation.
View Documents
You can view documents in a number of formats supported by the underlying
document management system.
Display Document History
You can also view a document’s history and status information, for example,
the document’s number, state, and size, and whether it is locked and if so by
whom.
Copy Documents
You can copy a document and place it on your local file system without locking
it. This facilitates concurrent storing of up-to-date product information.
Check Out Documents
You can also lock documents so that no other user can check in new versions
while you hold the lock. Using this feature, you can create a copy of the
document on your local file system.
Check In Documents
You can move a new version of a document from your local system into a vault
controlled by the document management system, and then release your lock on
it. This feature is also supported for compound documents.
View Document Properties
You can view a variety of document properties that define the document and its
status.
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Finding and Viewing Documents with
Document Management Integration

• Log on to the document management system
• Review the choices available for the specific

item/bill of material
• Click on the link to the specific document you

want to view

Engineering (N) ECOs > ECOs (I) Attachment (B) Open Document
Bills of Material (N) Bills > Bills (I) Attachment (B) Open Document

Finding Documents with Document Management Integration
The Document Management Integration feature complements the existing
attachment feature, where attachments are a “static” source of information. You
can use this feature to capture unstructured, engineering-controlled, document
versions to items, ECOs, and BOMs.
When you click the Data Type tab and select Document Reference, a screen
opens for you to log on to the document management system (not shown). After
logging in you see the choices available for the specific item/BOM, as well as a
variety of icons available for activities in the document management system.
These choices are detailed in Oracle Workflow User’s Guide Release 11i.
When you add a new reference, and select the Data Type field for Document
Reference, a caution window opens asking if your document downloaded
properly. You do not answer this question at this time. When you have finished
all document activities and close the document management system, you click
either Yes or No.

Viewing Specific Documents
Click on the link to the specific document you want to view.
The Document Management Integration feature supports multiple document
vaults within Oracle Engineering and BOM. You can use this navigation path to
view third-party document management vendors through any browser that you
have set up in your organization.
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Setup and Implementation Considerations
The Document Management Integration feature integrates with the Oracle
Workflow product and does not have any specific setup or implementation
considerations in the Oracle Engineering and Bills of Material application.
You can review a complete set of Oracle Workflow setup and implementation
steps for the document management system in the Oracle Workflow User’s
Guide Release 11i.
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DemonstrationDemonstration

This demonstration shows you the process for
referencing a document for a BOM to the document
management system. This demonstration also shows
you how to view the referenced  document on a BOM
with the document management system.

This demonstration shows you the process for
referencing a document for a BOM to the document
management system. This demonstration also shows
you how to view the referenced  document on a BOM
with the document management system.

Document Management Demonstration Script
1. Find the BOM for item number SB10299.
2. Click on the Attachments icon.
3. Select Document Reference from list of values in the file Type field.
4. A dialog box is displayed stating the following: “Has the file been uploaded
successfully?” Do not click either the “Yes or No” buttons. A browser window
will be launched.
5. Enter a username and password for Livelink.
6. Click the Add Item icon.
7. Enter the name of the document: Item Spec.
8. Enter a description for the document: Item SB10299 specifications.
9. Select the file you want to add by clicking on the Browse button or directly
entering the path where the file is located on your machine.
10. Select the Enterprise container in the Create In field. It should have
defaulted automatically; if not, click the Browse Livelink button to select the
container.
11. Click the Add Item button.
12. The document will be referenced on the BOM SB10299 and now can be
checked in and out from the document management system.
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Entering Tools Menu OptionsEntering Tools Menu Options

Use the Tools menu to perform the following
functions:
• Copy Bill From
• Assign Common Bill
• Configure Bill
• Check for Loops

Engineering (N) Prototypes > Bills > Bills (M) Tools
Bills of Material (N) Bills > Bills (M) Tools

Use the Tools menu to perform the following
functions:
• Copy Bill From
• Assign Common Bill
• Configure Bill
• Check for Loops

Engineering (N) Prototypes > Bills > Bills (M) Tools
Bills of Material (N) Bills > Bills (M) Tools

Tools Menu Options
Use the Tools menu to perform the following functions:
Copy Bill From: Use to copy components of another assembly to this
assembly.
Assign Common Bill: Use to reference the components of another assembly as
the components of this assembly.
Configure Bill: Use to launch the ATO processes.
Check for Loops: Use to check for bill of material loops in the multilevel bill
of material for this assembly.
Rollup Costs: Use to calculate the cost of this assembly.
Rollup Lead Times: Use to calculate the lead times for this assembly.
Indented Bills: Use to view the multilevel bill of material for this assembly.
Item Where Used: Use to view assemblies which contain the specified
component.
Bill Compare: Use to compare the components of two bills of material.
Routings: Use to enter or view the routing for this assembly.
Find ECO Schedules: Use to view engineering change orders.
View On-Hand Balances: Use to view inventory balances.
Item Details: Use to view item information.
Item Costs: Use to view item costs.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 61

Find Indented Bills

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Find Indented BillsFind Indented Bills

Use the Find Indented Bills window to:
• Enter the revision, the revision date, and the

number of levels to explode for the bill

Engineering (N) Prototypes > Bills > Indented Bills
Bills of Material (N) Bills > Indented Bills

Use the Find Indented Bills window to:
• Enter the revision, the revision date, and the

number of levels to explode for the bill

Engineering (N) Prototypes > Bills > Indented Bills
Bills of Material (N) Bills > Indented Bills

Find Indented Bills
Use this form to enter parameter information you want to view on an indented
bill of material.

• Enter the revision, the revision date, and the number of levels to explode
for the bill

• Select a Display option: All, Current, or Future and Current components
effective as of the revision date you specify

• Select a sort option for each level of the bill, by operation sequence then
item sequence, or item sequence then operation sequence

• Indicate whether to see costing information, and if so, enter the cost type

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Viewing an Indented Bill of Material
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Indented Bills of Material
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Indented Bills of MaterialIndented Bills of Material

Use the Indented Bill of Material window to:
• Display the structure of a manufacturing or

engineering item

Engineering (N) Prototypes > Bills > Indented Bills (B) Find
Bills of Material (N) Bills > Indented Bills (B) Find

Use the Indented Bill of Material window to:
• Display the structure of a manufacturing or

engineering item

Engineering (N) Prototypes > Bills > Indented Bills (B) Find
Bills of Material (N) Bills > Indented Bills (B) Find

Viewing Indented Bills of Material
Use this form to view an indented bill of material. An indented bill of material
is a bill of material that is exploded through many lower levels. You can choose
the number of lower levels that you want to see—up to 60—both by setting the
personal profile value BOM: Default Bill of Material Levels and by choosing a
value when you request the indented bill of material.
Item numbers preceded by a plus sign (+) have components; double-click the
Item number to view the components.
If lower-level components already appear, a minus sign (-) precedes their
assembly item number. To remove the components from view, double-click the
item number or click the double minus sign “--” icon.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Viewing an Indented Bill of Material
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Copying Bills of MaterialCopying Bills of Material

EEDD

BB CC
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XX

Using the Copying Feature
You can save time when you create bills of material by using the Copy feature.
Several of the items that you manufacture, sell, or plan have similar bills of
material. If you want to create similar, alternate bills of material for an item, you
use the Copy Bills of Material feature.
You create a bill of material by copying from these areas:

• The same or a different item number.
• The primary or an alternate bill for that item number.
• The same or a different organization.

The item from which you copy retains its components. The item to which you
copy contains the same components as the item from which you copy.
You can change anything on the copied bill of material except the item number.
The assembly and components must exist in the organization from which you
are copying. After you copy, the two bills of material are no longer related. If
you change one bill of material, you will not see the same change in the other
bill of material. Once you create a copied bill of material, you must use the Bill
of Material Delete function to delete it.
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Copy Bill
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Copy BillCopy Bill

Use the Copy Bill window to:
• Copy a bill from your current organization or from

another organization that shares your same item
master organization

• Copy any revision of a primary or alternate bill
• Modify your new bill as necessary

Engineering (N) Prototypes > Bills > Bills (M) Tools > Copy Bill From
Bills of Material (N) Bills > Bills (M) Tools > Copy Bill From

Use the Copy Bill window to:
• Copy a bill from your current organization or from

another organization that shares your same item
master organization

• Copy any revision of a primary or alternate bill
• Modify your new bill as necessary

Engineering (N) Prototypes > Bills > Bills (M) Tools > Copy Bill From
Bills of Material (N) Bills > Bills (M) Tools > Copy Bill From

Copy Bill
Enter the organization, item number, alternate designator, and revision or date
of the item whose components you want to copy as components of this item.

Note
In Oracle Engineering: (N) Prototypes—>Bills—>Bills
(M) Tools—>Copy Bill from… (B) Copy—>Save
In Oracle Bills of Material: (N) Bills—>Bills
(M) Tools—>Copy Bill from… (B) Copy—>Save
Review the results of the copy to verify copy success.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material >
Copying Bill and Routing Information
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Finding Bills to CompareFinding Bills to Compare

Use the Find Bills to Compare window to:
• Enter selection criteria for Bill 1 and Bill 2
• Check comparison criteria check boxes for the

attributes to compare the bills on

Engineering (N) Prototypes > Bills > Comparison
Bills of Material (N) Bills > Comparison

Use the Find Bills to Compare window to:
• Enter selection criteria for Bill 1 and Bill 2
• Check comparison criteria check boxes for the

attributes to compare the bills on

Engineering (N) Prototypes > Bills > Comparison
Bills of Material (N) Bills > Comparison

Find Bills to Compare
Use this form to enter information about two bills of material that you want to
compare.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Comparing Bills of Material
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Comparing Bill ComponentsComparing Bill Components

Use the Bill Components Comparison window to:
• Compare any two bills. For example, compare the

primary to an alternate bill, the same bill across
organizations, or the current revision of an item to
a future revision

Engineering (N) Prototypes > Bills > Comparison (B) Compare
Bills of Material (N) Bills > Comparison (B) Compare

Use the Bill Components Comparison window to:
• Compare any two bills. For example, compare the

primary to an alternate bill, the same bill across
organizations, or the current revision of an item to
a future revision

Engineering (N) Prototypes > Bills > Comparison (B) Compare
Bills of Material (N) Bills > Comparison (B) Compare

Bill Components Comparison
Use this form to view information about the components of two bills of
material. Refer to the selected column “1” or column “2” values to determine
which components appear in each bill of material.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Comparing Bills of Material
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Requesting Bills of Material
Comparison Report

Requesting Bills of Material
Comparison Report

Use the Report Bill of Material Comparison
window to:
• Request a report comparing two bills of material

(N) Reports > Comparison

Use the Report Bill of Material Comparison
window to:
• Request a report comparing two bills of material

(N) Reports > Comparison

Requesting Bills of Material Comparison Report
In Oracle Engineering and Oracle Bills of Material:
(N) Reports—>Comparison

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Reports and Processes

../ Bill of Material Comparison Report
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Common Bills of MaterialCommon Bills of Material

CommonCommonOriginalOriginal
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When to Use Common Bills of Material
If you need to have identical bills of material for the same item in more than one
organization or use separate items in the same organization, use the Common
Bills of Material feature. You create a Common Bills of Material by referencing
these areas:

• The same or a different item number
• The primary or an alternate bill for that item number
• The same or a different organization

The item that you reference contains the components. The item that is
referencing does not contain components; it contains a link to the referenced
item and organization bill of material. Any function that uses or views the bill of
material for the referencing item will use or view the bill of material of the
referenced item.
When you use common bills of material, you lose the ability to make
organization-specific bill of material changes.
You cannot change anything on the bill of material for the item that is
referencing; it has no components.
If the bill of material of the referenced item has been changed and then you use
or view the bill of material for the item that is referencing, you will use or view
the new components of the referenced item.
The assembly and components must exist in the organization from which you
are making the reference.
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Common BillCommon Bill

Use the Common Bill window to:
• Share bills of material that exist in your

manufacturing organizations with your item
master organization

Engineering (N) Prototypes > Bills > Bills (M) Tools >
Assign Common Bill
Bills of Material (N) Bills > Bills (M) Tools > Assign Common Bill

Use the Common Bill window to:
• Share bills of material that exist in your

manufacturing organizations with your item
master organization

Engineering (N) Prototypes > Bills > Bills (M) Tools >
Assign Common Bill
Bills of Material (N) Bills > Bills (M) Tools > Assign Common Bill

Assigning Common Bill
Enter the organization, item number, and alternate designator of the item whose
components you want to reference as components of this item.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material >
Referencing Common Bills and Routings
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Bill of Material LoopsBill of Material Loops

CCBB

AA

EEDD

AAFF

LoopLoop

Checking for Bill of Material Loops
In Oracle Engineering: (N) Prototypes—>Bills—>Bills
(M) Tools—>Check for Loops
In Oracle Bills of Material: (N) Bills—>Bills (M) Tools—>Check for Loops
Review the note and correct any bill of material loops that the loop check
reports.
A bill of material loop is a situation in which a multilevel bill of material
contains the same item as the top assembly and as a component. Because you
create multilevel bills of material one level at a time, you can inadvertently
create a bill of material loop. Processes that detect a bill of material loop usually
fail entirely or refuse to process the multilevel bill of material containing the
loop.
You can detect bill of material loops by taking these actions:

• Request the Check for Loops concurrent process.
• Wait for a concurrent process that uses bills of material to fail entirely or

refuses to process the multilevel bill of material containing the loop.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Defining a Bill of Material > Checking for Bill Loops
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Requesting Bills of Material ReportsRequesting Bills of Material Reports

Use the Engineering Bill Reports or Bill of Material
Reports window to:
• Request reports showing bill of material

information

(N) Reports > Bills

Use the Engineering Bill Reports or Bill of Material
Reports window to:
• Request reports showing bill of material

information

(N) Reports > Bills

Reports
In Oracle Engineering and Oracle Bills of Material: (N) Reports—>Bills

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Reports and Processes

../ Bill of Material Comparison Report

../ Bill of Material Listing Report

../ Bill of Material Loop Report

../ Bill of Material Structure Report

../ Bills of Material Parameters Report

../ Consolidated Bill of Material Report
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Use the Find Item WhereUsed window to:
• Enter the item, the revision, the revision date, and

the number of levels to implode for the bill of
material

Engineering (N) Prototypes > Bills > Item WhereUsed
Bills of Material (N) Bills > Item WhereUsed

Use the Find Item WhereUsed window to:
• Enter the item, the revision, the revision date, and

the number of levels to implode for the bill of
material

Engineering (N) Prototypes > Bills > Item WhereUsed
Bills of Material (N) Bills > Item WhereUsed

Find Item WhereUsed
Use this form to specify the component whose assemblies you want to view. For
example, if you are proposing a change to a component in multiple bills of
material, you can see the number of assemblies that you would effect.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Viewing Item Usages
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Use the Item WhereUsed window to:
• View an imploded list of all the using assemblies

for a specified component

Engineering (N) Prototypes > Bills > Item WhereUsed (B) Find
Bills of Material (N) Bills > Item WhereUsed (B) Find

Use the Item WhereUsed window to:
• View an imploded list of all the using assemblies

for a specified component

Engineering (N) Prototypes > Bills > Item WhereUsed (B) Find
Bills of Material (N) Bills > Item WhereUsed (B) Find

Item WhereUsed
Use this form to view the assemblies in which a component appears. Use the
Query function to find WhereUsed information for the assemblies.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Viewing Item Usages
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Use the Import Bills and Routing window to:
• Import bill information

Engineering (N) Prototypes > Bills > Import
Bills of Material (N) Bills > Import

Use the Import Bills and Routing window to:
• Import bill information

Engineering (N) Prototypes > Bills > Import
Bills of Material (N) Bills > Import

Importing BOMs and Routings
Use this form to create and change bills of material from information that you
have provided to interface tables in electronic format. Refer to the Oracle
Applications Manufacturing Implementation Guide for information about the
open interface process and file formats.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Importing Bills and Routings
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You should now be able to do the following:
• Create an engineering prototype BOM
• Transfer BOM from engineering to manufacturing
• Copy BOM from engineering to manufacturing
• Create phantom items
• Create alternate BOM
• Perform mass changes to BOM
• Review and prevent BOM loops

You should now be able to do the following:
• Create an engineering prototype BOM
• Transfer BOM from engineering to manufacturing
• Copy BOM from engineering to manufacturing
• Create phantom items
• Create alternate BOM
• Perform mass changes to BOM
• Review and prevent BOM loops

BOM Summary
You use bills of material to specify the component items that you need to
complete these tasks:

• Manufacture assemblies and subassemblies
• Configure sales orders
• Explode aggregate forecasts
• Calculate standard cost

Engineering bills of material are bills of material that your engineering function
creates and are not ready for production. Manufacturing bills of material are
bills of material that you use in production. The forms that you use to create
engineering and manufacturing bills of material are identical.
When your engineering bills of material are ready for production, you can
transfer or copy them to Oracle Bills of Material as manufacturing bills of
material.

• Phantom items are components in a bill of material that usually represent a
nonstocked subassembly.

• You create items in the master organization and assign them to the
manufacturing and distribution organizations in which you use them.
However, you create bills of material in each organization that uses them.

• Each item that has a bill of material has a primary bill of material. If you
create other bills of material for standard and planning items, you refer to
them as alternate bills of material.
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• Use copy and common bills of material to reduce bill of material creation
and maintenance time.

• A bill loop is a situation in which a multilevel bill of material contains the
same item as both the top assembly and as a component.

• You use mass change functionality to make the same component change
in multiple bills of material.

• You use reference designators to specify comments or instructions about
how to use more than one of the same component in the same assembly.
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This practice covers the following topics:
• Creating an item by copying an existing item
• Creating a new BOM by copying an existing BOM
• Creating an alternate BOM for an item in an

organization
• Enabling an item in a second organization and

copying a BOM from the first organization

This practice covers the following topics:
• Creating an item by copying an existing item
• Creating a new BOM by copying an existing BOM
• Creating an alternate BOM for an item in an

organization
• Enabling an item in a second organization and

copying a BOM from the first organization

Practice 2-1
1. Use the following table to create engineering items. Assign the items to the
organization your instructor specifies. Your instructor will assign item templates
that correspond to the values in the “Template Type” column of the table. XX
represents your team.
Item Number/Description Template Type Copied Item
XX1000 Pentium Computer Finished Good
XX1010 17" Monitor Purchased
XX1020 101 Keyboard XX1010
XX1030 Mouse XX1010
XX1040 CPU Chassis Subassembly
XX2010 Motherboard XX1040
XX2011 New Motherboard XX2010
XX2020 Serial Board XX1010
XX2030 1.6GB Hard Drive XX1010
XX2040 3.5 Disk Drive XX1010
XX3010 Blank Board XX1010
XX3020 586 133mHz IC XX1010
XX3030 Resistor XX1010
XX3031 New Resistor XX3030
XX3040 Integrated Circuit XX1010
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2. Create the three bills of material structures.
3. Create item (XX)3031 by copying item (XX)3030.
4. Create item (XX)2011 by copying item (XX)2010.
5. Create a new BOM for (XX)2011 by copying (XX)2010. Add component
(XX)3031 for 20PC and disable (XX)3030 for 20PC.
6. View an indented BOM for item (XX)1000.
7. View a detailed BOM for XX1000 and explode the subassembly.
8. Compare BOM (XX)2010 to BOM (XX)2011.
9. Create an alternate name called (XX)Sub for a substitute part.
10. Create an alternate BOM for item (XX)2010 using alternate name (XX)Sub.
Disable your (XX)3010 and add another team’s (XX)3010 in your alternate
BOM.
11. Enable (XX)2010 in a second organization that your instructor will assign.
Copy its BOM from the organization in which you have already created it.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 79

Practice 2-1 Solution

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 2-1 SolutionPractice 2-1 Solution

Practice 2-1 Solution
1. Use the following table to create engineering items. Assign the items to the
organization that your instructor specifies. Your instructor will assign item
templates that correspond to the values in the Template Type column of the
table. XX represents your team.
Engineering (N) Prototypes—>Items—>Master Items
Item Number/Description Template Type Copied Item
XX1000 Pentium Computer Finished Good
XX1010 17" Monitor Purchased
XX1020 101 Keyboard XX1010
XX1030 Mouse XX1010
XX1040 CPU Chassis Subassembly
XX2010 Motherboard XX1040
XX2020 Serial Board XX1010
XX2030 1.6GB Hard Drive XX1010
XX2040 3.5 Disk Drive XX1010
XX3010 Blank Board XX1010
XX3020 586 133mHz IC XX1010
XX3030 Resistor XX1010
XX3040 Integrated Circuit XX1010
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xx1000
Pentium
Computer

xx1010
17" Monitor
QPA1

xx1020
Keyboard
QPA1

xx1030
Mouse
QPA1

xx1040
Chassis
QPA1

xx2010
Motherboard
QPA1

xx2020
Serial Board
QPA1

xx2030
1.6GB HD
QPA1

xx2040
3.5 Disk Dr.
QPA1

xx3010
Blank Board
QPA1

xx3020
586 MHz
QPA2

xx3030
Resistor
QPA20

xx3040
IC
QPA10

Practice 2-1 Solution (continued)
2. Create the three bills of material structures.
Engineering (N) Prototypes—>Bills—>Bills
3. Create item XX3031 by copying item XX3030.
Engineering (N) Prototypes—>Items—>Master Items (M) Tools—>Copy
from
4. Create item XX2011 by copying item XX2010.
Engineering (N) Prototypes—>Items—>Master Items (M) Tools—>Copy
from
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Practice 2-1 Solution (continued)
5. Create a new BOM for (XX)2011 by copying (XX)2010. Add component
(XX)3031 for 20PC and disable (XX)3030 for 20PC.
(N) Prototypes—>Bills—>Bills (M)Tools—>Copy Bill from
(N) Prototypes—>Bills—>Bills



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 82

Practice 2-1 Solution

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 2-1 SolutionPractice 2-1 Solution

Practice 2-1 Solution (continued)
6. View an indented bill of material for item XX1000.
Engineering (N) Prototypes—>Bills—>Indented Bills
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Practice 2-1 Solution (continued)
7. View a detailed bill of material for XX1000 and explode the subassembly.
(N) Prototypes—>Bills—>Indented Bills (M)Tools—>Expand All
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Practice 2-1 Solution (continued)
8. Compare BOM XX2010 to BOM XX2011.
Engineering (N) Prototypes—>Bills—>Comparison



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 85

Practice 2-1 Solution
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Practice 2-1 Solution (continued)
9. Create an alternate name called (XX)Sub for a substitute part.
Bills of Material (N) Setup—>Alternates
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Practice 2-1 Solution (continued)
10. Create an alternate BOM for item (XX)2010 using alternate name (XX)Sub.
Disable your (XX)3010 and add another team’s (XX)3010 in your alternate
BOM.
Engineering (N) Prototypes—>Bills—>Bills
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Practice 2-1 Solution (continued)
11. Enable XX2010 in a second organization that your instructor will assign.
Copy its bill of material from the organization in which you have already
created it.
Engineering (N) Prototypes—>Items—>Master Items
(M) Tools—>Organization Assignment
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Practice 2-1 Solution (continued)
(N) Prototypes—>Bills—>Bills (M) Tools—>Copy Bill from
Your BOM should look like this in your new organization. Remember to save
your work.
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• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material
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After completing this section, you should be able to
do the following:
• Transfer engineering product information to

production
• Copy engineering product information to

production

After completing this section, you should be able to
do the following:
• Transfer engineering product information to

production
• Copy engineering product information to

production
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• When you decide that engineering information is
ready for production, you transfer the product
information (items, bills of material, and routing)
from engineering to manufacturing.

• Transferring removes the information from the
engineering side and adds it to the manufacturing
side.

• Copying leaves the information in the engineering
side and creates a new item, BOM, and routing on
the manufacturing side.

• When you decide that engineering information is
ready for production, you transfer the product
information (items, bills of material, and routing)
from engineering to manufacturing.

• Transferring removes the information from the
engineering side and adds it to the manufacturing
side.

• Copying leaves the information in the engineering
side and creates a new item, BOM, and routing on
the manufacturing side.
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EngineeringEngineering ProductionProduction

Transferring Product Information
When you decide that engineering information is ready for production, you
transfer the product information—items, bills of material, and routings— from
engineering to manufacturing.
When you transfer engineering information, you transform the engineering item
into a manufacturing item and the engineering item ceases to exist.
When you copy engineering information, you save the engineering information
and copy it to manufacturing as another item number.
The transfer and copy sequence is a one-way process. You cannot transfer or
copy product information from manufacturing to engineering.
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Manufacturing

Transferring Information To
Manufacturing

Use the Transfer to Manufacturing window to:
• Transfer engineering information like items, bills,

and routings to production

Engineering (N) Prototypes > Transfer to Manufacturing

Use the Transfer to Manufacturing window to:
• Transfer engineering information like items, bills,

and routings to production

Engineering (N) Prototypes > Transfer to Manufacturing

Transfer to Manufacturing
Transferring Product Information to Manufacturing: Revision
Use this form to transfer engineering information like items, bills, and routings
to production.
1. Enter the number of the item that you want to transfer.
2. Select the structures—item, bill, and routing—that you want to transfer.
3. If you want the transfer event to mark a change in item and routing revisions,
enter the new revisions.
4. You must transfer from the lowest subassembly and continue up to the
finished good or end item.
Manufacturing: Alternates
If you want to transfer a specific alternate item, then you select the specific
alternate name you want to transfer. If you leave the alternate product
information blank, the primary and all alternate BOMs will transfer.
Manufacturing: ECO, Description
1. If the transfer occurs because of a documented change order, you may
indicate the engineering change order (ECO) number. The ECO number will
only transfer if you increase the revision of the item or the routing.
2. Select Transfer.
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(Help) Oracle Manufacturing Applications > Oracle Engineering >
Engineering Prototype Environment >
Transferring or Copying Engineering Items
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• Transfer bills of material and routings that you
reference in common bills of material and routings
before transferring the bills of material that
contain the reference

• If you transfer an assembly bill of material and
have not transferred the component items in the
bill of material, the transfer process will transfer
the component item information before
transferring the bill of material

• Transfer bills of material and routings that you
reference in common bills of material and routings
before transferring the bills of material that
contain the reference

• If you transfer an assembly bill of material and
have not transferred the component items in the
bill of material, the transfer process will transfer
the component item information before
transferring the bill of material

Transferring Product Information to Manufacturing: Transfer Details
1. Select Implemented Only to prevent transfer of bill of material information
that is waiting for implementation from an engineering change order.
2. Future and Current transfers all components that are effective on and after the
date and time in the Effective Date field.
3. The All button transfers all components.
4. Select “OK.”
Hints
Use this feature to reduce data entry when you transfer engineering information.
The item transfer occurs at the organization level.
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Use the Copy to Manufacturing window to:
• Copy engineering prototype items, bills, and

routings to production

Engineering (N) Prototypes > Copy to Manufacturing

Use the Copy to Manufacturing window to:
• Copy engineering prototype items, bills, and

routings to production

Engineering (N) Prototypes > Copy to Manufacturing

Copy to Manufacturing
Use this form to copy engineering prototype information—items, bills, and
routings—to production.
1. Enter the number of the item from which you want to copy.
2. Select the structures—item, bill, or routing—that you want to copy.
3. If you want the copy event to mark a change in item and routing revisions,
enter the new revisions.
Manufacturing: Alternates
If you want to copy a specific alternate, then you select an alternate item,
routing, or BOM that already exists in engineering.
Manufacturing: Descriptions
1. If the copy occurs because of a documented change order, you may indicate
the engineering change order (ECO) number. The ECO number will only
transfer if you increase the revision of the item on the routing.
2. Select copy.
Manufacturing: Manufacturing Items
1. Enter the item number and description of the new production item number.
2. Select Copy.
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(Help) Oracle Manufacturing Applications > Oracle Engineering >
Engineering Prototype Environment >
Transferring or Copying Engineering Items
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• If you copy an assembly bill of material and have
not transferred the component item in the bill of
material, the BOM structure will not copy the
component item.

• If you copy an assembly bill of material and have
not transferred the component item in the bill of
material, the BOM structure will not copy the
component item.

Transfer Details
1. Select Implemented Only to prevent copying of bill of material information
that is waiting for implementation from an engineering change order.
2. Select Future and Current to copy all components that are effective on and
after the date and time in the Effective Date field.
3. Select “All” to copy all components.
4. Select OK.
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True or False

• Transferring and copying engineering data is
organization specific.

True or False

• Transferring and copying engineering data is
organization specific.

Review QuestionReview Question
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True or False

• Transferring and copying engineering data is
organization specific.
True
You can only transfer or copy an engineering item,
bill, or routing to manufacturing within the same
organization.

True or False

• Transferring and copying engineering data is
organization specific.
True
You can only transfer or copy an engineering item,
bill, or routing to manufacturing within the same
organization.

Answer to Review QuestionAnswer to Review Question



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 101

Summary

Copyright  Oracle Corporation, 2000. All rights reserved.
®

SummarySummary

You should now be able to do the following:
• Transfer engineering product information to

production
• Copy engineering product information to

production
• Transfer alternate product information to

production

You should now be able to do the following:
• Transfer engineering product information to

production
• Copy engineering product information to

production
• Transfer alternate product information to

production

Summary
When you decide that engineering information is ready for production, you
transfer the product information—items, bills of material, and routings— from
engineering to manufacturing.
When you transfer engineering information, you transform the engineering item
into a manufacturing item. The original engineering item ceases to exist.
When you copy engineering information, you save the engineering information
and copy it to manufacturing as another item number.
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This practice covers the following topics:
• Transferring engineering items
• Copying engineering items
• Reviewing your entries

This practice covers the following topics:
• Transferring engineering items
• Copying engineering items
• Reviewing your entries

Practice 3-1
1. Transfer BOMs for item numbers XX2010, XX1040, and XX1000 from
engineering to production.
Note: XX represents your team.
2. To verify the transfers, view XX1000 on the following forms and indicate
whether or not you are able to use each form to see the items:

• Oracle Inventory Master Items
• Oracle Engineering Master Items
• Oracle Inventory View Item Attributes
• Oracle Engineering View Item Attributes
• Oracle Bills of Material
• Oracle Engineering Bill of Material
• Oracle Bills of Material Indented Bills
• Oracle Engineering Indented Bills

3. Copy item XX2011 and give it a new name using item number XX2022.
View your results.
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Practice 3-1 Solution
1. Transfer BOM’s for item numbers XX2010, XX1040, and XX1000 from
engineering to production.
Note: XX represents your team.
(N) Prototype—>Transfer to Manufacturing
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Practice 3-1 Solution (continued)
2. To verify the transfers, view XX1000 on the following forms and indicate
whether or not you are able to use each form to see the items:
Oracle Inventory Master Items

• Inventory (N) Items—>Master Items; able to see the items
Oracle Engineering Master Items

• Engineering (N) Prototypes—>Items—>Master Items; not able to see
the items

Oracle Inventory View Item Attributes
• Inventory (N) Items—>View Item Details; able to see the items

Oracle Engineering View Item Attributes
•  Engineering (N) Prototypes—>Items—>View Item Details; able to

see the items
Oracle Bills of Material Bill of Material

• Bills of Material (N) Bills—>Bills; able to see the items
Oracle Engineering Bill of Material

• Engineering (N) Prototypes—>Bills—>Bills; not able to see the items
Oracle Bills of Material Indented Bills

• Bills of Material (N) Bills—>Indented Bills; able to see the items



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 105

Oracle Engineering Indented Bills
• Engineering (N) Prototypes—>Bills—>Indented Bills; able to see the

items
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Practice 3-1 Solution (continued)
3. Copy item XX2011 and give it a new name using item number XX2022.
View your results.
Engineering (N) Prototype—> Copy to Manufacturing
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• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material
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ObjectivesObjectives

After completing this section, you should be able to
do the following:
• Perform a mass change operation using Oracle

Bills of Material
• Perform a mass change operation using Oracle

Engineering
• Review entries for accuracy

After completing this section, you should be able to
do the following:
• Perform a mass change operation using Oracle

Bills of Material
• Perform a mass change operation using Oracle

Engineering
• Review entries for accuracy
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• Using mass changes, you can perform the same
change to multiple bills of material.

• You can search for all BOM that contain specific
components that you want to change.

• You can review your entries and changes for
accuracy and effectivity.

• Using mass changes, you can perform the same
change to multiple bills of material.

• You can search for all BOM that contain specific
components that you want to change.

• You can review your entries and changes for
accuracy and effectivity.
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EE

CCBB

P1P1

DD MM

EE

CCBB

P2P2

DD MM

EE

CCBB

P3P3

DD MM

Mass Changes
Using mass changes, you can perform the same change to multiple bills of
material. You cannot use the mass change functionality with routings. When
you make mass changes to bills of material, you can perform the following
actions:

• Change information about an existing component
• Add a component
• Replace one component with another
• Disable a component

You can search for all bills of material that contain the component that you want
to change, replace, or delete.
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Mass ChangesMass Changes

OracleOracle
Bills of MaterialBills of Material

OracleOracle
EngineeringEngineering

 Change bill of
material

 Create
engineering

change order

 Change bill of
material

Mass Changes (continued)
You can use both Oracle Bills of Material and Oracle Engineering to perform
mass changes.
You can perform mass changes in both engineering and production bills of
material in Oracle Engineering and production bills of material in Oracle Bills
of Material. However, you cannot make mass changes to a bill of material
type—Standard, Option Class, Model, or Planning—if you do not have personal
profile permission to change that bill of material type manually.
Depending on the application that you use, the mass change operates differently
in the following ways:

• When you perform a mass change using Oracle Bills of Material, you
change the bill of material immediately.

• When you perform a mass change using Oracle Engineering, you create an
engineering change order. When you implement the engineering change
order, you have changed the bills of material.
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Mass ChangesMass Changes

EE

CCBB

P1P1

DD MM

EE

CCBB

P2P2

DD MM

EE

CCBB

P3P3

DD MM

Mass Changes (continued)
You can use the mass change functionality to make the same component change
in multiple bills of material or to replace, delete, and update one or more
component items in many bills of material at the same time.
Engineering lets you create an ECO based on your parent item and component
criteria. A mass change ECO lists all assemblies that meet your search criteria
as revised items, and assigns all component changes as revised components.
You can manage and implement each revised item, or the entire ECO, the same
way you maintain revised items you manually assign to an ECO.
Note: In Bills of Material, mass changes take place immediately. However, in
Engineering, an ECO is created that must be implemented to take effect.
Perform mass changes in the bills of material as needed. Be sure to set ECO
options.
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Entering Mass Change BillsEntering Mass Change Bills

Use the Mass Change Bills window to:
• Enter the change number, type and description of

the change

Engineering (N) ECOs > Mass Changes
Bills of Material (N) Bills > Mass Changes

Use the Mass Change Bills window to:
• Enter the change number, type and description of

the change

Engineering (N) ECOs > Mass Changes
Bills of Material (N) Bills > Mass Changes

Component Changes
To create a mass change:
1. Enter the change number, type, and description of the change.
2. Indicate if the mass change process should increment the revision of the
assemblies that it changes and update unreleased discrete jobs and repetitive
schedules. Mass change will automatically update numerical revision numbers
only.
3. Select the parent items whose bills of material you want to change.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Mass Changing Bills of Material
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Entering Component Mass ChangesEntering Component Mass Changes

Use the Component Changes window to:
• Enter information about components that you

want to add, change, or disable

Use the Component Changes window to:
• Enter information about components that you

want to add, change, or disable

Component Changes: Main Region
Enter information about components that you want to add, change, or disable.
The fields in this form are similar to those on the bills of material form.

Creating a Mass Change
Select Report to request a trial run of the mass change without actually updating
the database or creating the engineering change order; or select Implement to
request the database update or engineering change order creation, and then
choose Submit.
Review the mass change report prior to implementing if using mass change
through BOM. Implement the change after review.
Review ECO prior to implementing if using mass change through engineering.
Implement the ECO after reviewing and approving.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material  > Mass Changing Bills of Material
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When performing a mass change, if you do not wish
to replace the values for the Supply Type, Supply
Subinventory, and Supply Locator fields, what must
you do?

When performing a mass change, if you do not wish
to replace the values for the Supply Type, Supply
Subinventory, and Supply Locator fields, what must
you do?
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When performing a mass change, if you do not wish
to replace the values for the Supply Type, Supply
Subinventory, and Supply Locator fields, what must
you do?

You must enter the current value when executing a
mass change.  If you leave the Supply Type, Supply
Subinventory, and Supply Locator fields blank when
entering component changes, their values will be
replaced by the blank (null) value when the mass
change is executed.

When performing a mass change, if you do not wish
to replace the values for the Supply Type, Supply
Subinventory, and Supply Locator fields, what must
you do?

You must enter the current value when executing a
mass change.  If you leave the Supply Type, Supply
Subinventory, and Supply Locator fields blank when
entering component changes, their values will be
replaced by the blank (null) value when the mass
change is executed.
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True or False

• You can undo a mass change.

True or False

• You can undo a mass change.

Review QuestionReview Question



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 118

Answer to Review Question

Copyright  Oracle Corporation, 2000. All rights reserved.
®

True or False

• You can undo a mass change.
False
You can not undo a mass change.  However, you
can create another mass change to reverse the
effects of a previous mass change.

True or False

• You can undo a mass change.
False
You can not undo a mass change.  However, you
can create another mass change to reverse the
effects of a previous mass change.

Answer to Review QuestionAnswer to Review Question
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You should now be able to do the following:
• Perform a mass change operation using Oracle

Bills of Material
• Perform a mass change operation using Oracle

Engineering
• Review entries for accuracy

You should now be able to do the following:
• Perform a mass change operation using Oracle

Bills of Material
• Perform a mass change operation using Oracle

Engineering
• Review entries for accuracy

Summary
Using mass changes, you can perform the same change to multiple bills of
material. You can search for all bills of material that contain the component that
you want to change, replace, or delete.
You can add, change, and disable components.
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This practice covers performing mass changes
using the Bill of Material form.
This practice covers performing mass changes
using the Bill of Material form.

Practice 4-1
1. Perform a mass change operation on assemblies AS65101, AS65102, and
AS65103 using the Oracle Bills of Material form.
2. Use the following information to complete the practice:

• Type Prod Chg
• Increment Revision Yes
• Items: AS65101 - AS65103
• Actions Report and Implement

3. Disable item CM51564, the Vision Pad Bag.
4. Submit the change.
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Practice 4-1 SolutionPractice 4-1 Solution

Practice 4-1 Solution
Perform a mass change operation on assemblies AS65101, AS65102, and
AS65103 using the Oracle Bills of Material form.
(N) Bills—>Mass Changes
1. Enter the following information:

• Type Prod Chg
• Increment Revision Yes
• Items: AS65101 - AS65103
• Actions: Report and Implement

2. Choose the Changes button on the Mass Change Bills window.
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Practice 4-1 Solution (continued)
Disable item CM51564, the Vision Pad Bag and submit the change.
(N) Bills—>Mass Changes
1. On the Component Changes form disable item number CM51564.
2. Choose the Submit button to launch the selected actions, Report and
Implement.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Creating Bills of Material
Chapter 2 - Page 123

Agenda

Copyright  Oracle Corporation, 2000. All rights reserved.
®

AgendaAgenda

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material

• Using Online Help
• Overview of Bills of Material
• Creating Bills of Material
• Transferring Product Information
• Performing Mass Changes
• Summary of Bills of Material
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PlanningPlanning

ModelModel

Option classOption class

StandardStandard

Bill ofBill of
MaterialMaterial
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Transferring Product InformationTransferring Product Information

EngineeringEngineering ProductionProduction
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OracleOracle
Bills of MaterialBills of Material

OracleOracle
EngineeringEngineering

 Change bill of
material

 Create
engineering

change order

 Change bill of
material
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SummarySummary

In this component, you should have learned how to:
• Create bills of material
• Copy and change bills of material
• Compare bills of material
• Transfer engineering product information to

production
• Copy engineering product information to

production
• Perform a mass change operation

In this component, you should have learned how to:
• Create bills of material
• Copy and change bills of material
• Compare bills of material
• Transfer engineering product information to

production
• Copy engineering product information to

production
• Perform a mass change operation
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Oracle Manufacturing - Create Routings Release 11i

Oracle Engineering > Resources

Oracle Bills of Material > Resources

Oracle Engineering > Resource Costs

Oracle Bills of Material > Resource Costs

Oracle Engineering > Resource Overhead Associations

Oracle Bills of Material > Resource Overhead Associations

Oracle Bills of Material > Quick Codes (CRP_RESOURCE_GROUPS)

Oracle Bills of Material > Simulation Sets

Oracle Bills of Material > Department Classes

Oracle Bills of Material > Location

Oracle Engineering > Departments

Oracle Bills of Material > Departments

Oracle Engineering > Overhead Rates

Oracle Bills of Material > Overhead Rates

Oracle Engineering > Resources

Oracle Bills of Material > Resources

Oracle Engineering > Shifts

Oracle Bills of Material > Shifts

Oracle Engineering > Capacity Changes

Oracle Bills of Material > Capacity Changes

Oracle Engineering > Engineering Routings

Oracle Bills of Material > Routings

Oracle Engineering > Routing Revisions

Oracle Bills of Material > Routing Revisions
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Oracle Engineering > Viewing Routings

Oracle Bills of Material > Viewing Routings

Oracle Engineering > Reports

Oracle Bills of Material > Reports

Oracle Engineering > Operation Resources

Oracle Bills of Material > Operation Resources

Oracle Engineering > Standard Operations

Oracle Bills of Material > Standard Operations

Oracle Engineering > Resources

Oracle Bills of Material > Resources

Oracle Engineering > Resource WhereUsed

Oracle Bills of Material > Resource WhereUsed

Oracle Engineering > Attachments

Oracle Bills of Material > Attachments

Oracle Engineering > Operation Documents

Oracle Bills of Material > Operation Documents

Oracle Engineering > Common Routing

Oracle Bills of Material > Common Routing

Oracle Engineering > Copy Routing

Oracle Bills of Material > Copy Routing

Oracle Engineering > Import Bills and Routings

Oracle Bills of Material > Import Bills and Routings

Oracle Engineering > Engineering Master Items

Oracle Engineering > Engineering Organization Items

Oracle Inventory > Master Items
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Oracle Inventory > Organization Items

Oracle Engineering > Engineering Routings

Oracle Bills of Material > Routings

Oracle Engineering > Operation Resources

Oracle Bills of Material > Operation Resources

Oracle Engineering > Calculate Lead Times

Oracle Bills of Material > Calculate Lead Times

Oracle Engineering > Transfer to Manufacturing

Oracle Engineering > Copy to Manufacturing
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Create RoutingsCreate Routings

Oracle Manufacturing Release 11iOracle Manufacturing Release 11i
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AgendaAgenda

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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AgendaAgenda

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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ObjectivesObjectives

After completing this module, you should be able to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information

After completing this module, you should be able to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information
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Using Oracle Applications HelpUsing Oracle Applications Help

1. Navigate to the Oracle Applications Navigator.
2. Select Help—>Window Help from the menu bar.

The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Help field and click Find.
Oracle Applications Help displays a list of topics
that meet your search criteria.

4. Click a topic to view detailed information.
Note: Click Search Instructions for help with
searching Oracle Applications Help.

1. Navigate to the Oracle Applications Navigator.
2. Select Help—>Window Help from the menu bar.

The Oracle Applications Help window is displayed.
3. Enter your search criteria, enclosed within

quotation marks, in the Help field and click Find.
Oracle Applications Help displays a list of topics
that meet your search criteria.

4. Click a topic to view detailed information.
Note: Click Search Instructions for help with
searching Oracle Applications Help.
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Using Oracle Applications Help Within a
Window

Using Oracle Applications Help Within a
Window

1. Open a window in the application you are using.
2. Select Help—>Window Help from the menu bar.

Oracle Applications Help displays detailed
information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.

1. Open a window in the application you are using.
2. Select Help—>Window Help from the menu bar.

Oracle Applications Help displays detailed
information about the window you opened,
including step-by-step instructions for entering
information in each field in the window.
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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Workday Calendar
You use the workday calendar to specify to the Oracle manufacturing applications your
workdays, your non-workdays, and your shifts.
Workday exceptions make allowances for the days that will not conform to the workday
pattern.
Shifts are the times when workers will be productive and do not include breaks, lunch or
any other scheduled nonproductive time.
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Resources and Departments
Resources are anything—except component material—required to manufacture,
cost, and schedule products. Each costed resource can have any number of
associated costs, including overhead cost. Once you assign resources to
routings, other Oracle Applications use them for setting item standard costs,
scheduling discrete jobs, and planning for capacity.
A department is a collection of resources designed to do certain tasks. A
department class is a collection of departments.
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Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1 Resource 2Resource 2

AA

Operation 20
Dept. B

Operation 20
Dept. B

Resource 1Resource 1 Resource 2Resource 2

Routings
You use routings to specify the resources and departments that you use to
manufacture, cost, and schedule assembly items. You must create resources and
departments before you create routings.
You assign department resources to an operation.
If you need to have identical routings for more than one item, you can use the
common routings feature.
Create routings by copying an existing routing.
You can review the information you have entered with reports and view  screens.
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Calculating Lead TimesCalculating Lead Times

ItemItem    LT.LT. StartStart      CompleteComplete
AA 22 1717 1919
B B 6     6     9 9 1717
CC 55 1010 1717
D      D      66 2 2 1010
E      E      44 44 1010

JulyJuly

Lead time: 5Lead time: 5

Lead time: 6Lead time: 6

Lead time: 6Lead time: 6

Lead time: 2Lead time: 2

Lead time: 5Lead time: 5

D A

C

B

E

11 22 33 44 55 66 77 88 99 1010 1111 1212 1313 1414 1515 1616 1717 1818 1919 2020 2121

Lead Times
Lead times are item, operation, and operation resource attributes that refer to the
amount of time you need to obtain or manufacture an item.
You can:
• Plan material and resources quickly and accurately.
• Establish appropriate planning time fences for products.
• Create purchase orders for material, accounting for vendor lead time.
• Schedule material to arrive at an operation where it is consumed.
• Schedule each resource at an operation where it is consumed.
• Promise accurate product shipment dates.
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Transferring Product Information

EngineeringEngineering ProductionProduction

Transferring Product Information
When you decide that engineering information is ready for production, you
transfer the product information (items, bills of material, and routing) from
engineering to manufacturing.
Transferring removes the information from the engineering side and adds it to the
manufacturing side.
Copying leaves the information in the engineering side and creates a new item,
bill of material, and routing on the manufacturing side.
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IntegrationIntegration

OracleOracle
EngineeringEngineering

OracleOracle
InventoryInventory

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Inventory
You can use items from Oracle Inventory as assemblies for engineering or bills
of material routings.
Use lead times to perform reorder point planning.
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IntegrationIntegration

OracleOracle
EngineeringEngineering

OracleOracle
InventoryInventory

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Work in Process (WIP)
When you create discrete jobs and repetitive schedules, Oracle Work in Process
(WIP) bases the operations list on the routings of the assembly.
Discrete job detailed scheduling uses resource times from the routings of the
assembly.
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IntegrationIntegration

Oracle SupplyOracle Supply
Chain PlanningChain Planning

Oracle MasterOracle Master
Schedule/MRPSchedule/MRP

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Master Scheduling/MRP
and Oracle Supply Chain Planning

The requirements explosion helps you use lead times for lead time offset and
time fences.
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Oracle CapacityOracle Capacity

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Capacity
Capacity scheduling helps you use resource times from the routings of the
assembly.



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 3 - Page 21

Integration

Copyright   Oracle Corporation,  2000. All rights reserved.
®

IntegrationIntegration

OracleOracle
PurchasingPurchasing

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Purchasing
Oracle Purchasing helps you use lead times for outside processing purchase
requisitions and purchase orders.
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OracleOracle
OrderOrder

ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Order Management
The assemble-to-order processes use model and option class routings to create
configured routings that are unique to a sales order line.



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 3 - Page 23

Integration

Copyright   Oracle Corporation,  2000. All rights reserved.
®

IntegrationIntegration

Oracle CostOracle Cost
ManagementManagement

OracleOracle
EngineeringEngineering

OracleOracle
Bills of MaterialBills of Material

Integrating with Oracle Cost Management
Oracle Cost Management helps you enter resource costs and overhead costs and
department overhead costs for the cost rollup process to set standard costs.
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Review QuestionReview Question

What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Bills of material and resources

What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Bills of material and resources
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Answer to Review QuestionAnswer to Review Question

What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Resources and bills of material

What must you create before you create routings?
1. Resources and departments
2. Lead times and operations
3. Engineering information and lead times
4. Resources and bills of material
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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Workday Calendar
You use the workday calendar to specify to the Oracle manufacturing
applications your workdays, your non-workdays, and your shifts. The workday
calendar is different from the financial calendars.

To completely create a calendar, you need to:
• Create a calendar name and starting and completion dates
• Specify a general workday pattern
• Specify exceptions to the general workday pattern
• Specify shifts
• Specify a shift workday pattern if it is different from the general workday

pattern
• Specify exceptions to any shift workday patterns
• Build the calendar



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 3 - Page 28

Workday Patterns

Copyright   Oracle Corporation,  2000. All rights reserved.
®

11 22 33 44 55 66 77 88 99 1010 1111 1212 1313 1414 1515 1616 1717 1818 1919 2020 2121

Workday PatternsWorkday Patterns

Workday Patterns
You specify the regular pattern of workdays (days on) and nonworkdays (days
off). The calendar build process denotes each day as a day on or a day off
according to the workday pattern that you specify.
You must state a workday pattern for the plant. You can state a workday pattern
for a specific shift.
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Workday ExceptionsWorkday Exceptions

Workday exceptionsWorkday exceptions

WorkdayWorkday
patternpattern

11 22 33 44 55 66 77 88 99 1010 1111 1212 1313 1414 1515 1616 1717 1818 1919 2020 2121

Workday Exceptions
You usually have exceptions to the regular workday pattern. Workday
exceptions are:

• Specific days in the calendar that are days on according to the workday
pattern but that are actually days off, such as holidays.

• Specific days in the calendar that are days off according to the workday
pattern but that are actually days on, such as work on a weekend for the
end of a quarter.

• You can state workday exceptions for the plant and for a specific shift.
To specify exceptions, you can:

• View a graphical display of each month and select days that are exceptions
• Use a form to create a list of the exception days (exception list) for the

calendar
• Copy exception lists from other calendars
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Use the Exception Templates window to create
workday exception templates.
Use the Exception Templates window to create
workday exception templates.

In Oracle Bills of Material: (N) Setup > Exception Templates
(Help) Oracle Bills of Material > Workday Calendar > Creating a
Workday Exception Template
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Use the Workday Calendar window to create workday
calendars.
Use the Workday Calendar window to create workday
calendars.

In Oracle Bills of Material: (N) Setup > Calendars
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 3
(> Related Topics)
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This practice covers creating a workday calendar.This practice covers creating a workday calendar.

Practice 1 Instructions
1. Create a workday calendar with a workday pattern and shifts that match your
facility.
2. View the calendar months.
3. Apply exceptions to the calendar and view the exceptions if necessary.
4. Build the calendar.
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Practice 1 SolutionPractice 1 Solution

Create a workday calendar.Create a workday calendar.

Practice 1 Solution
1. Create a workday calendar with workday pattern and shifts that match your
facility.
(N) Bills of Material > Setup > Calendars (B) Workday Pattern
(N) Bills of Material > Setup > Calendars (B) Shifts
2. View the calendar or shift months.
(N) Bills of Material > Setup > Calendars (B) Shifts (B) Dates
3. Apply exceptions to the calendar and view the exceptions if necessary.
(N) Bills of Material > Setup > Calendars (M) Tools > Exception
Templates, then (B) Dates > Exception List or (B) Shifts (B) Dates >
Exception List
To copy, use (N) Bills of Material > Setup > Calendars (M) Tools > Copy
4. Build the calendar.
(N) Bills of Material > Setup > Calendars (M) Tools > Build
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Review QuestionReview Question

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts
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Answer to Review QuestionAnswer to Review Question

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts

Which entity is not part of the workday calendar
process?
1. Build
2. Resources
3. Exceptions
4. Shifts
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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Resources
Resources are anything—except component material—required to manufacture,
cost, and schedule products. You identify resources, associate them with
departments, state the resource work shifts. When you create routings, you as
sign them to its operations. Once in the routings, the resources are used for
setting item standard costs, scheduling discrete jobs, and planning for capacity.
For discrete manufacturing, resources include people (for example, a
machinist), machines or tools (for example, a drill press), space (for example, a
finished goods stockroom), and time (for example, queue time).
When you charge a resource, you add the cost of the resource to the cost of a
discrete job or a repetitive schedule in Oracle Work in Process (WIP).
You can permanently adjust the availability of the resource by using the
following factors:
· Utilization: The percent of time during which the resource is not performing
work on a product as described in the manufacturing routings. The routings
describe setup, run, and teardown times. For example, an employee who is
present for eight hours each day attends a planning meeting for one-half hour at
the beginning of each day and cleans up for one-half hour at the end of each
day. The employee’s utilization is seven hours of eight hours (7 / 8 * 100) or
87.5 percent.
· Efficiency: The percent of work that the resource can produce in a day in
relation to the standard times. For example, an employee is
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new and you expect that, for the first six months, the employee will be able to
complete 75 percent of the work of more experienced
employees doing the same work. Since you set your standard times based on
experienced employees, you indicate the new
employee’s utilization at 75 percent.
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Use the Resources window to define resources.Use the Resources window to define resources.

In Oracle Engineering: (N) Prototypes > Routings > Resources
In Oracle Bills of Material: (N) Routings > Resources
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 7
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Use the Resource Costs window to enter resource
unit costs.
Use the Resource Costs window to enter resource
unit costs.

In Oracle Engineering: (N) Prototypes > Routings > Resources (B)
Rates
In Oracle Bills of Material: (N) Routings > Resources (B) Rates
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 7
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Use the Resource Overhead Associations window to
specify the overhead charge type, cost, and resource
overhead.

Use the Resource Overhead Associations window to
specify the overhead charge type, cost, and resource
overhead.

In Oracle Engineering: (N) Prototypes > Routings >
Resources (B) Overheads
In Oracle Bills of Material: (N) Routings > Resources (B) Overheads
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 7
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Use the Quick Codes (CRP_RESOURCE_GROUPS)
window to define resource groups.
Use the Quick Codes (CRP_RESOURCE_GROUPS)
window to define resource groups.

In Oracle Bills of Material: (N) Setup > Resource Groups
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 8
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Use the Simulation Sets window to define simulation
sets.
Use the Simulation Sets window to define simulation
sets.

In Oracle Bills of Material: (N) Setup > Simulation Sets
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 9
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Department class: ProductionDepartment class: Production

Department: MachiningDepartment: Machining Department: WeldingDepartment: Welding

MachinistMachinist

Drill pressDrill press

Shift 2Shift 2

Shift 1Shift 1

Shift 2Shift 2

Shift 1Shift 1

WelderWelder

Welding
torch

Welding
torch

Shift 1Shift 1

Shift 1Shift 1

Departments and Department Classes
A departments is a collection of resources designed to do certain tasks. For
example, you might group the drill presses and machinists into a department.
Departments are also called work centers.
A department class is a collection of departments. For example, you might
group the welding, machining, plating, and painting departments into the
“manufacturing” department class, and you might group the unit test and final
test departments into the “quality” department class.
Resources, Departments, and Shifts
You assign resources to one or more departments, and you can share resources
with other departments.
A shift represents a period of time during which a resource is available for
work. You specify the times for your shifts in the workday calendar. When you
assign the resource to its department, you specify the shifts in which the
resource is available.
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Use the Department Classes window to define
department classes.
Use the Department Classes window to define
department classes.

In Oracle Bills of Material: (N) Setup > Department Classes
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step 6
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Use the Location window to define locations to use
with outside processing items.
Use the Location window to define locations to use
with outside processing items.

In Oracle Bills of Material: (N) Setup > Locations
(Help) Oracle Purchasing > Setting Up > Defining Locations
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Use the Departments window to define departments.Use the Departments window to define departments.

In Oracle Engineering: (N) Prototypes > Routings > Departments
In Oracle Bills of Material: (N) Routings > Departments
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
11
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Use the Overhead Rates window to associate
overheads with departments.
Use the Overhead Rates window to associate
overheads with departments.

In Oracle Engineering: (N) Prototypes > Routings > Departments  (B)
Rates
In Oracle Bills of Material: (N) Routings > Departments (B) Rates
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
14
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Use the Resources window to assign resources to
departments.
Use the Resources window to assign resources to
departments.

In Oracle Engineering: (N) Prototypes > Routings > Departments (B)
Resources
In Oracle Bills of Material: (N) Routings > Departments (B) Resources
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
12
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Use the Shifts window to specify resource shifts.Use the Shifts window to specify resource shifts.

In Oracle Engineering: (N) Prototypes > Routings > Departments (B)
Resources (B) Shifts
In Oracle Bills of Material: (N) Routings > Departments (B) Resources
(B) Shifts
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
12
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11 22 33 44 55 66 77

88 99 1010 1111 1212 1313 1414

1515 1616 1717 1818 1919 2020 2121

2222 2323 2424 2525 2626 2727 2828

Add capacity
Capacity change = +1
Available capacity =

24 hours

Add capacity
Capacity change = +1
Available capacity =

24 hours

Reduce capacity
Capacity change = -1
Available capacity =

8 hours

Reduce capacity
Capacity change = -1
Available capacity =

8 hours

Add work day
Capacity change = +2
Available capacity =

16 hours

Add work day
Capacity change = +2
Available capacity =

16 hours

Delete work day
Capacity change = -2
Available capacity = 0

Delete work day
Capacity change = -2
Available capacity = 0

Capacity Changes
A capacity change is a temporary change to the available capacity of a
resource—for example, work on a specific Saturday. You identify a capacity
modification for a resource within a shift for a resource. When you plan
capacity or detail schedule a resource that has capacity modifications, the
planning and scheduling processes might schedule work on a different day than
they would have scheduled the same work if there were no capacity change.
A simulation set is the label for a group of capacity changes needed for a
specific purpose—for example, a vacation schedule or an end-of-quarter
overtime schedule. You can simulate capacity changes by performing a capacity
plan using a simulation set.



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 3 - Page 52

Navigation Path

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Navigation PathNavigation Path

Use the Capacity Changes window to specify
capacity

changes.

Use the Capacity Changes window to specify
capacity

changes.

In Oracle Engineering: (N) Prototypes > Routings > Departments (B)
Resources (B) Shifts (B) Capacity Changes
In Oracle Bills of Material: (N) Routings > Departments (B) Resources
(B) Shifts (B) Capacity Changes
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
12
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This practice covers creating resources, department
classes, and departments.
This practice covers creating resources, department
classes, and departments.

Practice 2 Instructions
1. Create a department class code XX-PCMFG with description PC
Manufacturing Department Class.
2. Create resources using the following table:
Note: XX represents your team.
Resource Description Type
XXInserter Auto Inserter Machine
XXAssblr Labor Grade 1 Person
XXTester Tester Person
Note: For each resource, use the following additional information:
• UOM: HR
• Autocharge: WIP Move
• Default Basis: Item
• Costed: Yes
• Standard Rate: Yes
• Absorption Account: Any account number
• Variance Account: Any account number
• Overheads: Do not enter
• Resource Costs: Do not enter
• 3. Create departments using the following table:
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• Department Description Resource Name Capacity
Units
• XX-AutoIns Auto Insertion XXInserter 1
• XX-ManAssy Manual Assy XXAssblr 10
• XX-Test Testing XXTester 3
• XX-PCFinal PC Final Assy XXAssblr 4
• XX-PCFinal PC Final Assy XXTester 2
• Assign departments to class XX-PCMFG
• Note: For each resource, use the following additional information:
• Class: XX-PCMFG
• Shared: No
• Available 24 Hours: No
• Assigned Shifts: 1
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Practice 2 SolutionPractice 2 Solution

Create resources, department classes, and
departments.
Create resources, department classes, and
departments.

Practice 2 Solution
1. Create a department class code XX-PCMFG with description PC
Manufacturing Department Class.
(N) Bills of Material  > Setup > Department Classes
2. Create resources using the following table:
Note: XX represents your initials.
Resource Description Type
XXInserter Auto Inserter Machine
XXAssblr Labor Grade 1 Person
XXTester Tester Person
Note: For each resource, use the following additional information:
• UOM: HR
• Charge Type: WIP Move
• Default Basis: Item
• Costed: Yes
• Standard Rate: Yes
• Absorption Account: Any account number
• Variance Account: Any account number
• Overheads: Do not enter
• Resource Costs: Do not enter
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• (N) Engineering > Prototypes > Routings > Resources
• 3. Create departments using the following table:
• Department Description Resource Name Capacity
Units
• XX-AutoIns Auto Insertion XXInserter 1
• XX-ManAssy Manual Assy XXAssblr 10
• XX-Test Testing XXTester 3
• XX-PCFinal PC Final Assy XXAssblr 4
• XX-PCFinal PC Final Assy XXTester 2
• Assign departments to class XX-PCMFG.
• Note: For each resource, use the following additional information:
• Class: XX-PCMFG
• Share: No
• Available 24 Hours: No
• Assigned Shifts: 1
• (N) Engineering > Prototypes > Routings > Departments
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Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift

Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift
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Answer to Review QuestionAnswer to Review Question

Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift

Which of the following Entity : Action pairs is not
correct?
1. Resource : Assign to operation
2. Department class : Assign to department
3. Shift : Assign to resource
4. Capacity change : Assign to shift
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• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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RoutingsRoutings

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA

Engineering and Manufacturing Routings
You use routings to specify the process that you use to manufacture both
discrete and repetitive assembly items. A routing consists of operation steps.
Each operation step occurs at a department and contains resources that perform
work, schedule time, or add cost to the assembly.
Engineering routings are routings that your engineering function creates.
Manufacturing routings are routings that you use in production. You create
engineering routings in Oracle Engineering and you create manufacturing
routings in Oracle Inventory. They differ only in the following ways:
• Engineering routings have the routing Engineering attribute selected.
• Manufacturing routings have the routing Engineering attribute clear.
• You access the two through different navigation paths.
• They have different form titles.
• You create and change engineering routings using the Oracle Engineering
forms; you create and change manufacturing routings using the Oracle Bills of
Material forms.
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Primary and Alternate RoutingsPrimary and Alternate Routings

PrimaryPrimary AlternateAlternate

Operation test
Dept. B

Operation test
Dept. B

Operation assemble
Dept. A

Operation assemble
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

Operation disassemble
Dept. A

Operation disassemble
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 3Resource 3

AA AA

Defining Primary and Alternate Routings
Each item that has a routing has a primary routing. If you create other routings
for items, you refer to them as alternate routings. You use alternate routings in
the following ways:

• You identify each alternate routing by naming it. For example, you create
a primary routing to use when you manufacture the item and you want to
create another routing to use when you rework the item. Name the
alternate routing Rework.

• You can create as many alternate routings as you need for any item. The
alternate name must belong to the alternate list of values before you can
use it.

• You must add the name of the alternate routing to the list before you use it.
When you create discrete jobs and repetitive schedules in Oracle Work in
Process, you can specify which routing it should use when creating the
operations list. If you use an alternate routing, you can automatically create a
variance because standard cost is based on the primary routing.
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Routings in Multiple OrganizationsRoutings in Multiple Organizations

Organization 1Organization 1 Organization 2Organization 2

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA

Operation 20
Dept. 222

Operation 20
Dept. 222

Operation 10
Dept. 111

Operation 10
Dept. 111

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA

Routings in Multiple Organizations
You create items in the master organization and assign them to the
manufacturing and distribution organizations in which you use them. Within the
assigned organization, you create routings.
Example
Creating a routing for item A in organization 1 with operation step 10 in
department 111 and operation step 20 in department 222
Creating a routing for item A in organization 2 with operation step 10 in
department 111 and operation step 20 in department 222
Creating a routing for item A in organization 3 with operation step 10 in
department 333 and operation step 20 in department 444
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Use the following windows to enter routings:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

Use the following windows to enter routings:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

In Oracle Engineering: (N) Prototypes > Routings > Routings
In Oracle Bills of Material: (N) Routings > Routings
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Creating a Routing
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Assigning a Completion Subinventory and Locator
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Revision ARevision A Revision BRevision B

Operation 20
Dept. new

Operation 20
Dept. new

Operation 10
Dept. A
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Resource newResource new

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2
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Dept. B

Operation 20
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Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA AA

Defining Routing Revisions
A routing revision helps you indicate that the operations and resources of an
item have changed. You do not have to use routing revisions when you change
routings. Oracle Engineering and Oracle Bills of Material date stamp all
changes that you make to routings when you increase the revision.
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Use the Routing Revisions window to create routing
revisions.
Use the Routing Revisions window to create routing
revisions.

In Oracle Engineering: (N) Prototypes > Routings > Routings (B)
Routing Revisions
In Oracle Bills of Material: (N) Routings > Routings (B) Routing
Revisions
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Creating a Routing Revision
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Use the Viewing Routings window to view routings.Use the Viewing Routings window to view routings.

In Oracle Engineering: (N) Prototypes > Routings > Routings
In Oracle Bills of Material: (N) Routings > Routings
(Help) <no help available>
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Use the Reports window to request routing reports.Use the Reports window to request routing reports.

In Oracle Engineering and Oracle Bills of Material: (N) Reports >
Routings
(Help) Oracle Bills of Material > Reports and Processes > ...
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Use the Operation Resources window to create
operation resources.
Use the Operation Resources window to create
operation resources.

In Oracle Engineering: (N) Prototypes > Routings > Routings (B)
Operation Resources
In Oracle Bills of Material: (N) Routings > Routings (B) Operation
Resources
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Assigning Operation Resources
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Resource 1Resource 1

Resource 2Resource 2
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Defining Standard Operations
A standard operation holds operation and resource information. Create a
standard operation for an operation that you will use in many routings. As you
create specific routings, you can copy standard operations to an operation. The
operation and resource information will copy to the routing and you can change
any of the information after the copying is complete.
A standard operation is not the same as a standard bill of material.
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Use the Standard Operations window to create
standard operations.
Use the Standard Operations window to create
standard operations.

In Oracle Engineering: (N) Prototypes > Routings > Standard
Operations
In Oracle Bills of Material: (N) Routings > Standard Operations
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
17
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Navigation PathNavigation Path

Use the Resources window to create standard
operation resources.
Use the Resources window to create standard
operation resources.

In Oracle Engineering: (N) Prototypes > Routings > Standard
Operations (B) Operation Resources
In Oracle Bills of Material: (N) Routings > Standard Operations (B)
Operation Resources
(Help) Oracle Bills of Material > Setting Up > Setup Overview > Step
17
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Navigation PathNavigation Path

Use the Resource WhereUsed window to view the
routings and operations that use a resource.
Use the Resource WhereUsed window to view the
routings and operations that use a resource.

In Oracle Engineering: (N) Prototypes > Routings > Resource
WhereUsed
In Oracle Bills of Material: (N) Routings > Resource WhereUsed
(Help) Oracle Bills of Material > Routings > Viewing Resource Usage
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Navigation PathNavigation Path

Use the Attachments window to add attachments to a
routing.
Use the Attachments window to add attachments to a
routing.

In Oracle Engineering: (N) Prototypes > Routings > Routings (M) Edit
> Attachments
In Oracle Bills of Material: (N) Routings > Routings (M) Edit >
Attachments
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Attaching Files
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Navigation PathNavigation Path

Use the Operation Documents window to create and
change routing attachments.
Use the Operation Documents window to create and
change routing attachments.

In Oracle Engineering: (N) Prototypes > Routings > Documents
In Oracle Bills of Material: (N) Routings > Documents
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Attaching Files > Related Topics > Defining Bill or Routing Operation
Documents
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Navigation PathNavigation Path

Use the Tools menu bar choice to perform a variety of
routing functions.
Use the Tools menu bar choice to perform a variety of
routing functions.

In Engineering: (N) Prototypes > Routings > Routings (M) Tools
In Bills of Material: (N) Routings > Routings (M) Tools
(Help) Oracle Bills of Material > Routings > Routings Reference >
Tools menu
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Common RoutingsCommon Routings

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA XX

Creating Common Routings
If you need to have identical routings for more than one item, you can save time
and reduce the necessity for maintenance by using the common routing feature.
The routing you reference contains the operations and resources. The routing
that is referencing does not contain operations and resources; it contains a link
to the referenced routing. Any function that uses or views the referencing
routing will use or view the routing of the referenced routing.
Make all changes to the original routing. The routings that reference the
common routing will reflect the changes.
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Navigation PathNavigation Path

Use the Common Routing window to assign an item
to a common routing.
Use the Common Routing window to assign an item
to a common routing.

In Oracle Engineering: (N) Prototypes > Routings > Routings  (M)
Tools > Assign Common Routing
In Oracle Bills of Material: (N) Routings > Routings  (M) Tools >
Assign Common Routing
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Referencing Common Bills and Routings
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Copy RoutingsCopy Routings

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

Operation 20
Dept. B

Operation 20
Dept. B

Operation 10
Dept. A

Operation 10
Dept. A

Resource 1Resource 1

Resource 2Resource 2

Resource 1Resource 1

Resource 2Resource 2

AA XX

Copy Routings
When you want to create similar, alternate routings for and item, you can save
time creating routings by using the Copy Routing feature.
You create a routing by copying from:
The same or a different item number
The primary or an alternate bill for that item number
The item from which you copy retains its operations and resources. The item to
which you copy contains the same operations and resources as the item from
which you copy.
You can change anything on the copied routing except the item number and the
operation number.
After copying, the two routings are no longer related. If you change one routing,
you do not see the same change in the other routing.
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Navigation PathNavigation Path

Use the Copy Routing window to copy the routing of
one item as the routing of another item.
Use the Copy Routing window to copy the routing of
one item as the routing of another item.

In Oracle Engineering: (N) Prototypes > Bills > Bills (M) Special >
Copy Routing from
In Oracle Bills of Material: (N) Bills > Bills (M) Special > Copy Routing
from
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Copying Bill & Routing Information
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LegacyLegacy
or Productor Product

DataData
ManagementManagement

SystemsSystems

OracleOracle

Open interface
tables

Routing Open InterfaceRouting Open Interface

PDMPDM

OracleOracle
ApplicationsApplications
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Navigation PathNavigation Path

Use the Import Bills and Routings window to create,
update, and delete routing information from external
systems.

Use the Import Bills and Routings window to create,
update, and delete routing information from external
systems.

In Oracle Engineering: (N) Prototypes > Routings > Import
In Oracle Bills of Material: (N) Routings > Import
(Help) Oracle Bills of Material > Routings > Importing Bills and
Routings
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Practice 3 OverviewPractice 3 Overview

This practice covers creating routings.This practice covers creating routings.

Practice 3 Instructions
1. Create a routing for item XX1000 using the following tables:
Note: XX represents your team.
Operation Sequence Department Description
100 XX-PCFinal Assemble PC
200 XX-PCFinal Test PC
Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
100 10 XXAssblr 0.25 Item 4
200 10 XXTester 0.5 Item 1
Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• 2. Create a routing for item XX1040 using the following tables:
• Operation Sequence Department Description
• 100 XX-PCFinal Assemble CPU Chassis
• 200 XX-PCFinal Test CPU Chassis
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXAssblr 0.5 Item 4
• 200 10 XXTester 1 Item 1
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• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• 3. Create a routing for item XX2010 using the following tables:
• Operation Sequence Department Description
• 100 XX-AutoIns Machine install components
• 200 XX-ManAssy Hand install components
• 300 XX-Test Test motherboard
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXInserter 2 Lot 1
• 100 20 XXInserter 1 Item 1
• 200 10 XXAsslbr 0.1 Item 10
• 300 10 XXTester 2 Item 1
• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• 4. Return to your bill of material and assign routing operation sequences to
your components.
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Practice 3 SolutionPractice 3 Solution

Create routings.Create routings.

Practice 3 Solution
1. Create a routing for item XX1000 using the following tables:
Note: XX represents your team.
Operation Sequence Department Description
100 XX-PCFinal Assemble PC
200 XX-PCFinal Test PC
Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
100 10 XXAssblr 0.25 Item 4
200 10 XXTester 0.5 Item 1
Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• (N) Engineering > Prototypes > Routings > Routings
• 2. Create a routing for item XX1040 using the following tables:
• Operation Sequence Department Description
• 100 XX-PCFinal Assemble CPU Chassis
• 200 XX-PCFinal Test CPU Chassis
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXAssblr 0.5 Item 4
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• 200 10 XXTester 1 Item 1
• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• (N) Engineering > Prototypes > Routings > Routings
• 3. Create a routing for item XX2010 using the following tables:
• Operation Sequence Department Description
• 100 XX-AutoIns Machine install components
• 200 XX-ManAssy Hand install components
• 300 XX-Test Test motherboard
• Operation  Resource Usage Rate Assigned
Sequence  Sequence Name or Amount Basis Units
• 100 10 XXInserter 2 Lot 1
• 100 20 XXInserter 1 Item 1
• 200 10 XXAsslbr 0.1 Item 10
• 300 10 XXTester 2 Item 1
• Note: For each resource, use the following additional information:
• UOM: HR
• Schedule: Yes
• (N) Engineering > Prototypes > Routings > Routings
• 4. Return to your bill of material and assign routing operation sequences to
your components.
• (N) Engineering > Prototypes > Bills > Bills



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 3 - Page 86

Review Question

Copyright   Oracle Corporation,  2000. All rights reserved.
®

Review QuestionReview Question

Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers

Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers
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Answer to Review QuestionAnswer to Review Question

Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers

Engineering and manufacturing routing differ in all of
the following areas except one. Which one is it?
1. Engineering attribute
2. Navigation path
3. Form title
4. Operation numbers
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• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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ItemItem    LT.LT. StartStart      CompleteComplete
AA 22 1717 1919
B B 6     6     9 9 1717
CC 55 1010 1717
D      D      66 2 2 1010
E      E      44 44 1010

JulyJuly

Lead time: 5Lead time: 5

Lead time: 6Lead time: 6

Lead time: 6Lead time: 6

Lead time: 2Lead time: 2

Lead time: 5Lead time: 5

D A

C

B

E

11 22 33 44 55 66 77 88 99 1010 1111 1212 1313 1414 1515 1616 1717 1818 1919 2020 2121

Lead TimesLead Times

Lead Times
Plan material and resource requirements and determine requirement dates for
available-to-promise calculations using dynamic lead times.
Dynamic Lead Time Offsetting: Estimate the start date of an order, an
operation, or a resource based on order quantity, lead times, and the workday
calendar.
Detailed Scheduling: Schedule jobs to the minute based on detailed resource
availability and usages. Oracle Bills of Material calculates manufacturing lead
times using detailed scheduling. Detailed scheduling is the most precise
scheduling method in Oracle Manufacturing.
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Lead Time AttributesLead Time Attributes

Preprocessing
lead time

Preprocessing
lead time

Processing
lead time

Processing
lead time

Postprocessing
lead time

Postprocessing
lead time

Preprocessing
lead time

Preprocessing
lead time

Lead time offset
(fixed and variable)
Lead time offset

(fixed and variable)
MakeMake
itemitem

BuyBuy
itemitem

Lead Time Attributes
Preprocessing Lead Time: Represents the time required to release a purchase
order or a job from the time you learn of the requirement.
Postprocessing Lead Time: Represents the time to make a purchased item
available in inventory from the time you receive it: you manually enter
postprocessing lead time for each purchased item.
Processing Lead Time: Time required to procure or manufacture an item;
processing lead time includes the fixed and variable portions of lead times.
Cumulative Manufacturing Lead Time: Total time required to make an item
if you had all raw materials in stock but had to make all subassemblies level by
level; Oracle automatically calculates this value.
Cumulative Total Lead Time: Total time required to make an item if no
inventory existed and you had to order all the raw materials and make all
subassemblies level by level; Oracle automatically calculates this value.
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Lead Time ValuesLead Time Values

ManuallyManually
enterenter

ConcurrentConcurrent
processprocess

Assigning Lead Time Values
To assign values to lead time attributes, you can do either of the following:

• Manually enter them.
• For make items, start concurrent processes that calculate them. These

processes replace values that you have manually entered with calculated
values.
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2 days2 days 10 days10 days 3 days3 days

Calculating Lead TimesCalculating Lead Times

RoutingsRoutings

SupplierSupplier

The Lead Time Calculation Process
Use the following process if you want Oracle Engineering or Oracle Bills of
Material to calculate lead time information:

• For buy items, manually enter preprocessing, processing, and
postprocessing attributes.

• For make items, enter routings and manually enter preprocessing and lead
time lot size attributes.

• Start the concurrent process Calculate Manufacturing Lead Times, which
calculates the fixed, variable, processing, lead time percentage, and offset
percentage attributes.

• Start the concurrent process Roll Up Cumulative Lead Times, which
calculates the cumulative manufacturing and cumulative total attributes.
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Lead Time Lot SizeLead Time Lot Size

Value
Assigned

YES

YES

YES

Attribute

Fixed Order Quantity

Min-Max Order Quantity

Standard Lot Size

Value for Lead Time Lot
Size

Fixed Order Quantity

Average Order Quantity

<none>

Lead Time Lot Size
Specify the quantity to use when calculating dynamic manufacturing lead times
based on how you plan and cost the item.
Lead Time Lot Size Item Attribute
Schedule the first job in dynamic lead time calculations for the quantity of zero
and to schedule the second job in dynamic lead time calculations for the lead time
lot size.
No Lead Time Lot Size Assigned
You use default standard lot size, which defaults to the item’s standard lot size
attribute if there is no lead time lot size entered in the lead times region of this
form. The default lead time lot size of “1” will default the item’s lead time lot size
to “1” if there is no standard lot size.
Value Assigned Attribute Value for Lead Time Lot Size
YES Fixed Order Quantity Fixed Order Quantity
YES Min-Max Order Quantity Average Order Quantity
YES Standard Lot Size None
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Manufactured Item Lead TimesManufactured Item Lead Times

Attribute

Preprocessing

Processing

Postprocessing

Fixed

Variable

Cumulative Mfg

Cumulative Total

Lead Time Lot Size

Manually
Assign

YES

YES

Auto
Calculate

YES

YES

YES

YES

YES

Lead Time
Offset

YES

YES

Used for
Time Fences

YES

YES

Manufacturing Lead Times
Oracle Engineering computes the fixed and variable portion of manufacturing
(processing) lead time using routings and detailed scheduling.

Calculate Processing Lead Time for Manufactured Items
Schedule one discrete job for a quantity of zero (fixed lead time), and a second
discrete job for the lead time lot size quantity (variable lead time).
When computing processing lead time, engineering schedules all calendar days
as workdays, regardless of days off or workday exceptions.
Fixed and Variable Lead Time
Fixed lead time is defined as the portion of time required to build an assembly
that is independent of order quantity. Setup and teardown are examples of fixed
lead time.
Variable lead time is defined as the time required to produce one additional unit
of an assembly
Oracle Manufacturing uses an item’s fixed lead time and variable lead time in
dynamic lead time offset calculations.
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Manufactured Item Lead Time PercentageManufactured Item Lead Time Percentage

Operation
Sequence

10

20

30

Operation Description

Assemble Chassis Base

Mount Motherboard

Package Product

Lead Time
Percentage

0%

50%

80%

Start
Day

1

6

9

Duration
(1 LTLS)

5

3

2

Reference InformationReference Information
Processing Lead Time = 10 daysProcessing Lead Time = 10 days

LTLS - Lead Time Lot SizeLTLS - Lead Time Lot Size

Manufacturing Lead Times (continued)
Oracle Manufacturing computes resource and operation offsets automatically
when calculating Manufacturing Lead Time.

Operation Lead Time Percentage
Engineering automatically calculates the percentage of total manufacturing lead
time required for previous operations, calculated from the start of a job to the
start of an operation. You can override lead time percent calculations in the
main region of the engineering routings window.
Schedule material to arrive when an operation requires it. Oracle Master
Scheduling/MRP uses offsets to determine when an operation requires material.
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Res
Seq

1

1

2

1

Manufactured Item Resource OffsetsManufactured Item Resource Offsets
Op
Seq

10

20

20

30

Resource
Description

Assemble chassis

Detailed system test

Assemble

Pack

Offset
Percentage

0%

50%

60%

80%

Start
Day

1

6

7

9

Duration
(1 LTLS)

5

1

2

2

Reference InformationReference Information
OpOp Seq Seq = Operation Sequence = Operation Sequence
Res SeqRes Seq = Resource Sequence = Resource Sequence

Processing Lead Time = 10 daysProcessing Lead Time = 10 days
LTLS - Lead Time Lot SizeLTLS - Lead Time Lot Size

Resource Offsets
Oracle Engineering automatically calculates the percentage of total
manufacturing lead time required for previous operations, calculated from the
start of the job to the start time of a resource at an operation. You can override
offset percentage calculations in the Resource zone of the Define Engineering
routing form.
Schedule Resources
Schedule resources at an operation exactly when they are required. Oracle
Capacity uses operation and resource offsets, as well as detailed usage
information, to plan operation resources.
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Cumulative Manufacturing Lead TimeCumulative Manufacturing Lead Time

Time (Days)Time (Days)

Assembly:
Made

Subassembly:
Made

ProcessingProcessing
lead timelead time

Cumulative manufacturingCumulative manufacturing
lead timelead time

PreprocessingPreprocessing
ProcessingProcessing

Rollup Lead Times
Cumulative manufacturing lead time formula:
Cumulative manufacturing lead time = Manufacturing lead time for item +
maximum [(Cumulative manufacturing lead time – Offset days of any
component)]
Set planning time fences for items based on cumulative manufacturing or
cumulative total lead time.
Cumulative manufacturing lead time: The total time required to make an item
if you had all raw materials in stock but had to make all subassemblies level by
level. Engineering automatically calculates this value.
Cumulative total lead time: The total time required to make an item if no
inventory existed and you had to order all the raw materials and make all the
subassemblies level by level. Engineering automatically calculates this value.
Compute cumulative manufacturing lead time: Calculate the maximum
component cumulative manufacturing lead time less operation offset.
Cumulative manufacturing lead time for a purchased item is zero.
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Cumulative Total Lead TimeCumulative Total Lead Time

Time (Days)Time (Days)

Cumulative total lead timeCumulative total lead time

Assembly:
Made

Subassembly:
Made

Component:
Purchased

ProcessingProcessing
lead timelead time

Cumulative ManufacturingCumulative Manufacturing
lead timelead time

PreprocessingPreprocessing
ProcessingProcessing
PostprocessingPostprocessing

Cumulative Total Lead Time Formula
Cumulative total lead time = Total lead time for item + Maximum [(Cumulative
total lead time – Offset days for any component)]
Compute Cumulative Total Lead Time
Calculate an item’s own total lead time plus the maximum value of cumulative
total lead time operation offset for any component.
For cumulative calculations, include the postprocessing lead time for a
purchased item.
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Navigation PathNavigation Path

Use the following windows to set lead time item
attributes:
• Engineering Master Items and Engineering

Organization Items in Oracle Engineering
• Master Items and Organization Items in Oracle

Inventory

Use the following windows to set lead time item
attributes:
• Engineering Master Items and Engineering

Organization Items in Oracle Engineering
• Master Items and Organization Items in Oracle

Inventory

In Oracle Engineering:
• Engineering Master Items: (N) Prototypes > Items > Master Items
• Engineering Organization Items: (N) Prototypes > Items >
Organization Items
• In Oracle Inventory:
• Master Items: (N) Items > Master Items
• Organization Items: (N) Items > Organization Items
• (Help) Oracle Inventory > Items > Item Attribute Descriptions > Lead
Times Attribute Group
• (Help) Oracle Inventory > Items > Defining Items
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Navigation PathNavigation Path

Use the following windows to set routing lead time
percentage:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

Use the following windows to set routing lead time
percentage:
• Engineering Routings in Oracle Engineering
• Routings in Oracle Bills of Material

In Oracle Engineering: (N) Prototypes > Routings > Routings
In Oracle Bills of Material: (N) Routings > Routings
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Creating a Routing
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Navigation PathNavigation Path

Use the Operation Resources window to set resource
offset percentage.
Use the Operation Resources window to set resource
offset percentage.

In Oracle Engineering: (N) Prototypes > Routings > Routings (B)
Operation Resources
In Oracle Bills of Material: (N) Routings > Routings (B) Operation
Resources
(Help) Oracle Bills of Material > Routings > Defining a Routing >
Assigning Operation Resources
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Navigation PathNavigation Path

Use the Calculate Lead Times window to request
automatic lead time calculation.
Use the Calculate Lead Times window to request
automatic lead time calculation.

In Oracle Engineering: (N) Prototypes > Routings > Lead Times
In Oracle Bills of Material: (N) Routings > Lead Times
(Help) Oracle Bills of Material > Lead Tine Management > Calculating
Lead Times
(Help) Oracle Bills of Material > Lead Tine Management > Rolling Up
Lead Times
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Practice 4 OverviewPractice 4 Overview

This practice covers entering and calculating lead
times.
This practice covers entering and calculating lead
times.

Practice 4 Instructions
1.Enter lead times for your buy items using the following table:
Lot size for XXXX1000, XX1040, XX2010 is 100 pieces.
Item Number Preprocessing LT Processing LT

Postprocessing LT
XX1010 5 5
XX1020 5 5
XX1030 5 5
XX2020 5 5 2
XX2030 5 5
XX2040 5 5
XX3010 5 10 2
XX3020 5 60 1
XX3030 5 5
XX3040 5 30 1
2. Calculate lead time for items XX2010, XX1040, and XX1000.
3. View fixed, variable, and processing lead times for items XX2010, XX1040,
and XX1000.
Note
• One hour of lead time = 1/24 = 0.0416667 day
• Two hours of lead time = 2/24 = 0.0833333 day
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• Four hours of lead time = 4/24 = 0.166666 day
• Eight hours of lead time = 8/24 = 0.333333 day
• Twelve hours of lead time = 12/24 = 0.5 day
• Twenty-four hours of lead time = 24/24 = 1 day
• 4. Roll up lead time for item XX1000.
• 5. View cumulative lead times for item XX1000.
• 6. View indented bill of material for XX1000.
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Practice 4 SolutionPractice 4 Solution

Enter and calculate lead times.Enter and calculate lead times.

Practice 4 Solution
1. Enter lead times for your buy items using the following table:
(N) Engineering > Prototypes > Items > Master Items (M) Tools >
Organization Assignment (B) Org Attributes (T) Lead Times
Lot size for XX1000, XX1040, XX2010 is 100 pieces.
Item Number Preprocessing LT Processing LT

Postprocessing LT
XX1010 5 5
XX1020 5 5
XX1030 5 5
XX2020 5 5 2
XX2030 5 5
XX2040 5 5
XX3010 5 10 2
XX3020 5 60 1
XX3030 5 5
XX3040 5 30 1
2. Calculate lead time for items XX2010, XX1040, and XX1000.
(N) Engineering > Prototypes > Routings > Lead Times
3. View fixed, variable, and processing lead times for items XX2010, XX1040,
and XX1000.
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(N) Engineering > Prototypes > Items > Master Items (M) Tools >
Organization Assignment (B) Org Attributes (T) Lead Times
Note:
• One hour of lead time = 1/24 = 0.0416667 day
• Two hours of lead time = 2/24 = 0.0833333 day
• Four hours of lead time = 4/24 = 0.166666 day
• Eight hours of lead time = 8/24 = 0.333333 day
• Twelve hours of lead time = 12/24 = 0.5 day
• Twenty-four hours of lead time = 24/24 = 1 day
• 4. Roll up lead time for item XX1000.
• (N) Engineering > Prototypes > Routings > Lead Times
• 5. View cumulative lead times for item XX1000.
• (N) Engineering > Prototypes > Items > Master Items (M) Tools >
Organization Assignment (B) Org Attributes (T) Lead Times
• 6. View indented bill of material for item XX1000.
• (N) Engineering > Prototypes > Bills > Indented Bills
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Review QuestionReview Question

If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing

If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing
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Answer to Review Question
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Answer to Review QuestionAnswer to Review Question

If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing

If you want to automatically calculate the lead time of
a manufactured item, which of the following lead
times must you enter?
1. Preprocessing
2. Fixed
3. Postprocessing
4. Processing
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Agenda
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AgendaAgenda

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary
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Transferring Product Information
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Transferring Product Information

EngineeringEngineering ProductionProduction

Transferring Product Information
When you decide that engineering information is ready for production, you
transfer the product information—items, bills of material, and routings— from
engineering to manufacturing.
When you transfer engineering information, you transform the engineering item
into a manufacturing item and the engineering item ceases to exist.
When you copy engineering information, you save the engineering information
and copy it to manufacturing as another item number.
The transfer and copy sequence is a one-way process. You cannot transfer or copy
product information from manufacturing to engineering.
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Navigation Path
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Navigation PathNavigation Path

Use the Transfer to Manufacturing window to transfer
engineering prototype items, bills of material, and
routings to production.

Use the Transfer to Manufacturing window to transfer
engineering prototype items, bills of material, and
routings to production.

In Oracle Engineering: (N) Prototype > Transfer to Manufacturing
(Help) Oracle Engineering > Engineering Prototype Environment >
Transferring or Copying Engineering Items
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Navigation Path
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Navigation PathNavigation Path

Use the Copy to Manufacturing window to copy
engineering prototype items, bills of material, and
routings to production.

Use the Copy to Manufacturing window to copy
engineering prototype items, bills of material, and
routings to production.

In Oracle Engineering: (N) Prototype > Copy to Manufacturing
(Help) Oracle Engineering > Engineering Prototype Environment >
Transferring or Copying Engineering Items
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Practice 5 Overview
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Practice 5 OverviewPractice 5 Overview

This practice covers transferring product information.This practice covers transferring product information.

Practice 5 Instructions
1. Transfer bills of material and routings for item numbers XX2010, XX1040, and
XX1000 from engineering to production.
Note: XX represents your team.
2. To verify the transfers, view XX1000 on the following forms and indicate
whether or not you are able to use each form to see the items:
• Oracle Inventory Master Items
• Oracle Engineering Master Items
• Oracle Inventory View Item Attributes
• Oracle Engineering View Item Attributes
• Oracle Bills of Material
• Oracle Engineering Bill of Material
• Oracle Bills of Material Indented Bills
• Oracle Engineering Indented Bills
• Oracle Bills of Material Routings
• Oracle Engineering Routings
• 3. Copy item XX2011 and give it a new name using item number XX2022. View
your results.
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Practice 5 Solution
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Practice 5 SolutionPractice 5 Solution

Transfer product information.Transfer product information.

Practice 5 Solution
1. Transfer bills of material and Routings for item numbers XX2010, XX1040,
and XX1000 from engineering to production.
Note: XX represents your team.
(N) Engineering > Prototypes > Transfer to Manufacturing
2. To verify the transfers, view XX1000 on the following forms and indicate
whether or not you are able to use each form to see the items:
• Oracle Inventory Master Items
• (N) Inventory > Items—>Master Items; not able to see the items
• Oracle Engineering Master Items
• (N) Engineering > Prototypes—>Items—>Master Items; able to see the
items
• Oracle Inventory View Item Attributes
• (N) Inventory > Items—>Item Information; able to see the items
• Oracle Engineering View Item Attributes
•  (N) Engineering > Prototypes—>Items—>View Item Details; able to see the
items
• Oracle Bills of Material Bill of Material
• (N) Bills of Material > Bills—>Bills; able to see the items
• Oracle Engineering Bill of Material
• (N) Engineering > Prototypes—>Bills—>Bills; not able to see the items
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• Oracle Bills of Material Indented Bills
• (N) Bills of Material > Bills—>Indented Bills; able to see the items
• Oracle Engineering Indented Bills
• (N) Engineering > Prototypes—>Bills—>Indented Bills; able to see the items
• Oracle Bills of Material Routings
• (N) Bills of Material > Routings—>Routings; able to see the items
• Oracle Engineering Routings
• (N) Engineering > Prototypes—>Routings—>Routings; not able to see the
items
• 3. Copy item XX2011 and give it a new name using item number XX2022. View
your results.
• (N) Engineering > Prototype > Copy to Manufacturing
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Review QuestionReview Question

In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times

In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times
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Answer to Review QuestionAnswer to Review Question

In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times

In which of the following transfer functions does the
engineering item remain?
1. Assign common routing
2. Transfer to manufacturing
3. Copy to manufacturing
4. Roll-up lead times
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AgendaAgenda

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary

• Introduction
• Overview
• Maintaining the workday calendar
• Defining resources and departments
• Creating routings
• Calculating lead times
• Transferring product information
• Summary



Copyright © Oracle Corporation, 2000. All rights reserved.

Oracle Manufacturing - Create Routings Release 11i
Chapter 3 - Page 119

Summary
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SummarySummary

In this module, you should have learned how to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information

In this module, you should have learned how to:
• Maintain the workday calendar
• Define resources and departments
• Create routings
• Calculate lead times
• Transfer product information
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R11i - Managing Engineering Change Orders
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R11i - Managing Engineering Change
Orders

R11i - Managing Engineering Change
Orders
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ObjectivesObjectives

• After completing this lesson, you should be able
to do the following:
– Create engineering change orders
– Recognize the effects of engineering change

orders on bills of material
– Approve, schedule, and implement

engineering change orders
– Understand the new ECO Business Object

Interface

• After completing this lesson, you should be able
to do the following:
– Create engineering change orders
– Recognize the effects of engineering change

orders on bills of material
– Approve, schedule, and implement

engineering change orders
– Understand the new ECO Business Object

Interface
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Agenda
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AgendaAgenda

• Overview of Engineering Change Orders
• Engineering Change Order Life Cycle
• Engineering Change Order Business Object

Interface
• Summary
• Practice

• Overview of Engineering Change Orders
• Engineering Change Order Life Cycle
• Engineering Change Order Business Object

Interface
• Summary
• Practice
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Lesson 1: Overview of Engineering Change Orders
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Lesson 1:
Overview of Engineering Change Orders

Lesson 1:
Overview of Engineering Change Orders

• Overview of Engineering Change Orders
• Engineering Change Order Life Cycle
• Engineering Change Order Business Object

Interface
• Summary
• Practice

• Overview of Engineering Change Orders
• Engineering Change Order Life Cycle
• Engineering Change Order Business Object

Interface
• Summary
• Practice
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Overview
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OverviewOverview

– An engineering change order (ECO) is an order
to change bills of material.

– An engineering change order cannot be used
to change routings.

– You can control the engineering change order
approval process by using Oracle Workflow.

– You can track the components being
discontinued, the new components being
added, and their effectivity dates.

– You can also enter any information on
substitution components.

– An engineering change order (ECO) is an order
to change bills of material.

– An engineering change order cannot be used
to change routings.

– You can control the engineering change order
approval process by using Oracle Workflow.

– You can track the components being
discontinued, the new components being
added, and their effectivity dates.

– You can also enter any information on
substitution components.

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > Overview

… Engineering Change Orders >  ECOs on Items and Bills
… Engineering Change Orders > ECO Access Control
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Engineering Change Orders
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Engineering Change OrdersEngineering Change Orders

EngineeringEngineering
changechange
orderorder

EEDD

BB CC

AA

MMDD

BB CC

AA
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Engineering Change Orders
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Engineering Change OrdersEngineering Change Orders

• An engineering change order (ECO) is an order to
change bills of material to add, change and delete
components.

• You cannot use an ECO to change routings.
• ECO’s can be used to change both engineering

and manufacturing bills of material.
• ECO’s can specify changes to one or more revised

items.

• An engineering change order (ECO) is an order to
change bills of material to add, change and delete
components.

• You cannot use an ECO to change routings.
• ECO’s can be used to change both engineering

and manufacturing bills of material.
• ECO’s can specify changes to one or more revised

items.
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Engineering Change Orders
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Engineering Change OrdersEngineering Change Orders

• ECO’s can be subjected to a review process,
managed with either Oracle Engineering or Oracle
Workflow.

• When implementing the ECO, you can force the
ECO to increment the bill of material revision when
it changes the revised item.

• Bills of material can be changed without ECO’s
using the Bills of Material Form.  Or personal
profiles can be set to prohibit direct updates
without an ECO.

• ECO’s can be subjected to a review process,
managed with either Oracle Engineering or Oracle
Workflow.

• When implementing the ECO, you can force the
ECO to increment the bill of material revision when
it changes the revised item.

• Bills of material can be changed without ECO’s
using the Bills of Material Form.  Or personal
profiles can be set to prohibit direct updates
without an ECO.
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Lesson 2:
Engineering Change Order Life Cycle

Lesson 2:
Engineering Change Order Life Cycle

• Overview of Engineering Change Orders
• Engineering Change Order Life Cycle
• Engineering Change Order Business Object

Interface
• Summary
• Practice

• Overview of Engineering Change Orders
• Engineering Change Order Life Cycle
• Engineering Change Order Business Object

Interface
• Summary
• Practice
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ECO Life Cycle
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ECO Life CycleECO Life Cycle

• When processing ECO’s you typically follow a set
pattern of action.

• These actions correspond to the ECO revised item
statuses and ECO approval statuses.

• ECO revised item status refers to the overall status
of the ECO and to the individual status of each
revised item on the ECO.

• ECO approval status refers to the process of
requesting and obtaining approval for the ECO
from a list of approvers.

• When processing ECO’s you typically follow a set
pattern of action.

• These actions correspond to the ECO revised item
statuses and ECO approval statuses.

• ECO revised item status refers to the overall status
of the ECO and to the individual status of each
revised item on the ECO.

• ECO approval status refers to the process of
requesting and obtaining approval for the ECO
from a list of approvers.

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > ECO Life Cycle
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ECO Statuses
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ECO StatusesECO Statuses

EE

CCBB

AA

DD MM

Removing one item from a bill and replacing it with another.Removing one item from a bill and replacing it with another.Removing one item from a bill and replacing it with another.
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ECO Statuses
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ECO StatusesECO Statuses

• ECO Approval Statuses
– Not Ready - You are not ready to ask for

approval
– Ready to Approve - You are ready to ask the

approvers to review
– Approval Requested - Approvers have been

asked to review
– Approved - The decision has been made to

approve the ECO
– Rejected - The decision has been made to

reject the ECO
– Processing Error - An error occurred in the

workflow approval process

• ECO Approval Statuses
– Not Ready - You are not ready to ask for

approval
– Ready to Approve - You are ready to ask the

approvers to review
– Approval Requested - Approvers have been

asked to review
– Approved - The decision has been made to

approve the ECO
– Rejected - The decision has been made to

reject the ECO
– Processing Error - An error occurred in the

workflow approval process

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > ECO Statuses

… Engineering Change Orders > ECO Approval Process > 
ECO Approval Statuses
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ECO Statuses
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ECO StatusesECO Statuses

• ECO Revised Item Statuses
– Open - You are preparing the information
– Release - You can manually implement the

change
– Schedule - The implementation concurrent

process implements the change
– Implement - You have successfully changed

the bill of material
– Hold - You have temporarily decided not to

implement a Released or Scheduled change
– Cancel - you have permanently decided not to

implement the change

• ECO Revised Item Statuses
– Open - You are preparing the information
– Release - You can manually implement the

change
– Schedule - The implementation concurrent

process implements the change
– Implement - You have successfully changed

the bill of material
– Hold - You have temporarily decided not to

implement a Released or Scheduled change
– Cancel - you have permanently decided not to

implement the change

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > ECO Revised Item Statuses
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ECO Life Cycle - without Approval
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ECO Life Cycle - without ApprovalECO Life Cycle - without Approval

To implement ECO’s without an approval process:
• Enter the change information

– ECO approval status = Approved
– ECO revised item status = Open

• Implement the change
– ECO approval status = Approved
– ECO revised item status = Released or

Scheduled (for manual or auto
implementation)

• After the change is completed
– ECO approval status = Approved
– ECO revised item status = Implemented

To implement ECO’s without an approval process:
• Enter the change information

– ECO approval status = Approved
– ECO revised item status = Open

• Implement the change
– ECO approval status = Approved
– ECO revised item status = Released or

Scheduled (for manual or auto
implementation)

• After the change is completed
– ECO approval status = Approved
– ECO revised item status = Implemented

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > ECO Approval Process > ECO
Approvals
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ECO Life Cycle without Approval
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ECO Life Cycle
without Approval
ECO Life Cycle

without Approval

ImplementedImplemented

OpenOpen

ReleasedReleased ScheduledScheduled
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ECO Life Cycle - with Approval
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ECO Life Cycle - with ApprovalECO Life Cycle - with Approval
To implement ECO’s with an approval process:
• Enter the change information

– ECO approval status = Not Ready
– ECO revised item status = Open

• Prepare the change information for review
– ECO approval status = Ready to Approve
– ECO revised item status = Open

• Send the information to the approvers
– ECO approval status = Approval Requested
– ECO revised item status = Open

• Change is not approved
– ECO approval status = Rejected

To implement ECO’s with an approval process:
• Enter the change information

– ECO approval status = Not Ready
– ECO revised item status = Open

• Prepare the change information for review
– ECO approval status = Ready to Approve
– ECO revised item status = Open

• Send the information to the approvers
– ECO approval status = Approval Requested
– ECO revised item status = Open

• Change is not approved
– ECO approval status = Rejected
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ECO Life Cycle - with Approval
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ECO Life Cycle - with ApprovalECO Life Cycle - with Approval
Continued:

– ECO revised item status = Canceled
• Change is approved

– ECO approval status = Approved
– ECO revised item status = Open

• Implement the approved change
– ECO approval status = Approved
– ECO revised item status = Released or

Scheduled (for manual or auto
implementation)

• After the approved change is completed
– ECO approval status = Approved
– ECO revised item status = Implemented

Continued:
– ECO revised item status = Canceled

• Change is approved
– ECO approval status = Approved
– ECO revised item status = Open

• Implement the approved change
– ECO approval status = Approved
– ECO revised item status = Released or

Scheduled (for manual or auto
implementation)

• After the approved change is completed
– ECO approval status = Approved
– ECO revised item status = Implemented
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ECO Life Cycle - with Approval
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ECO Life Cycle - with ApprovalECO Life Cycle - with Approval

OpenOpen

ReleasedReleased ScheduledScheduled

ImplementedImplemented

Ready for
Approval

Ready for
Approval

Approval
Requested
Approval

Requested

ApprovedApprovedRejectedRejected
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ECO Approval: Oracle EngineeringECO Approval: Oracle Engineering

OracleOracle
EngineeringEngineering

EngineeringEngineering
Change OrderChange Order

Approved!Approved!

OracleOracle
EngineeringEngineering

OracleOracle
EngineeringEngineering
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ECO Approval: Oracle EngineeringECO Approval: Oracle Engineering

Managing the approval process using Engineering:
• Setup the approval process

– Create approval lists
– Assign an approval list to the ECO
– Assign an ECO change type to the ECO (one not

associated with an Oracle Workflow)
• The Oracle Engineering approval process steps

– Set ECO approval status to: Approval Requested
– Oracle Alert sends email to the reviewers
– Each approver responds: approved/rejected
– The responses are reviewed and the ECO

approval status is set to Approved or Rejected

Managing the approval process using Engineering:
• Setup the approval process

– Create approval lists
– Assign an approval list to the ECO
– Assign an ECO change type to the ECO (one not

associated with an Oracle Workflow)
• The Oracle Engineering approval process steps

– Set ECO approval status to: Approval Requested
– Oracle Alert sends email to the reviewers
– Each approver responds: approved/rejected
– The responses are reviewed and the ECO

approval status is set to Approved or Rejected

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > ECO Approval Process > Defining ECO
Approval Lists
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ECO Approval: Oracle WorkflowECO Approval: Oracle Workflow

OracleOracle
Work FlowWork Flow

OracleOracle
EngineeringEngineering

EngineeringEngineering
Change OrderChange Order

Approved!Approved!

OracleOracle
EngineeringEngineering
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ECO Approval: Oracle Workflow

Copyright  Oracle Corporation, 2000. All rights reserved.
®

ECO Approval: Oracle WorkflowECO Approval: Oracle Workflow

Managing the approval process using Workflow:
• Setup the workflow approval process

– Create a workflow or use a seeded workflow
for approval with processes to perform actions
and notifications to contact employees for
decisions

– Assign an approvers list as a ‘role’ to the
workflow notification activity

– Assign the workflow to an ECO change type
– Assign the ECO change type to the ECO

Managing the approval process using Workflow:
• Setup the workflow approval process

– Create a workflow or use a seeded workflow
for approval with processes to perform actions
and notifications to contact employees for
decisions

– Assign an approvers list as a ‘role’ to the
workflow notification activity

– Assign the workflow to an ECO change type
– Assign the ECO change type to the ECO

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > ECO Approval Process > Workflow for
ECO Approvals
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ECO Approval: Oracle Workflow
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ECO Approval: Oracle WorkflowECO Approval: Oracle Workflow

Continued:
• The Oracle Workflow approval process steps

– Choose submit on the Engineering Change
Orders form

– The workflow notifies all employees in the role
– Each approver responds: approved/rejected
– Oracle Workflow tabulates the responses,

makes an approval decision, performs follow
up activities and returns control to Oracle
Engineering.

– If an error occurs the ECO approval status
becomes: Processing Error

Continued:
• The Oracle Workflow approval process steps

– Choose submit on the Engineering Change
Orders form

– The workflow notifies all employees in the role
– Each approver responds: approved/rejected
– Oracle Workflow tabulates the responses,

makes an approval decision, performs follow
up activities and returns control to Oracle
Engineering.

– If an error occurs the ECO approval status
becomes: Processing Error
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ECO Approval: Oracle Workflow
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ECO Approval: Oracle WorkflowECO Approval: Oracle Workflow

For example the standard approval processing
workflow delivered in Oracle Engineering:
• Requires unanimous approval from the reviewers

to approve the ECO
• Sets MRP Active to selected or clear
• Sets the ECO approval status to Approved or

Rejected

For example the standard approval processing
workflow delivered in Oracle Engineering:
• Requires unanimous approval from the reviewers

to approve the ECO
• Sets MRP Active to selected or clear
• Sets the ECO approval status to Approved or

Rejected
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ECO Approval: Oracle Workflow
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ECO Approval: Oracle WorkflowECO Approval: Oracle Workflow

Get ECO
Attributes

Set MRP
to

Inactive

Set MRP
to

Active

Get
Marketing
Approval

Approve
ECO

Reject
ECO

Get ECO
Committee
Approval

ApproveApprove YesYes

NoNo

RejectReject
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Lesson 3:
Engineering Change Order Business

Objects Interface

Lesson 3:
Engineering Change Order Business

Objects Interface
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• Overview of Engineering Change Orders
• Engineering Change Order Life Cycle
• Engineering Change Order Business

Object Interface
• Summary
• Practice
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• Oracle Engineering enables collaborative product
design with your suppliers and customers.
Release 11i improves the transfer of information
with trading partners by incorporating the ECO
Business Object interface.

• Using the ECO Business Object interface, you can
simplify your access to Oracle Engineering ECOs
through a common, flexible, and robust interface
to meet your mission-critical business needs.

• Oracle Engineering enables collaborative product
design with your suppliers and customers.
Release 11i improves the transfer of information
with trading partners by incorporating the ECO
Business Object interface.

• Using the ECO Business Object interface, you can
simplify your access to Oracle Engineering ECOs
through a common, flexible, and robust interface
to meet your mission-critical business needs.

Help: Oracle Manufacturing Applications > Oracle Engineering > New
Features in This Release
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Importing ECOs

• You can quickly import ECOs by using the new
ECO Business Object interface from any external
system, including the Product Data Management
(PDM) system. Validation of all ECO information
during import clearly identifies change problems,
enabling the appropriate decision-makers to
resolve errors.

Importing ECOs

• You can quickly import ECOs by using the new
ECO Business Object interface from any external
system, including the Product Data Management
(PDM) system. Validation of all ECO information
during import clearly identifies change problems,
enabling the appropriate decision-makers to
resolve errors.
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Updating and Deleting ECOs

• You can also use the ECO Business Object
interface to update and delete existing ECO
information.

Updating and Deleting ECOs

• You can also use the ECO Business Object
interface to update and delete existing ECO
information.
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Business Value of the
ECO Object Interface

• Common, flexible, and robust
• Import capabilities to create, update, delete
• Synchronous—not batch API
• Validates change information
• Provides error messages

• Common, flexible, and robust
• Import capabilities to create, update, delete
• Synchronous—not batch API
• Validates change information
• Provides error messages

Oracle
Forms

Outside
systems

ECO
Business
object 

Interface

ECO
Tables
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• You should now be able to do the following:
– Create engineering change orders
– Recognize the effects of engineering change

orders on bills of material
– Approve, schedule, and implement

engineering change orders
– Understand the ECO business objects

interface

• You should now be able to do the following:
– Create engineering change orders
– Recognize the effects of engineering change

orders on bills of material
– Approve, schedule, and implement

engineering change orders
– Understand the ECO business objects

interface
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– Creating an ECO
– Reviewing changes
– Comparing current BOM and pending BOM
– Rescheduling the ECO
– Reviewing effects of pending changes

– Creating an ECO
– Reviewing changes
– Comparing current BOM and pending BOM
– Rescheduling the ECO
– Reviewing effects of pending changes
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– Approving engineering change orders with
Oracle Workflow

– Attaching a workflow process to the change
type

– Approving an ECO
– Releasing an ECO
– Manually implementing the ECO

– Approving engineering change orders with
Oracle Workflow

– Attaching a workflow process to the change
type

– Approving an ECO
– Releasing an ECO
– Manually implementing the ECO
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1. Change organizations to M1 Seattle Manufacturing
(N) INV Change Organization

2. Create two Items for your team (XX):
– Copy from AS10001 to make XX-10001
– Copy from CM65478 to make XX-65478

(N) ENG Prototypes > Items > Master Items (M)
Tools > Copy From

3. Assign your new items to M1 Seattle Manufacturing
(N) ENG Prototypes > Items > Master Items (M)
Tools > Organization Assignment

1. Change organizations to M1 Seattle Manufacturing
(N) INV Change Organization

2. Create two Items for your team (XX):
– Copy from AS10001 to make XX-10001
– Copy from CM65478 to make XX-65478

(N) ENG Prototypes > Items > Master Items (M)
Tools > Copy From

3. Assign your new items to M1 Seattle Manufacturing
(N) ENG Prototypes > Items > Master Items (M)
Tools > Organization Assignment
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4. Copy the Bill of Material from AS10001 to XX-10001
(N) ENG Prototypes > Bills > Bills (M) Tools > Copy
Bill from

5. Create an ECO as follows:
– ECO: XX-100
– Type: New Prod
– Approval Status: Approved

(N) ENG ECOs > ECOs
– Revised Item: XX-10001
– New Revision: B
– Effective Date: Four weeks from today

(N) ENG ECOs > ECOs (B) Revised Items

4. Copy the Bill of Material from AS10001 to XX-10001
(N) ENG Prototypes > Bills > Bills (M) Tools > Copy
Bill from

5. Create an ECO as follows:
– ECO: XX-100
– Type: New Prod
– Approval Status: Approved

(N) ENG ECOs > ECOs
– Revised Item: XX-10001
– New Revision: B
– Effective Date: Four weeks from today

(N) ENG ECOs > ECOs (B) Revised Items

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > Defining an Engineering Change Order

… Engineering Change Orders > Defining ECO Revised Items
… Engineering Change Orders > Defining an ECO Revision



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i - Managing Engineering Change Orders
Chapter 4 - Page 39

Practice Solution

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice SolutionPractice Solution

5. Create an ECO continued:
– Disable Component: CM65478
– Add Component: XX-65478

(N) ENG ECOs > ECOs (B) Revised Items (B)
Components

6. Review the pending changes on your bill of
materials
Note: Remember to uncheck the Implemented Only
box before finding your bill
(N) ENG Prototypes > Bills > Indented Bills

5. Create an ECO continued:
– Disable Component: CM65478
– Add Component: XX-65478

(N) ENG ECOs > ECOs (B) Revised Items (B)
Components

6. Review the pending changes on your bill of
materials
Note: Remember to uncheck the Implemented Only
box before finding your bill
(N) ENG Prototypes > Bills > Indented Bills

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > Defining Revised Components
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7. Review your new item revision for XX-10001:
(N) ENG Prototypes > Items > Organization Items
(M) Tools > Revisions

8. Compare the XX-10001 Current bill of material (Rev
A) with the pending bill (Rev B)
Note: Remember to uncheck both the Implemented
Only boxes
(N) ENG Prototypes > Bills > Comparison

9.  Review your pending ECO schedule
(N) ENG ECOs > Schedules

7. Review your new item revision for XX-10001:
(N) ENG Prototypes > Items > Organization Items
(M) Tools > Revisions

8. Compare the XX-10001 Current bill of material (Rev
A) with the pending bill (Rev B)
Note: Remember to uncheck both the Implemented
Only boxes
(N) ENG Prototypes > Bills > Comparison

9.  Review your pending ECO schedule
(N) ENG ECOs > Schedules

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > Viewing Item Revisions
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10. Release the ECO
(N) ENG ECOs > ECOs (M) Tools > Release

11. Reschedule your ECO to one week earlier
(N) ENG ECOs > ECOs (M) Tools > Reschedule

12. Review the effect of the change to your pending
bill of material and revision
(N) ENG Prototypes > Bills > Indented Bills
(N) ENG ECOs > ECOs (B) Revised Items (B)
Revisions

10. Release the ECO
(N) ENG ECOs > ECOs (M) Tools > Release

11. Reschedule your ECO to one week earlier
(N) ENG ECOs > ECOs (M) Tools > Reschedule

12. Review the effect of the change to your pending
bill of material and revision
(N) ENG Prototypes > Bills > Indented Bills
(N) ENG ECOs > ECOs (B) Revised Items (B)
Revisions

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > Changing ECO Status

… Engineering Change Orders > Viewing ECO Approval 
Status
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13. Manually implement your ECO
(N) ENG ECOs > ECOs (M) Tools > Implement

14. Review the bill of material to see the effect of
implementing the change
(N) ENG Prototypes > Bills > Indented Bills

15. Create another ECO as follows:
– ECO: XX-200
– Type: New Prod
– Priority: Standard

(N) ENG ECOs > ECOs

13. Manually implement your ECO
(N) ENG ECOs > ECOs (M) Tools > Implement

14. Review the bill of material to see the effect of
implementing the change
(N) ENG Prototypes > Bills > Indented Bills

15. Create another ECO as follows:
– ECO: XX-200
– Type: New Prod
– Priority: Standard

(N) ENG ECOs > ECOs

Help: Oracle Manufacturing Applications > Oracle Engineering >
Engineering Change Orders > Implementing ECOs
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15. Create another ECO continued:
– Revised Item: XX-10001
– New Revision: C
– Effective Date: Four weeks from today

(N) ENG ECOs > ECOs (B) Revised Items
16. Submit your new ECO to launch the workflow for

approval
 (N) ENG ECOs > ECOs (B) Submit

17. Approve your ECO
(N) ENG ECOs > Notification

15. Create another ECO continued:
– Revised Item: XX-10001
– New Revision: C
– Effective Date: Four weeks from today

(N) ENG ECOs > ECOs (B) Revised Items
16. Submit your new ECO to launch the workflow for

approval
 (N) ENG ECOs > ECOs (B) Submit

17. Approve your ECO
(N) ENG ECOs > Notification
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18. Review your ECO for Approval Status = Approved
and MRP Active = selected
 (N) ENG ECOs > ECOs (B) Revised Items

19. Manually implement your ECO
 (N) ENG ECOs > ECOs (M) Tools > Implement

18. Review your ECO for Approval Status = Approved
and MRP Active = selected
 (N) ENG ECOs > ECOs (B) Revised Items

19. Manually implement your ECO
 (N) ENG ECOs > ECOs (M) Tools > Implement
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After completing this course, you should be able to
do the following:
•  Explain the concepts of planning, model, and
    option bills of material
•  Describe the steps in creating product families

After completing this course, you should be able to
do the following:
•  Explain the concepts of planning, model, and
    option bills of material
•  Describe the steps in creating product families
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• Lesson 1: Creating customized bills of material
• Lesson 2: Creating product families
• Lesson 1: Creating customized bills of material
• Lesson 2: Creating product families
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Lesson 1: Creating Customized
Bills of Material

• Lesson 1: Creating customized bills of material
• Lesson 2: Creating product families
• Lesson 1: Creating customized bills of material
• Lesson 2: Creating product families
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After completing this lesson, you should be able to
manually create planning, model, and option class
bills of material.

After completing this lesson, you should be able to
manually create planning, model, and option class
bills of material.
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You use bills of material to specify the component
items that you use to:
• Manufacture assemblies and subassemblies
• Configure assemblies from sales order line items
• Explode aggregate forecasts
• Calculate standard cost

You use bills of material to specify the component
items that you use to:
• Manufacture assemblies and subassemblies
• Configure assemblies from sales order line items
• Explode aggregate forecasts
• Calculate standard cost
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ItemsItems

PlanningPlanning

ModelModel

Option classOption class

StandardStandard

Types of Oracle Bills of Material
Planning: Use planning bills of material to specify items that belong to the same
product line (similar to a product family which is discussed later). For example, a
restaurant that sells Italian food sells pizza, which accounts for 70 percent of its
Italian food business, and calzone, which accounts for 30 percent of its Italian
food business. Refer to the assembly of a planning bill of material as a product
family.
Model: Use model bills of material to specify classes of options from which your
customers can choose when ordering configurable items. For example, a
customer ordering a pizza must choose the type of crust, type of sauce, type
of cheese, and toppings. Refer to the nonoptional components as included
items or mandatory components.
Option Class: Use option class bills of material with model bills of material to
specify families of options from which your customers can choose when ordering
configurable items. For example, a customer ordering a pizza can choose pizza
toppings from among sausage, pepperoni, onions, and mushrooms.
Refer to the optional components of an option class bill of material as options and
the nonoptional components of an option class bill of material as included items
or mandatory components.
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Bill of Material Item TypesBill of Material Item Types

ItemsItems

PlanningPlanning

ModelModel

Option classOption class

StandardStandard

Creating Assembly Item Types of BOM
You must make sure that the assembly's BOM Item Type attribute in the item
master specifies the bill of material type you wish to create. For example, to
create a model bill of material, select Model from the drop down list as the value
of the BOM Item Type item attribute.
Allowing Entry of Items on Bills of Material
You must select the BOM Allowed item attribute for both the assembly item
and all of the component items from which you want to construct a bill of
material. When you select the BOM Allowed item attribute, you can use the
item as either an assembly or as a component of a bill of material. Before
you can select the BOM Allowed item attribute, you must select the
Inventory Item attribute.
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Planning BOMPlanning BOM

Option class BOMOption class BOM

Standard BOMStandard BOM

Model BOMModel BOM CalzoneCalzonePizzaPizza

ToppingsToppingsSauceSauce

Pesto saucePesto sauce

Olive oilOlive oilTomatoesTomatoes

Italian foodItalian food

Tomato sauceTomato sauce

Connecting Multiple Bills of Material
The bills of material shown in the slide include:
• A planning bill of material for Italian foods containing items pizza and calzone

as components
• Two model bills of material for pizza and calzone (Pizza contains the option

class components sauce and toppings.)
• Two option class bills of material for sauce and toppings (Sauce contains

standard components tomato sauce and pesto sauce.)
• Two standard bills of material for tomato sauce and pesto sauce (Tomato sauce

contains standard components tomato and oil.)
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Planning Bills of MaterialPlanning Bills of Material

Training
computer 
Training

computer 

Research
computer
Research
computer

Workplace
computer

Workplace
computer

Classroom
computer

Classroom
computer

Planning BOMPlanning BOM

Specify Components for Planning BOM
Use planning bills of material to specify components that belong to the same
product line.
You neither order nor build planning assemblies. Clear item attributes
Customer Ordered, Customer Orders Enabled, Internal Orders Enabled, and
Build in WIP.
(Help) Oracle Manufacturing Applications > Oracle Inventory > Items >
Item Attribute Descriptions by Group > Main Attribute Group >
(link) Status Attributes and Item Status Control
You use planning bills for aggregate forecasting. Assign planning percentages,
as well as quantities per assembly, to the components in proportion to their use
in the assembly. The forecast explosion process allocates forecasts of the
assembly to the components based on their planning percentages and their
quantities per assembly.
If the top level  item attribute BOM Item Type value is Planning, you can use
those items with item attribute BOM Item Type value of Planning, Model,
Option class, and Standard as components.
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EGA
monitor

EGA
monitor

VGA
monitor
VGA

monitor

MonitorMonitor

Workplace
computer 

Workplace
computer 

VIA
manual

VIA
manualVGA-BVGA-BVGA-AVGA-A VGA

stand
VGA
stand

Model BOMModel BOM

OptionOption

Option classOption class
 BOM BOM

Option classOption class
 BOM BOM

OptionOption IncludedIncluded IncludedIncluded

Specifying Classes for Model BOM
Use model bills of material to specify classes of options from which your
customers can choose when they order configurable items.
The two types of model bills of material are:
Pick-to-order: Your customer chooses options, and you pick and ship the
components.
Assemble-to-order: Your customer chooses options, and you assemble the
components before shipping.
In the example in the slide, each computer is made up of a monitor option class,
cpu option class, and accessories option class.
Each monitor option class is made up of a VGA option class and a EGA option
class. The VGA monitor option class has two options, VGA-A and VGA-B, and
to components that are always included, the manual and the stand.
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EGA
monitor

EGA
monitor

VGA
monitor
VGA

monitor

MonitorMonitor

Workplace
computer 

Workplace
computer 

VIA
manual

VIA
manualVGA-BVGA-BVGA-AVGA-A VGA

stand
VGA
stand

Model BOMModel BOM

OptionOption

Option classOption class
 BOM BOM

Option classOption class
 BOM BOM

OptionOption IncludedIncluded IncludedIncluded

Model Bills of Materials
You do not build model assemblies; you assemble a configured item on a
final assembly schedule. The configured item has a standard bill of material
that contains only the options that the customer selected. Select Customer
Ordered, Customer Orders Enabled, Internal Ordered, and Internal Orders
Enabled item attributes. Clear the check box for the Build in WIP item attribute.
You use model bills of material for aggregate forecasting. Assign planning
percentages to the components in proportion to their use in the model. The
forecast explosion process allocates forecasts of the model to the components
based on their planning percentages.
If the value of the assembly BOM Item Type item attribute is Model, you
can use those items with a BOM Item Type item attribute value of Model,
Option Class, and Standard as components.
Because Oracle Order Management uses model bills of material, you must also
define them in the organization designated by profile option OE: Item Validation
Organization.
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VGA
monitor
VGA

monitor

VGA-AVGA-A VGA-BVGA-B

Option class BOMOption class BOM

OptionOption OptionOption

Rules for Setting Up Option Class Bills of Material
Use option class bills of material with model bills of material to specify
families of options from which your customers can choose when ordering
configurable items.
You neither order nor build option class assemblies; you order and build the
options. You should clear Customer Ordered, Customer Orders Enabled,
Internal Ordered, Internal Orders Enabled, and Build in WIP item attributes.
You use option class bills of material for aggregate forecasting. Assign
planning percentages to the components in proportion to their use in the
assembly. The forecast explosion process allocates forecasts of the assembly
to the components based on their planning percentages.
If the assembly BOM Item Type item attribute value is Option Class, you
can use those items with BOM Item Type item attribute value of Model,
Option Class, and Standard as components.
Since Oracle Order Management uses option class bills of material, you must also
define them in the organization designated by profile option OE: Item Validation
Organization.
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PrimaryPrimary AlternateAlternate

EEDD

BB CC

AA

Upgrade
kit

Upgrade
kitNew DNew D

BB CC

AA

Restriction
Do not create alternate bills of material for model and option class bills of
material.  You cannot choose alternate bills of material when you configure an
order.  Refer to the Oracle Bills of Material User’s Guide for additional
information.
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Which bill of material item types cannot be built?
a Model
b Standard
c Planning
d Option Class

Which bill of material item types cannot be built?
a Model
b Standard
c Planning
d Option Class
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Which bill of material item types cannot be built?
a Model
b Standard
c Planning
d Option Class

Which bill of material item types cannot be built?
a Model
b Standard
c Planning
d Option Class
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Bill of Material Data: Component DetailsBill of Material Data: Component Details

• Use the Planning % field for planning, model, and
option class bills of material.

• Enter the percentage of assembly sales that this
component usually contributes.
– The planning percentages for all the

components on a bill of material may total more
than 100%.

– Oracle Planning uses this percentage to
calculate forecasts for the components from
forecasts for the product family and model.

• Use the Planning % field for planning, model, and
option class bills of material.

• Enter the percentage of assembly sales that this
component usually contributes.
– The planning percentages for all the

components on a bill of material may total more
than 100%.

– Oracle Planning uses this percentage to
calculate forecasts for the components from
forecasts for the product family and model.

(N) Engineering > Prototypes > Bills > Bills (T) Component Details
(N) Bills of Material > Bills > Bills (T) Component Details
(Help) Oracle Manufacturing Applications > Oracle Engineering >
Engineering Prototype Environment >
Engineering Bills of Material and Routings >
(Related Topics) Creating a Bill of Material (Oracle Bills of Material Help) >
Planning Percent (Link) > Planning Percent Field
(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Defining a Bill of Material > Creating a Bill of Material >
Planning Percent (Link) > Planning Percent Field
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Bill of Material Data: Order EntryBill of Material Data: Order Entry

• Check ATP: Use for model and option class bills of
material. Select the check box to indicate that the
available-to-promise feature in Oracle Order
Management should check the availability of this
component when suggesting a promise date for a
customer order. You can select this check box if
you have selected the item attribute Check ATP for
both the assembly and the component.

• Check ATP: Use for model and option class bills of
material. Select the check box to indicate that the
available-to-promise feature in Oracle Order
Management should check the availability of this
component when suggesting a promise date for a
customer order. You can select this check box if
you have selected the item attribute Check ATP for
both the assembly and the component.

(N) Engineering > Prototypes > Bills > Bills
(T) Order Management

(N) Bills of Material > Bills > Bills (T) Order Management

(Help) Oracle Manufacturing Applications > Oracle Engineering >
Engineering Prototype Environment >
Engineering Bills of Material and Routings >
(Related Topics) Creating a Bill of Material (Oracle Bills of Material Help) >
(link) Check ATP
(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Defining a Bill of Material > Creating a Bill of Material >
(link) Check ATP
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Bill of Material Data:
Order Entry (continued)

Bill of Material Data:
Order Entry (continued)

• Optional: Used with model and option class bills
of material. Select the component’s check box to
indicate that the customer placing a customer
order can select this component as an option.

• Optional: Used with model and option class bills
of material. Select the component’s check box to
indicate that the customer placing a customer
order can select this component as an option.

(Help) Oracle Manufacturing Applications > Oracle Engineering >
Engineering Prototype Environment >
Engineering Bills of Material and Routings >
(Related Topics) Creating a Bill of Material (Oracle Bills of Material Help) >
(link) Mutually Exclusive and Optional
(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Defining a Bill of Material > Creating a Bill of Material >
(link) Mutually Exclusive and Optional
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Bill of Material Data:
Order Entry (continued)

Bill of Material Data:
Order Entry (continued)

• Mutually Exclusive: Used with model and option
class bills of material. This component applies if
you have taken one of these actions:
– Selected both Mutually Exclusive and

Optional, a customer placing a customer order
can choose no options or choose one, and
only one, option.

– Selected Mutually Exclusive and cleared
Optional, a customer placing a customer order
must choose one option only.

• Mutually Exclusive: Used with model and option
class bills of material. This component applies if
you have taken one of these actions:
– Selected both Mutually Exclusive and

Optional, a customer placing a customer order
can choose no options or choose one, and
only one, option.

– Selected Mutually Exclusive and cleared
Optional, a customer placing a customer order
must choose one option only.
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Bill of Material Data:
Order Entry (continued)

Bill of Material Data:
Order Entry (continued)

– Cleared Mutually Exclusive and selected
Optional, a customer placing a customer order
can choose no options or any number of
options.

– Cleared both Mutually Exclusive and Optional,
a customer placing a customer order can
choose any number of options, but must
choose at least one option.

(N) Engineering > Prototypes > Bills > Bills (T) Order Management

(N) Bills of Material > Bills > Bills (T) Order Management

– Cleared Mutually Exclusive and selected
Optional, a customer placing a customer order
can choose no options or any number of
options.

– Cleared both Mutually Exclusive and Optional,
a customer placing a customer order can
choose any number of options, but must
choose at least one option.

(N) Engineering > Prototypes > Bills > Bills (T) Order Management

(N) Bills of Material > Bills > Bills (T) Order Management

(Help) Oracle Manufacturing Applications > Oracle Engineering >
Engineering Prototype Environment >
Engineering Bills of Material and Routings >
(Related Topics) Creating a Bill of Material (Oracle Bills of Material Help) >
Mutually Exclusive and Optional (Link) Mutually Exclusive and Optional Fields
(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Defining a Bill of Material > Creating a Bill of Material >
Mutually Exclusive and Optional (Link) Mutually Exclusive and Optional Fields
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Bill of Material Data:
Order Entry (continued)

Bill of Material Data:
Order Entry (continued)

• Quantity  Minimum: Used with model and option
class bills of material to indicate the minimum
number of the component that a customer placing
a customer order must order.

• Quantity Maximum: Used with model and option
class bills of material to indicate the maximum
number of the component that a customer placing
a customer order can order.

• Quantity  Minimum: Used with model and option
class bills of material to indicate the minimum
number of the component that a customer placing
a customer order must order.

• Quantity Maximum: Used with model and option
class bills of material to indicate the maximum
number of the component that a customer placing
a customer order can order.

(N) Engineering > Prototypes > Bills > Bills (T) Order Management

(N) Bills of Material > Bills > Bills (T) Order Management

(Help) Oracle Manufacturing Applications > Oracle Engineering >
Engineering Prototype Environment >
Engineering Bills of Material and Routings >
(Related Topics) Creating a Bill of Material (Oracle Bills of Material Help) >
Minimum and Maximum Quantities (Link) >
Minimum and Maximum Quantity Fields
(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Defining a Bill of Material > Creating a Bill of Material >
Minimum and Maximum Quantities (Link) >
Minimum and Maximum Quantity Fields
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Processing Assemble-to-OrderProcessing Assemble-to-Order

• When your customers order configured items, you
use Oracle Order Management to display model and
option class bills of material from which they choose
options.

• Use the Run Assemble to Order Processes form to
create a unique item number and a unique standard
bill of material, based on the model and option class
bills of material for each configured sales order line.

• When the AutoCreate Configuration Items feature is
used, Oracle generates either a WIP discrete order or
schedule.

• A BOM and associated routing is created for the
specific sales order.

• When your customers order configured items, you
use Oracle Order Management to display model and
option class bills of material from which they choose
options.

• Use the Run Assemble to Order Processes form to
create a unique item number and a unique standard
bill of material, based on the model and option class
bills of material for each configured sales order line.

• When the AutoCreate Configuration Items feature is
used, Oracle generates either a WIP discrete order or
schedule.

• A BOM and associated routing is created for the
specific sales order.

(N) Bills of Material > ATO
(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Configure to Order >AutoCreate Configuration Items >
AutoCreating Config Items and Final Assembly Orders  >
(link) AutoCreate Configuration Items and Final Assembly Orders
Note: The unique item number is comprised of the Numbering Segment and
Numbering Method you selected in the Configuration Options setup parameters
during implementation.
Note: If you have checked the BOM profile option to check for duplicate
configurations, and one is found, the same assigned item number is used.
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Enhanced Open Interfaces

BOM and routing open interfaces
• Import updates and deletes to existing bills and

routings
• Use user-friendly values

Open interface
tables

OracleOracleLegacyLegacy
or PDMor PDM

SystemsSystems

Bills of Material Open Interface
Oracle Manufacturing integration tools are powerful, flexible tools with
which you can capture data from other Oracle applications or your own
applications, define necessary format conversions, and direct data to your
Oracle Manufacturing products.
The bills of material open interface can:
• Update and delete BOM information including, bills and common bills,

reference designators, and substitute components
• Update and delete BOM component information including, planning, cost rollup

indicator, supply type, supply locator, and check ATP indicator
• Update and delete BOM component information including, model, option class

information (optional, mutually exclusive, basis), min and max quantities, order
information, and assembly components
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Review QuestionReview Question

If you want the system to see if the component is
available when suggesting the promise date for a
customer order, you have to check the Check ATP
item attribute for:
a  the component
b  the assembly
c  both
d  neither

If you want the system to see if the component is
available when suggesting the promise date for a
customer order, you have to check the Check ATP
item attribute for:
a  the component
b  the assembly
c  both
d  neither
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Answer to Review QuestionAnswer to Review Question

If you want the system to see if the component is
available when suggesting the promise date for a
customer order, you have to check the Check ATP
item attribute for:
a  the component
b  the assembly
c  both
d  neither

If you want the system to see if the component is
available when suggesting the promise date for a
customer order, you have to check the Check ATP
item attribute for:
a  the component
b  the assembly
c  both
d  neither
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Lesson 1 SummaryLesson 1 Summary

You should now be able to do the following:
• Specify options for customers
• Specify classes of options for customers
• Create planning, model, and option class bills of

material

You should now be able to do the following:
• Specify options for customers
• Specify classes of options for customers
• Create planning, model, and option class bills of

material

Bills of Material Summary
To create each of the four types of bills of material, you use an assembly
item with a corresponding item type, as follows:
• Use planning bills of material to specify components that belong to the same

product line.
• Use model bills of material to specify classes of options from which your

customers can choose when ordering pick to order and configurable items.
• Use option class bills of material with model bills of material to identify the list

of specific options from which your customers can choose when ordering pick
to order and configurable items.

• Use standard bills of material to specify components that you use to
manufacture items.

• • A bill of material revision indicates that one or more components of a
parent have been added, changed, or deleted.

• • You use the ATO processes to create a unique item number and a unique
standard bill of material based on the model and option class bills of material
for each configured sales order line.
Note: If you have checked the BOM profile option to check for duplicate
configurations, and one is found, the same assigned item number is used.
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Practice 1-1 OverviewPractice 1-1 Overview

• Entering marketing bills of material
• Specifying option classes for components
• Entering attribute fields for components
• Exploding forecasts for model item numbers

• Entering marketing bills of material
• Specifying option classes for components
• Entering attribute fields for components
• Exploding forecasts for model item numbers
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A Model Bill of MaterialA Model Bill of Material

XX-SPEAKERS

XX-VIDEO

XX-CDROM

XX-MODEM

XX-OC-ACC   XX-DOC

XX-MODEL

XX-MON-21

XX-MON-19

XX-MON-16

XX-OC-MON

XX-CPU500

XX-CPU400

XX-CPU300

XX-OC-CPU

Build the PC Model Structure
The model is made up of a CPU, a monitor, accessories, and documentation. A
customer can select from three CPUs, three monitors, and four accessories. The
documentation is a standard item.

1 Create item numbers for all of the above items, using the descriptions and
templates indicated below. Remember to enable these items in the shipping
organization (M1).

1 Item Number Description Template
XX-MODEL Model PC PTO Model
XX-OC-CPU CPU Options PTO Option Class
XX-OC-MON Monitor Options PTO Option Class
XX-OC-ACC Optional Accessories PTO Option Class
XX-DOC PC User’s Guide Finished Good
XX-CPU300 CPU 300 (low end CPU) Finished Good
XX-CPU400 CPU 400 (mid range CPU) Finished Good
XX-CPU500 CPU 500 (high end CPU) Finished Good
XX-MON-16 16” Color Monitor Finished Good
XX-MON-19 19” Color Monitor Finished Good
XX-MON-21 21” Color Monitor Finished Good
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A Model Bill of MaterialA Model Bill of Material

XX-SPEAKERS

XX-VIDEO

XX-CDROM

XX-MODEM

XX-OC-ACC   XX-DOC

XX-MODEL

XX-MON-21

XX-MON-19

XX-MON-16

XX-OC-MON

XX-CPU500

XX-CPU400

XX-CPU300

XX-OC-CPU

Build the PC Model Structure (continued)
1 Create item numbers for all of the above items, using the descriptions and

templates indicated below. Remember to enable these items in the shipping
organization (M1).

1 Item Number Description Template
XX-MODEM Fax/Modem Card Finished Good
XX-CDROM CDROM Drive Finished Good
XX-VIDEO Video Finished Good
XX-SPEAKERS Pair of Whiz-Bang Speakers Finished Good
2 Change your organization to the Vision Operations.
3 Create the BOM as shown above. Remember to set the order entry and shipping

attributes for the option class and finished good components per the
configuration rules below:

• Selection of a CPU and a Monitor is REQUIRED when ordering any XX-
MODEL configuration.

• Selection of any accessory is OPTIONAL.
• The PC User’s Guide is an INCLUDED item.
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A Model Bill of MaterialA Model Bill of Material

XX-SPEAKERS

XX-VIDEO

XX-CDROM

XX-MODEM

XX-OC-ACC   XX-DOC

XX-MODEL

XX-MON-21

XX-MON-19

XX-MON-16

XX-OC-MON

XX-CPU500

XX-CPU400

XX-CPU300

XX-OC-CPU

Build the PC Model Structure (continued)
The configurations rules (continued):

• The CPU options and the Monitor options are MUTUALLY EXCLUSIVE of
each other. A customer can order only one CPU and only one Monitor, and
they are REQUIRED for shipment and billing.

• Accessory options are MUTUALLY EXCLUSIVE of each other. So a
customer does not have to order any of these, but if accessories are ordered,
only one of each can be selected due to slot limitations on the CPU.

• If a customer orders the XX-CPU500, the XX-MODEM and the XX-CDROM
cannot be selected since these options are included as part of the high end
CPU.
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Testing Your Model Bill of Material
(optional)

Testing Your Model Bill of Material
(optional)

Before you can enter a sales order for your model,
every item that you created must be on a specified
price list. Two rules to follow:
• Place your model and option class items on the

price list with a zero value.
• Enter very small price values for all other

components.
Enter an order for your XX-MODEL. Use the
information in the note section for your order:

Before you can enter a sales order for your model,
every item that you created must be on a specified
price list. Two rules to follow:
• Place your model and option class items on the

price list with a zero value.
• Enter very small price values for all other

components.
Enter an order for your XX-MODEL. Use the
information in the note section for your order:

Entering an order
1 In the Order Information area, enter or select:

• Customer Name: Business World
• Order Type: Standard
• Accept all other defaults

2 In the Line Items area, enter or select:
• Line: accept the default
• Ordered Item: XX-MODEL
• Qty: 1

3 Select the Configurator tab (Your PTO model bill of material is displayed.)
4 Select what ever options you want.
4 Note: First time through, do not break any of the configuration rules.
5 Enter a second order; see what happens when you break one or more of your

configuration rules.
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Lesson 2: Creating Product FamiliesLesson 2: Creating Product Families

• Lesson 1: Creating customized bills of material
• Lesson 2: Creating product families
• Lesson 1: Creating customized bills of material
• Lesson 2: Creating product families
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Lesson 2 ObjectivesLesson 2 Objectives

After completing this lesson you should be able to
do the following:
•  Group like items into product families
•  Assign member items
•  Control member item planning percentages with
    effectivity dates

After completing this lesson you should be able to
do the following:
•  Group like items into product families
•  Assign member items
•  Control member item planning percentages with
    effectivity dates
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• A product family is a single-level BOM.
• You may apply the product family template to

create your product family consistently.
• You must define the product family item and all

the family members as items.
• If you do not assign planning percentages, the

Oracle database will assign the default percentage
of 100%.

• A product family is a single-level BOM.
• You may apply the product family template to

create your product family consistently.
• You must define the product family item and all

the family members as items.
• If you do not assign planning percentages, the

Oracle database will assign the default percentage
of 100%.
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Product Family: Example

Viper Family
FX-166

Blue Viper
BX-166

Red Viper
RX-166

White Viper
WX-166

Product Family
A product family is a grouping of products that are similar in resource usage,
design, and manufacturing process. These similarities facilitate planning at an
aggregate level. A product family cannot be structured under a Standard,
Planning, Model, or Option Class bill of material. Consequently, a product family
is a single-level bill of material. Members of a product family can belong to only
one product family. You will be able to plan based on the planning percentages
and effectivity of the product family members. Refer to the Oracle Bills of
Material User’s Guide for detailed information.
Note: You must make sure that the product family key flexfield structure is
configured to match the system item structure. If the system item structure is
changed, it should be reflected in the product family structure as well.
Product Family Items
•  Product Family Items are defined in the master items form.
•  They are created by using the predefined product family item template, or a
   template you have created for your company.
•  This feature automatically creates product family categories for each product
   family item.
•  Planning percentages can exceed 100%.
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Setting Up a Product Family

Viper Family
FX-166

(N) Inventory > Items > Master Items

To create a product family item:
1 Navigate to the Master Item form.

Note: If you are a Flow Manufacturing customer, select Product Family from
the Flow Manufacturing window. The product family template is automatically
applied.

2 Apply the product family template.
Note: You are not required to use the product family template. If you choose
not to do so, make sure you define the correct product family attributes.
Specifically, the item must be an inventory item and the BOM Item Type must
be Product Family. The item must also be BOM allowed.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Creating a Product Family
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Assigning Members to a Product Family

Viper Family
FX-166

Blue Viper
BX-166

Red Viper
RX-166

White Viper
WX-166

(N) Material Planning > Setup > Product Family

To assign family members:
1 Navigate to the Product Family form.

Note: If you are using Oracle Flow Manufacturing,  you can select Product
Family Members from the Flow Manufacturing menu.

2 Select a product family item.
3 Select item members of the product family. The description, type, forecast

control, and planning method for the member items are displayed for the items
selected.
Note: When an item is included in a product family, it is automatically assigned
to the same category as the family item.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Assigning Product Family Members
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Assigning Member Planning Percentages

Viper Family
FX-166

Blue Viper
BX-166

Red Viper
RX-166

White Viper
WX-166

(N) Material Planning > Setup > Product Family (B) Allocations

40% 30%50%

Assigning Percentages:
1 Navigate to the Allocations form.
2 For each selected product family member, enter the planning percentage.
3 Assign effectivity dates for the item.

Note: Effectivity dates cannot overlap.
4 Optionally, enter comments text.
5 Save your work.

Note: You cannot commit a record without assigning planning percentages. The
default planning percent is 100. The default effectivity date is the system date.

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Assigning Product Family Members > Related Topics >
Setting Planning Percentages for Product Family Members
and
(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Bills of Material References > Planning Percent
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Review QuestionReview Question

Which of the following statements are true?
a A product family can be part of a model bill of

material.
b Members of a product family cannot belong to

more than one family.
c You cannot apply effectivity to a product family

member.
d A product family is a single-level bill of material.

Which of the following statements are true?
a A product family can be part of a model bill of

material.
b Members of a product family cannot belong to

more than one family.
c You cannot apply effectivity to a product family

member.
d A product family is a single-level bill of material.
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Answer to Review QuestionAnswer to Review Question

Which of the following statements are true?
a A product family can be part of a model bill of material.
b Members of a product family cannot belong to

more than one family.
c You cannot apply effectivity to a product family

member.
d A product family is a single-level bill of material.

Which of the following statements are true?
a A product family can be part of a model bill of material.
b Members of a product family cannot belong to

more than one family.
c You cannot apply effectivity to a product family

member.
d A product family is a single-level bill of material.
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Lesson 2 SummaryLesson 2 Summary

You should now be able to do the following:
• Group like items into product Families
• Assign member items
• Control member item planning percentages with

effectivity dates

You should now be able to do the following:
• Group like items into product Families
• Assign member items
• Control member item planning percentages with

effectivity dates
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Practice 2-1 OverviewPractice 2-1 Overview

• Creating product families
• Creating product members
• Assigning members to product families

• Creating product families
• Creating product members
• Assigning members to product families
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1 Create a product family called XX-BIKES with a
description of Bikes Product Family.

2 Create family member items for the following:
– XX-B-BIKE (Blue Bike)
– XX-G-BIKE (Green Bike)
– XX-W-BIKE (White Bike)

3 Assign members to the product family.
4 Assign planning percentages to your product

family.

1 Create a product family called XX-BIKES with a
description of Bikes Product Family.

2 Create family member items for the following:
– XX-B-BIKE (Blue Bike)
– XX-G-BIKE (Green Bike)
– XX-W-BIKE (White Bike)

3 Assign members to the product family.
4 Assign planning percentages to your product

family.
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Practice 2-1 SolutionPractice 2-1 Solution

XX-G-BIKE

XX-BIKES

XX-B-BIKE XX-W-BIKE

1 Create a product family called XX-BIKES with a description of
Bikes Product Family.

(N) Inventory > Items > Master Items

• Copy from the item template named Product Family

• Save your work

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Creating a Product Family
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Practice 2-1 SolutionPractice 2-1 Solution

XX-G-BIKE

XX-BIKES

XX-B-BIKE XX-W-BIKE

2 Create family member items for the following:

• XX-B-BIKE  (Blue Bike
• XX-G-BIKE  (Green Bike)

• XX-W-BIKE  (White Bike)

(N) Inventory > Items > Master Items
• Copy from the item template named Subassembly

• Save your work
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XX-G-BIKE

XX-BIKES

XX-B-BIKE XX-W-BIKE

3 Assign members to the product family.

(N) Material Planning > Setup > Product Family
• Enter each member item

• Save your work

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Assigning Product Family Members
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Practice 2-1 SolutionPractice 2-1 Solution

XX-G-BIKE

XX-BIKES

XX-B-BIKE XX-W-BIKE

4 Assign planning percentages to your product family.

(N) Material Planning > Setup > Product Family (B) Allocations
• Enter each member’s percentage

• Save your work

(Help) Oracle Manufacturing Applications > Oracle Bills of Material >
Bills of Material > Assigning Product Family Members > Related Topics >
Setting Planning Percentages for Product Family Members
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You should now be able to do the following:
• Explain the concepts with planning, model, and
     option bills of material
• Describe the steps in creating product families

You should now be able to do the following:
• Explain the concepts with planning, model, and
     option bills of material
• Describe the steps in creating product families



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i - Setting Up and Implementing Engineering
Chapter 6 - Page 1

R11i - Setting Up and
Implementing Engineering
Chapter 6



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i - Setting Up and Implementing Engineering
Chapter 6 - Page 2

R11i - Setting Up and Implementing Engineering
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R11i - Setting Up and Implementing
Engineering

R11i - Setting Up and Implementing
Engineering



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i - Setting Up and Implementing Engineering
Chapter 6 - Page 3

Objectives

Copyright  Oracle Corporation, 2000. All rights reserved.
®
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After completing this course,  you should be able to:
• Setup the Oracle Engineering module
• Identify implementation considerations
• Prepare to enter items, bills of material and

routings
• Prepare to perform transfers, engineering

changes, mass changes and deletions

After completing this course,  you should be able to:
• Setup the Oracle Engineering module
• Identify implementation considerations
• Prepare to enter items, bills of material and

routings
• Prepare to perform transfers, engineering

changes, mass changes and deletions
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• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary
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Lesson 1 - Product OverviewLesson 1 - Product Overview

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary
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• The Oracle engineering products are Oracle Bills
of Material and Oracle Engineering.

• You use Oracle Bills of Material to:
– Create and maintain production items
– Create and maintain production bills of

materials
– Create and maintain production resources,

departments, routings, and lead times
– Perform mass changes
– Delete product information
– Maintain the workday calendar

• The Oracle engineering products are Oracle Bills
of Material and Oracle Engineering.

• You use Oracle Bills of Material to:
– Create and maintain production items
– Create and maintain production bills of

materials
– Create and maintain production resources,

departments, routings, and lead times
– Perform mass changes
– Delete product information
– Maintain the workday calendar
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Product Overview
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Product OverviewProduct Overview

• You use Oracle Engineering to:
– Create and maintain engineering items
– Create and maintain engineering bills of

materials
– Create and maintain engineering resources,

departments, routings, and lead times
– Transfer engineering product information to

production
– Process engineering change orders
– Perform mass changes
– Delete product information

• You use Oracle Engineering to:
– Create and maintain engineering items
– Create and maintain engineering bills of

materials
– Create and maintain engineering resources,

departments, routings, and lead times
– Transfer engineering product information to

production
– Process engineering change orders
– Perform mass changes
– Delete product information
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Lesson 2 - Module SetupLesson 2 - Module Setup

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary
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Oracle Applications Implementation Wizard.
• Using the Wizard is optional.
• If implementing more than one Oracle Applications

product, it is recommended that you use the
Applications Implementation Wizard to coordinate
setup steps.

• The Wizard guides you through setup for the
applications you have installed.

• It suggests a logical sequence of steps that satisfy
cross-product dependencies and reduces
redundant steps.

• The wizard can also document your
implementation for future reference and review,
including your comments at each step.

Oracle Applications Implementation Wizard.
• Using the Wizard is optional.
• If implementing more than one Oracle Applications

product, it is recommended that you use the
Applications Implementation Wizard to coordinate
setup steps.

• The Wizard guides you through setup for the
applications you have installed.

• It suggests a logical sequence of steps that satisfy
cross-product dependencies and reduces
redundant steps.

• The wizard can also document your
implementation for future reference and review,
including your comments at each step.

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Setup Overview
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In addition to setting up Oracle Engineering you must
set up the underlying Oracle applications technology.
These steps are discussed in detail in other courses.
• Perform system wide setup tasks such as

configuring concurrent managers and printers.
• Manage data security, which includes setting up

responsibilities, and assigning users to one or
more of these responsibilities

• Setup Oracle Workflow

In addition to setting up Oracle Engineering you must
set up the underlying Oracle applications technology.
These steps are discussed in detail in other courses.
• Perform system wide setup tasks such as

configuring concurrent managers and printers.
• Manage data security, which includes setting up

responsibilities, and assigning users to one or
more of these responsibilities

• Setup Oracle Workflow
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Related Application SetupsRelated Application Setups

Before you setup Oracle Engineering you must
complete the setup for the following:
• In Oracle Inventory

– Defining items
• Oracle Bills of Material

– Module setup

Before you setup Oracle Engineering you must
complete the setup for the following:
• In Oracle Inventory

– Defining items
• Oracle Bills of Material

– Module setup
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Step 1 - Set Profile Options (Required)
• Profile options control how Oracle Engineering

manages access to and processes data.
• Profile options can be set at one or more of the

following levels
– site
– application
– responsibility
– user

• Perform this step once for each entity (site,
application, responsibility or user)

In Oracle Engineering: (N) Setup > Profiles

Step 1 - Set Profile Options (Required)
• Profile options control how Oracle Engineering

manages access to and processes data.
• Profile options can be set at one or more of the

following levels
– site
– application
– responsibility
– user

• Perform this step once for each entity (site,
application, responsibility or user)

In Oracle Engineering: (N) Setup > Profiles



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i - Setting Up and Implementing Engineering
Chapter 6 - Page 13

Setup Steps

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Setup StepsSetup Steps

Step 2 - Enter Employee (Required)
• Define employees for your organization.  ECO

requestors and approvers must be defined as
employees.

• If you have Oracle Human Resource Management
Systems installed, enter employees there.  If not,
enter employees in Oracle Engineering.

• Perform this step once for each entity
organization.

In Oracle Engineering:
(N) Setup > Employees

Step 2 - Enter Employee (Required)
• Define employees for your organization.  ECO

requestors and approvers must be defined as
employees.

• If you have Oracle Human Resource Management
Systems installed, enter employees there.  If not,
enter employees in Oracle Engineering.

• Perform this step once for each entity
organization.

In Oracle Engineering:
(N) Setup > Employees

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Defining ECO Approval Lists
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Step 3 - Define Change Order Types (Optional)
• You can assign a change order type to your ECOs

from a seeded list of change order types or you
can define your own.

• You can create change order types for ECOs with
manufacturing items or manufacturing and
engineering items.

• If you skip this step, Oracle shipped change order
types will be used as the default.

• Perform this step once per installation.
In Oracle Engineering: (N) Setup > Change Types

Step 3 - Define Change Order Types (Optional)
• You can assign a change order type to your ECOs

from a seeded list of change order types or you
can define your own.

• You can create change order types for ECOs with
manufacturing items or manufacturing and
engineering items.

• If you skip this step, Oracle shipped change order
types will be used as the default.

• Perform this step once per installation.
In Oracle Engineering: (N) Setup > Change Types

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Defining ECO types
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Step 4 - Define ECO Departments (Optional)
• You can group users that use the ECO system into

one or more departments within you inventory
organization.

• You can restrict access to ECOs by ECO
department.

• You can require an ECO department on all ECOs.
• You can change the ECO department as the ECO

moves through multiple departments.
• Perform this step once per organization.
In Oracle Engineering: (N) Setup > ECO Departments

Step 4 - Define ECO Departments (Optional)
• You can group users that use the ECO system into

one or more departments within you inventory
organization.

• You can restrict access to ECOs by ECO
department.

• You can require an ECO department on all ECOs.
• You can change the ECO department as the ECO

moves through multiple departments.
• Perform this step once per organization.
In Oracle Engineering: (N) Setup > ECO Departments

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Defining ECO Approval Lists
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Step 5 - Define Autonumbering (Optional)
• You can define customized autonumbering for

new ECOs and mass change orders.
• Autonumbering can be by user, organization or

site.
• You can use the assigned autonumber or override

the autonumber and assign your own number.
• Perform this step once per organization user.
In Oracle Engineering: (N) Setup > Autonumbering

Step 5 - Define Autonumbering (Optional)
• You can define customized autonumbering for

new ECOs and mass change orders.
• Autonumbering can be by user, organization or

site.
• You can use the assigned autonumber or override

the autonumber and assign your own number.
• Perform this step once per organization user.
In Oracle Engineering: (N) Setup > Autonumbering

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Defining ECO Autonumbering
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Step 6 - Define Approval Lists (Optional)
• You can define lists of approvers required to

review an ECO before it can be released.
• Oracle engineering can be used to notify people

on the list with an alert, that an ECO requires their
review.

• Note: Oracle Workflow can also be used to notify
approvers; as well as tabulate and evaluate
responses.

• Perform this step once per installation.
In Oracle Engineering: (N) Setup > Approval Lists

Step 6 - Define Approval Lists (Optional)
• You can define lists of approvers required to

review an ECO before it can be released.
• Oracle engineering can be used to notify people

on the list with an alert, that an ECO requires their
review.

• Note: Oracle Workflow can also be used to notify
approvers; as well as tabulate and evaluate
responses.

• Perform this step once per installation.
In Oracle Engineering: (N) Setup > Approval Lists

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Defining ECO Approval Lists
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Step 7 - Define Reasons (Optional)
• You can define reasons for engineering change

orders using your own terminology.
• ECO Reasons are used for your reference only.
• If you skip this step, Oracle shipped reasons will

be used as the default value.
• Perform this step once per organization.
In Oracle Engineering: (N) Setup > Reasons

Step 7 - Define Reasons (Optional)
• You can define reasons for engineering change

orders using your own terminology.
• ECO Reasons are used for your reference only.
• If you skip this step, Oracle shipped reasons will

be used as the default value.
• Perform this step once per organization.
In Oracle Engineering: (N) Setup > Reasons

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Defining ECO Reasons
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Step 8 - Define Priorities (Optional)
• You can define scheduling priorities for ECOs to

describe the urgency of your ECO.
• Priorities are for your reference only.
• If you skip this step, Oracle shipped priorities will

be used as the default value.
• Perform this step once per organization.
In Oracle Engineering: (N) Setup > Priorities

Step 8 - Define Priorities (Optional)
• You can define scheduling priorities for ECOs to

describe the urgency of your ECO.
• Priorities are for your reference only.
• If you skip this step, Oracle shipped priorities will

be used as the default value.
• Perform this step once per organization.
In Oracle Engineering: (N) Setup > Priorities

Help: Oracle Manufacturing Applications > Oracle Engineering >
Setting UP > Defining ECO Priorities
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Step 9 - Start AutoImplement Manager (Optional)
• If you automatically implement ECOs, you must

specify the frequency that you want the
AutoImplement Manager to run.

• Once the ECO has been released to the
AutoImplement manager, you can automatically
implement all scheduled ECO revised items with
effective dates less than or equal to the current
date.

• Perform this step once per organization.
In Oracle Engineering: (N) Setup > AutoImplement

Step 9 - Start AutoImplement Manager (Optional)
• If you automatically implement ECOs, you must

specify the frequency that you want the
AutoImplement Manager to run.

• Once the ECO has been released to the
AutoImplement manager, you can automatically
implement all scheduled ECO revised items with
effective dates less than or equal to the current
date.

• Perform this step once per organization.
In Oracle Engineering: (N) Setup > AutoImplement

Help: Oracle Manufacturing Applications > Oracle Engineering >
Reports and Processes > Starting the AutoImplement Manager
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Engineering includes two pre-coded alerts that you
can use with or without customizing.
• ECO Approval Notification

– Notifies all users on the ECO’s approval list
that an ECO requires their approval

• ECO Use Up Date
– Notifies the ECO planner that a plan date for

use-up item has changed

Engineering includes two pre-coded alerts that you
can use with or without customizing.
• ECO Approval Notification

– Notifies all users on the ECO’s approval list
that an ECO requires their approval

• ECO Use Up Date
– Notifies the ECO planner that a plan date for

use-up item has changed
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Review QuestionReview Question

In order to implement Oracle Engineering you must
do which of the following?
A. Run the Applications Implementation Wizard
B. Perform system wide setups
C. Setup and assign responsibilities to users
D. Setup Oracle Bills of Material
E. Setup Oracle Inventory
F. Setup Oracle General Ledger
G. Setup Oracle Workflow

In order to implement Oracle Engineering you must
do which of the following?
A. Run the Applications Implementation Wizard
B. Perform system wide setups
C. Setup and assign responsibilities to users
D. Setup Oracle Bills of Material
E. Setup Oracle Inventory
F. Setup Oracle General Ledger
G. Setup Oracle Workflow
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In order to implement Oracle Engineering you must
do which of the following?
A. Run the Applications Implementation Wizard
B. Perform system wide setups
C. Setup and assign responsibilities to users
D. Setup Oracle Bills of Material
E. Setup Oracle Inventory
F. Setup Oracle General Ledger
G. Setup Oracle Workflow

In order to implement Oracle Engineering you must
do which of the following?
A. Run the Applications Implementation Wizard
B. Perform system wide setups
C. Setup and assign responsibilities to users
D. Setup Oracle Bills of Material
E. Setup Oracle Inventory
F. Setup Oracle General Ledger
G. Setup Oracle Workflow
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Lesson 3 - Setup for Items and Bills of
Material

Lesson 3 - Setup for Items and Bills of
Material

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary
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Implementation ConsiderationsImplementation Considerations

• How many levels will you structure your bills of
material?

• Will you use phantoms?
• What item templates will you use?
• What item catalog groups will you use?
• Will you use engineering and production items

with bills of material or only production items with
bills of material?

• Will you use reference designators?

• How many levels will you structure your bills of
material?

• Will you use phantoms?
• What item templates will you use?
• What item catalog groups will you use?
• Will you use engineering and production items

with bills of material or only production items with
bills of material?

• Will you use reference designators?



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i - Setting Up and Implementing Engineering
Chapter 6 - Page 26

Implementation Considerations
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Implementation ConsiderationsImplementation Considerations

• Who will be responsible for converting current
bills of material? How will they accomplish the
conversion?

• Who will be responsible for maintaining bills of
material? What process will you use to request
and approve bill of material changes?

• How will you use item revisions?
• What alternate bills of material will you use?
• Will you use copy and common bills?

• Who will be responsible for converting current
bills of material? How will they accomplish the
conversion?

• Who will be responsible for maintaining bills of
material? What process will you use to request
and approve bill of material changes?

• How will you use item revisions?
• What alternate bills of material will you use?
• Will you use copy and common bills?
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• Setup Key Flexfields
• Setup Bills of Material Parameters
• Setup Personal Profiles
• Setup Security Functions
• Request BOM Setup Reports

• Setup Key Flexfields
• Setup Bills of Material Parameters
• Setup Personal Profiles
• Setup Security Functions
• Request BOM Setup Reports
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Key Flexfield SegmentsKey Flexfield Segments

Use the Key Flexfield Segments form to create the
item number flexfield.
In Oracle Engineering: (N) Setup > Flexfields > Key >

Segments
In Oracle Bills of Material: (N) Setup > Flexfields >

Key > Segments

Use the Key Flexfield Segments form to create the
item number flexfield.
In Oracle Engineering: (N) Setup > Flexfields > Key >

Segments
In Oracle Bills of Material: (N) Setup > Flexfields >

Key > Segments

ItemsItems
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Use the Segments Summary form to specify the
number and length of each item flexfield segment.
In Oracle Engineering: (N) Setup > Flexfields > Key >

Segments (B) Segments
In Oracle Bills of Material: (N) Setup > Flexfields >

Key > Segments (B) Segments

Use the Segments Summary form to specify the
number and length of each item flexfield segment.
In Oracle Engineering: (N) Setup > Flexfields > Key >

Segments (B) Segments
In Oracle Bills of Material: (N) Setup > Flexfields >

Key > Segments (B) Segments
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Use the Parameters form to specify the Bill of Material
parameters:
In Oracle Bills of Material: (N) Setup > Parameters
• Max Bill Levels: Enter the number of bill of

material levels that the indented bill of material
explosion should display.

• Inactive Status: Enter an Oracle Inventory item
status to indicate the status that you assign to
configured items that you want Oracle Bills of
Material to delete.

Use the Parameters form to specify the Bill of Material
parameters:
In Oracle Bills of Material: (N) Setup > Parameters
• Max Bill Levels: Enter the number of bill of

material levels that the indented bill of material
explosion should display.

• Inactive Status: Enter an Oracle Inventory item
status to indicate the status that you assign to
configured items that you want Oracle Bills of
Material to delete.
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Use the Parameters form to specify the Bill of Material
parameters: (continued)
In Oracle Bills of Material: (N) Setup > Parameters
• Numbering Segment: Enter the item number

segment that you want to be unique for each
configured item number.

• Numbering Method: Choose a button to specify
the information that the ATO process should place
in the unique segment of configured item
numbers.

Use the Parameters form to specify the Bill of Material
parameters: (continued)
In Oracle Bills of Material: (N) Setup > Parameters
• Numbering Segment: Enter the item number

segment that you want to be unique for each
configured item number.

• Numbering Method: Choose a button to specify
the information that the ATO process should place
in the unique segment of configured item
numbers.
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In the Personal Profile form set your choice for the
personal profile option values in the User Value field.
In Oracle Engineering: (N) Setup > Profiles
In Oracle Bills of Material: (N) Setup > Profiles
• Component Item Sequence Increment: Indicates

the value by which the bill of material form should
increase the component sequence numbers.

• Default Bill of Material Levels: Indicates the
number of bill of material levels that the indented
bill of material explosion should display. This
value defaults to the bill of material parameters.

In the Personal Profile form set your choice for the
personal profile option values in the User Value field.
In Oracle Engineering: (N) Setup > Profiles
In Oracle Bills of Material: (N) Setup > Profiles
• Component Item Sequence Increment: Indicates

the value by which the bill of material form should
increase the component sequence numbers.

• Default Bill of Material Levels: Indicates the
number of bill of material levels that the indented
bill of material explosion should display. This
value defaults to the bill of material parameters.
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• Default WIP Supply Values for Components: Select
“Yes” to instruct Oracle Work In Process to use
values for WIP Supply Type, WIP Supply
Subinventory, and WIP Supply Locator from the
assembly item’s bill of material when creating a
work order or repetitive schedule pick list. Select
No to instruct Oracle Work In Process to use
values for WIP Supply Type, WIP Supply
Subinventory, and WIP Supply Locator from the
component item when creating a work order or
repetitive schedule pick list.

• Model Item Access: Indicates whether the user can
define and update bills of material for model and
option class items.

• Default WIP Supply Values for Components: Select
“Yes” to instruct Oracle Work In Process to use
values for WIP Supply Type, WIP Supply
Subinventory, and WIP Supply Locator from the
assembly item’s bill of material when creating a
work order or repetitive schedule pick list. Select
No to instruct Oracle Work In Process to use
values for WIP Supply Type, WIP Supply
Subinventory, and WIP Supply Locator from the
component item when creating a work order or
repetitive schedule pick list.

• Model Item Access: Indicates whether the user can
define and update bills of material for model and
option class items.
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Personal Profile Values: Bills of Material
• Planning Item Access: Indicates whether a holder

of this responsibility can define and update bills of
material for planning items.

• Standard Item Access: Indicates whether a holder
of this responsibility can define and update bills of
material for standard items.

Personal Profile Values: Bills of Material
• Planning Item Access: Indicates whether a holder

of this responsibility can define and update bills of
material for planning items.

• Standard Item Access: Indicates whether a holder
of this responsibility can define and update bills of
material for standard items.

Bills of MaterialBills of Material
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Personal Profile ValuesPersonal Profile Values

Personal Profile Values: Configured Items
• Check for Duplicate Configuration: Indicates that

the ATO process should search for an existing
configured item before creating a new item. For
this feature to work, you must program the search
method that you want the ATO process to use.

• Configuration Item Delimiter: Indicates the
character that the ATO process should use to
separate the order and line numbers in the item
number segment of newly-configured items. The
ATO process uses this delimiter when you indicate
in the bill-of-material parameters to replace the
base model’s segment value with the order
number/line number.

Personal Profile Values: Configured Items
• Check for Duplicate Configuration: Indicates that

the ATO process should search for an existing
configured item before creating a new item. For
this feature to work, you must program the search
method that you want the ATO process to use.

• Configuration Item Delimiter: Indicates the
character that the ATO process should use to
separate the order and line numbers in the item
number segment of newly-configured items. The
ATO process uses this delimiter when you indicate
in the bill-of-material parameters to replace the
base model’s segment value with the order
number/line number.
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Personal Profile Values—Configured Items
(continued)
• Configuration Item Type: Indicates the item type

that the ATO process should set on the new
configuration items.

• Days Past Before Starting Cutoff of Order Entry
Bills: Indicates the number of past days that
Oracle Bills of Material should save versions of
Order Entry bills of material in the pre-explosions
table.

Personal Profile Values—Configured Items
(continued)
• Configuration Item Type: Indicates the item type

that the ATO process should set on the new
configuration items.

• Days Past Before Starting Cutoff of Order Entry
Bills: Indicates the number of past days that
Oracle Bills of Material should save versions of
Order Entry bills of material in the pre-explosions
table.
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Personal Profile Values—Configured Items
(continued)
• Inherit Option Class Operation Sequence Number:

Indicates whether to allow components on model
bills to inherit operation information from parent
items.

• Perform Lead Time Calculations: Indicates
whether the ATO process should calculate lead
times of newly-configurated items that it creates.

Personal Profile Values—Configured Items
(continued)
• Inherit Option Class Operation Sequence Number:

Indicates whether to allow components on model
bills to inherit operation information from parent
items.

• Perform Lead Time Calculations: Indicates
whether the ATO process should calculate lead
times of newly-configurated items that it creates.
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Security FunctionsSecurity Functions

• Security Functions are maintained by the System
Administrator.

• There are two security functions in engineering
Items:
– Delete: Determines whether engineering items

can be deleted from the Bills of Material
window or the Routings window.

– Revisions: Determines whether revisions for
engineering items can be updated.

• Security Functions are maintained by the System
Administrator.

• There are two security functions in engineering
Items:
– Delete: Determines whether engineering items

can be deleted from the Bills of Material
window or the Routings window.

– Revisions: Determines whether revisions for
engineering items can be updated.
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BOM Setup ReportsBOM Setup Reports

Use the BOM Setup Reports form to request setup
reports.
In Oracle Bills of Material: (N) Reports >Setup > BOM

Setup Reports
• Alternates Report
• Bills of Material Parameters Report
• Department Resources Report
• Workday Exception Sets Report

Use the BOM Setup Reports form to request setup
reports.
In Oracle Bills of Material: (N) Reports >Setup > BOM

Setup Reports
• Alternates Report
• Bills of Material Parameters Report
• Department Resources Report
• Workday Exception Sets Report

ReportsReportsReports
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Review QuestionReview Question

In order to implement Oracle Engineering you must
do which of the following?
A. Run the Applications Implementation Wizard
B. Perform system wide setups
C. Setup and assign responsibilities to users
D. Setup Oracle Bills of Material
E. Setup Oracle Inventory
F. Setup Oracle General Ledger

In order to implement Oracle Engineering you must
do which of the following?
A. Run the Applications Implementation Wizard
B. Perform system wide setups
C. Setup and assign responsibilities to users
D. Setup Oracle Bills of Material
E. Setup Oracle Inventory
F. Setup Oracle General Ledger
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Answer to Review QuestionAnswer to Review Question

Which of the following are not setup steps to
implement items and bills of material?
A. Setup Item Categories Flexfield
B. Setup Bills of Material Parameters
C. Setup Personal Profiles
D. Setup Security Functions
E. Request BOM Setup Reports

Which of the following are not setup steps to
implement items and bills of material?
A. Setup Item Categories Flexfield
B. Setup Bills of Material Parameters
C. Setup Personal Profiles
D. Setup Security Functions
E. Request BOM Setup Reports
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Lesson 4 - Setup for RoutingsLesson 4 - Setup for Routings

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary
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Implementation ConsiderationsImplementation Considerations

• Will you use engineering and production routings
or only production routings?

• Who will be responsible for converting current
routings? How will they accomplish it?

• Who will be responsible for maintaining routings?
What process will you use to request and approve
routing changes?

• How will you use routing revisions?
• What alternate routings will you use?

• Will you use engineering and production routings
or only production routings?

• Who will be responsible for converting current
routings? How will they accomplish it?

• Who will be responsible for maintaining routings?
What process will you use to request and approve
routing changes?

• How will you use routing revisions?
• What alternate routings will you use?
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Implementation Considerations
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Implementation ConsiderationsImplementation Considerations

• Will you use copy and common routings?
• What resources and departments will you use?
• How will you use capacity changes?
• Will you use standard operations?
• How will you determine lead times? Who will be

responsible for converting, entering, and
maintaining lead times? How will they accomplish
it?

• Will you use copy and common routings?
• What resources and departments will you use?
• How will you use capacity changes?
• Will you use standard operations?
• How will you determine lead times? Who will be

responsible for converting, entering, and
maintaining lead times? How will they accomplish
it?

ResourcesResources
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Setup for RoutingsSetup for Routings

• Setup Locations
• Setup Personal Profiles
• Request BOM Setup Reports

• Setup Locations
• Setup Personal Profiles
• Request BOM Setup Reports
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LocationsLocations

Use the Location form to enter location information.
You assign locations to departments that receive
deliveries of outside processing items.
In Oracle Bills of Material: (N) Setup > Locations

Use the Location form to enter location information.
You assign locations to departments that receive
deliveries of outside processing items.
In Oracle Bills of Material: (N) Setup > Locations
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Personal ProfilesPersonal Profiles

In the Personal Profile form set your choice for the
personal profile option values in the User Value field.
In Oracle Engineering: (N) Setup > Profiles
In Oracle Bills of Material: (N) Setup > Profiles
• Hour UOM: Indicates the unit of measure that

represents an hour. You cannot schedule
resources whose unit of measure is not in the
same class as the hour unit of measure.

• Update Resource UOM: Indicates whether you can
update the resource unit of measure.

In the Personal Profile form set your choice for the
personal profile option values in the User Value field.
In Oracle Engineering: (N) Setup > Profiles
In Oracle Bills of Material: (N) Setup > Profiles
• Hour UOM: Indicates the unit of measure that

represents an hour. You cannot schedule
resources whose unit of measure is not in the
same class as the hour unit of measure.

• Update Resource UOM: Indicates whether you can
update the resource unit of measure.
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BOM Setup ReportsBOM Setup Reports

Use the BOM Setup Reports form to request setup
reports.
In Oracle Bills of Material: (N) Reports > Setup > BOM

Setup Reports
• Alternates Report
• Bills of Material Parameters Report
• Department Resources Report
• Workday Exception Sets Report

Use the BOM Setup Reports form to request setup
reports.
In Oracle Bills of Material: (N) Reports > Setup > BOM

Setup Reports
• Alternates Report
• Bills of Material Parameters Report
• Department Resources Report
• Workday Exception Sets Report

ReportsReports
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Review QuestionReview Question

Which of the following are not setup steps to
implement routings?
A. Setup Locations
B. Setup Security Functions
C. Setup and assign responsibilities to users
D. Request BOM Setup Reports

Which of the following are not setup steps to
implement routings?
A. Setup Locations
B. Setup Security Functions
C. Setup and assign responsibilities to users
D. Request BOM Setup Reports
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Answer to Review QuestionAnswer to Review Question

Which of the following are not setup steps to
implement routings?
A. Setup Locations
B. Setup Security Functions
C. Setup and assign responsibilities to users
D. Request BOM Setup Reports

Which of the following are not setup steps to
implement routings?
A. Setup Locations
B. Setup Security Functions
C. Setup and assign responsibilities to users
D. Request BOM Setup Reports
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Lesson 5 - Setup for Product
Maintenance

Lesson 5 - Setup for Product
Maintenance

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary
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Implementation ConsiderationsImplementation Considerations

• When and how will you transfer engineering
product information to production information?
Will you use the same item numbers or different
item numbers between engineering items and
production items?

• When and how will you transfer engineering
product information to production information?
Will you use the same item numbers or different
item numbers between engineering items and
production items?

EngineeringEngineering ProductionProduction
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Implementation Considerations
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Implementation ConsiderationsImplementation Considerations

• Will you use ECOs? What ECO process will you
use? Will you use an approval process and will it
be the process in Oracle Engineering or in Oracle
Workflow?

• Will you use the Use Up functionality? If not, how
will you decide when to implement the change?
How will you evaluate existing discrete jobs and
repetitive schedules in light of an engineering
change?

• Will you use ECOs? What ECO process will you
use? Will you use an approval process and will it
be the process in Oracle Engineering or in Oracle
Workflow?

• Will you use the Use Up functionality? If not, how
will you decide when to implement the change?
How will you evaluate existing discrete jobs and
repetitive schedules in light of an engineering
change?



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i - Setting Up and Implementing Engineering
Chapter 6 - Page 54

Implementation Considerations
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Implementation ConsiderationsImplementation Considerations

• Will you use Oracle Engineering for performing
mass changes? Will you use Oracle Bills of
Material for performing mass changes?

• Will you delete and archive information or only
delete? What information will you delete and
archive? How often and who will delete and
archive information? What delete constraints will
you develop?

• Will you use Oracle Engineering for performing
mass changes? Will you use Oracle Bills of
Material for performing mass changes?

• Will you delete and archive information or only
delete? What information will you delete and
archive? How often and who will delete and
archive information? What delete constraints will
you develop?
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Setup for Product MaintenanceSetup for Product Maintenance

• Start AutoImplement Manager
• Define Deletion Constraints
• Set Personal Profiles
• Set Security Functions
• Request Setup Reports

• Start AutoImplement Manager
• Define Deletion Constraints
• Set Personal Profiles
• Set Security Functions
• Request Setup Reports
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AutoImplement ManagerAutoImplement Manager

Use the Start AutoImplement Manager form to request
the AutoImplement Manager to implement ECO
revised items with status Scheduled whose schedule
date is current or past.
In Oracle Engineering: (N) Setup > AutoImplement

Use the Start AutoImplement Manager form to request
the AutoImplement Manager to implement ECO
revised items with status Scheduled whose schedule
date is current or past.
In Oracle Engineering: (N) Setup > AutoImplement
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Deletion Constraints
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Deletion ConstraintsDeletion Constraints

Use the Deletion Constraints form to view the
deletion

constraints and to create your own deletion
constraints.
In Oracle Engineering: (N) Setup > Delete Constraints
In Oracle Bills of Material: (N) Setup > Delete

Constraints

Use the Deletion Constraints form to view the
deletion

constraints and to create your own deletion
constraints.
In Oracle Engineering: (N) Setup > Delete Constraints
In Oracle Bills of Material: (N) Setup > Delete

Constraints
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Personal ProfilesPersonal Profiles

In the Personal Profile form set your choice for the
personal profile option values in the User Value field.
In Oracle Engineering: (N) Setup > Profiles
In Oracle Bills of Material: (N) Setup > Profiles
• Change Order Autonumbering: Indicates whether

you can define ECO autonumbering for all users or
for yourself only.

• ECO Department: Indicates the default department
that Oracle Engineering uses when you define an
ECO and restricts you to viewing and updating
ECOs controlled by your department.

In the Personal Profile form set your choice for the
personal profile option values in the User Value field.
In Oracle Engineering: (N) Setup > Profiles
In Oracle Bills of Material: (N) Setup > Profiles
• Change Order Autonumbering: Indicates whether

you can define ECO autonumbering for all users or
for yourself only.

• ECO Department: Indicates the default department
that Oracle Engineering uses when you define an
ECO and restricts you to viewing and updating
ECOs controlled by your department.
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Personal Profiles
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Personal ProfilesPersonal Profiles

• ECO Revision Warning: Indicates whether to
implement ECO revisions with pending lower level
revisions. Regardless of your choice, Oracle
Engineering issues a warning message when this
situation occurs.

• Engineering Item Change Order Access: Indicates
whether you can revise engineering items in
ECOs.

• Mandatory ECO Departments: Indicates whether
you must assign a department to each ECO.

• ECO Revision Warning: Indicates whether to
implement ECO revisions with pending lower level
revisions. Regardless of your choice, Oracle
Engineering issues a warning message when this
situation occurs.

• Engineering Item Change Order Access: Indicates
whether you can revise engineering items in
ECOs.

• Mandatory ECO Departments: Indicates whether
you must assign a department to each ECO.
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Personal Profiles
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Personal ProfilesPersonal Profiles

• Model Item Change Order Access: Indicates
whether you can revise model and option class
items on ECOs.

• Planning Item Change Order Access: Indicates
whether you can revise planning items on ECOs.

• Require Revised Item New Revision: Indicates
whether you must assign a new revision to revised
items on ECOs.

• Standard Item Change Order Access: Indicates
whether you can revise standard items on ECOs.

• Model Item Change Order Access: Indicates
whether you can revise model and option class
items on ECOs.

• Planning Item Change Order Access: Indicates
whether you can revise planning items on ECOs.

• Require Revised Item New Revision: Indicates
whether you must assign a new revision to revised
items on ECOs.

• Standard Item Change Order Access: Indicates
whether you can revise standard items on ECOs.
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Security FunctionsSecurity Functions

• Security Functions are maintained by the System
Administrator.

• There are nine security functions for engineering
change orders:
– Approvals: Determines whether you can

submit or abort an ECO approval Workflow
process.

– Cancel: Determines whether you can cancel
ECOs.

• Security Functions are maintained by the System
Administrator.

• There are nine security functions for engineering
change orders:
– Approvals: Determines whether you can

submit or abort an ECO approval Workflow
process.

– Cancel: Determines whether you can cancel
ECOs.
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Security Functions
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Security FunctionsSecurity Functions

• ECO Security Functions: (continued)
– Implement: Determines whether you can

implement ECOs.
– Release: Determines whether you can release

ECOs.
– Reschedule: Determines whether you can

reschedule ECOs.
– Schedule: Determines whether you can

schedule ECOs.

• ECO Security Functions: (continued)
– Implement: Determines whether you can

implement ECOs.
– Release: Determines whether you can release

ECOs.
– Reschedule: Determines whether you can

reschedule ECOs.
– Schedule: Determines whether you can

schedule ECOs.
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Security Functions
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Security FunctionsSecurity Functions

• ECO Security Functions: (continued)
– Update: Determines whether ECOs can be

updated.
– Delete: Determines whether you can delete

engineering items from the Bills of Material
window or the Routings window.

– Transfer: Determines whether you can transfer
engineering items to manufacturing.

• ECO Security Functions: (continued)
– Update: Determines whether ECOs can be

updated.
– Delete: Determines whether you can delete

engineering items from the Bills of Material
window or the Routings window.

– Transfer: Determines whether you can transfer
engineering items to manufacturing.
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BOM Setup ReportsBOM Setup Reports

Use the BOM Setup Reports form to request setup
reports.
In Oracle Bills of Material: (N) Reports > Setup > BOM

Setup Reports
• Alternates Report
• Bills of Material Parameters Report
• Department Resources Report
• Workday Exception Sets Report

Use the BOM Setup Reports form to request setup
reports.
In Oracle Bills of Material: (N) Reports > Setup > BOM

Setup Reports
• Alternates Report
• Bills of Material Parameters Report
• Department Resources Report
• Workday Exception Sets Report

ReportsReports
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Review QuestionReview Question

Which of the following statements are true?
A. Oracle Bills Of Material can be used to transfer

product data to Oracle Engineering.
B. The AutoImplement Manager is not required when

using Oracle Workflow to approve ECOs.
C. The Revisions security function applies to ECOs.
D. An engineering profile can be set to make ECO

Reasons a mandatory field on ECOs.

Which of the following statements are true?
A. Oracle Bills Of Material can be used to transfer

product data to Oracle Engineering.
B. The AutoImplement Manager is not required when

using Oracle Workflow to approve ECOs.
C. The Revisions security function applies to ECOs.
D. An engineering profile can be set to make ECO

Reasons a mandatory field on ECOs.
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Answer to Review QuestionAnswer to Review Question

Which of the following statements are true?
A. Oracle Bills Of Material can be used to transfer product

data to Oracle Engineering.
B. The AutoImplement Manager is not required when

using Oracle Workflow to approve ECOs.
C. The Revisions security function applies to ECOs.
D. An engineering profile can be set to make ECO

Reasons a mandatory field on ECOs.

Which of the following statements are true?
A. Oracle Bills Of Material can be used to transfer product

data to Oracle Engineering.
B. The AutoImplement Manager is not required when

using Oracle Workflow to approve ECOs.
C. The Revisions security function applies to ECOs.
D. An engineering profile can be set to make ECO

Reasons a mandatory field on ECOs.
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Lesson 6 - SummaryLesson 6 - Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary

• Product Overview
• Module setup
• Setup to enter Items and Bills of Material
• Setup to enter Routings
• Setup to perform Product Maintenance
• Summary
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SummarySummary

In this course, you should have learned how to:
• Setup the Oracle Engineering module
• Identify implementation considerations
• Prepare to enter items, bills of material and

routings
• Prepare to perform transfers, engineering changes

mass changes and deletions

In this course, you should have learned how to:
• Setup the Oracle Engineering module
• Identify implementation considerations
• Prepare to enter items, bills of material and

routings
• Prepare to perform transfers, engineering changes

mass changes and deletions
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Appendix - Engineering ProfilesAppendix - Engineering Profiles

• ENG: Change Autonumbering - System
Administrator Access
– Indicate whether you can define ECO

autonumbering for all users or just yourself.
• ENG: ECO Department

– Indicate the default department used when you
define an ECO.  Departments are used to
control access to update ECO data.

• ENG: ECO Revision Warning
– Indicate whether to raise a warning but still

implement ECO revisions with pending lower
level revisions (Yes), or to raise an error and
not perform the implementation (No or blank)

• ENG: Change Autonumbering - System
Administrator Access
– Indicate whether you can define ECO

autonumbering for all users or just yourself.
• ENG: ECO Department

– Indicate the default department used when you
define an ECO.  Departments are used to
control access to update ECO data.

• ENG: ECO Revision Warning
– Indicate whether to raise a warning but still

implement ECO revisions with pending lower
level revisions (Yes), or to raise an error and
not perform the implementation (No or blank)
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Appendix - Engineering ProfilesAppendix - Engineering Profiles

• ENG: Engineering Item Change Order Access
– Indicate whether you can revise items on

ECOs.
• ENG: Mandatory ECO Departments

– Indicate whether it is mandatory to assign a
department to each ECO to enforce data
security.

• ENG: Model Item Change Order Access
– Indicate whether you can revise model and

option class items on ECOs.

• ENG: Engineering Item Change Order Access
– Indicate whether you can revise items on

ECOs.
• ENG: Mandatory ECO Departments

– Indicate whether it is mandatory to assign a
department to each ECO to enforce data
security.

• ENG: Model Item Change Order Access
– Indicate whether you can revise model and

option class items on ECOs.
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Appendix - Engineering ProfilesAppendix - Engineering Profiles

• ENG: Planning Item Change Order Access
– Indicate whether you can revise planning

items on ECOs.
• ENG: Require Revised Item New Revisions

– Indicate whether it is mandatory to assign a
new revision to revised items on ECOs.  Blank
or “null” is equivalent to No.

• ENG: Standard Item Change Order Access
– Indicate whether you can revise standard

items on ECOs.

• ENG: Planning Item Change Order Access
– Indicate whether you can revise planning

items on ECOs.
• ENG: Require Revised Item New Revisions

– Indicate whether it is mandatory to assign a
new revision to revised items on ECOs.  Blank
or “null” is equivalent to No.

• ENG: Standard Item Change Order Access
– Indicate whether you can revise standard

items on ECOs.
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Appendix - Security FunctionsAppendix - Security Functions

During Implementation, the system administrator sets
up and maintains security functions as well as profile
options.
• Engineering Change Orders: Approvals

(ENG_ENGFDECN_APPROVAL)
– Determines whether an ECO Workflow process

can be submitted or aborted.
• Engineering Change Orders: Cancel

(ENG_ENGFDECN_CANCEL)
– Determines whether ECOs can be cancelled.

During Implementation, the system administrator sets
up and maintains security functions as well as profile
options.
• Engineering Change Orders: Approvals

(ENG_ENGFDECN_APPROVAL)
– Determines whether an ECO Workflow process

can be submitted or aborted.
• Engineering Change Orders: Cancel

(ENG_ENGFDECN_CANCEL)
– Determines whether ECOs can be cancelled.
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• Engineering Change Orders: Implement
(ENG_ENGFDECN_IMPLEMENT)
– Determines whether ECOs can be

implemented.
• Engineering Change Orders: Release

(ENG_ENGFDECN_RELEASE)
– Determines whether ECOs can be released.

• Engineering Change Orders: Reschedule
(ENG_ENGFDECN_RESCHEDULE)
– Determines whether ECOs can be rescheduled.

• Engineering Change Orders: Implement
(ENG_ENGFDECN_IMPLEMENT)
– Determines whether ECOs can be

implemented.
• Engineering Change Orders: Release

(ENG_ENGFDECN_RELEASE)
– Determines whether ECOs can be released.

• Engineering Change Orders: Reschedule
(ENG_ENGFDECN_RESCHEDULE)
– Determines whether ECOs can be rescheduled.
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• Engineering Change Orders: Schedule
(ENG_ENGFDECN_SCHEDULE)
– Determines whether ECOs can be scheduled.

• Engineering Change Orders: Update
(ENG_ENGFDECN_UPDATE)
– Determines whether ECOs can be updated.

• Engineering Change Orders: Delete
(ENG_INVIDITM_DELETE)
– Determines whether engineering items can be

deleted from the Bills of Material or Routings
windows.

• Engineering Change Orders: Schedule
(ENG_ENGFDECN_SCHEDULE)
– Determines whether ECOs can be scheduled.

• Engineering Change Orders: Update
(ENG_ENGFDECN_UPDATE)
– Determines whether ECOs can be updated.

• Engineering Change Orders: Delete
(ENG_INVIDITM_DELETE)
– Determines whether engineering items can be

deleted from the Bills of Material or Routings
windows.
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• Engineering Change Orders: Revisions
(ENG_INVIDITM_REVISIONS)
– Determines whether revisions for engineering

items can be updated.
• Engineering Change Orders: Transfer

(ENG_INVIDITM_TRANSFER)
– Determines whether engineering items can be

transferred to manufacturing.

• Engineering Change Orders: Revisions
(ENG_INVIDITM_REVISIONS)
– Determines whether revisions for engineering

items can be updated.
• Engineering Change Orders: Transfer

(ENG_INVIDITM_TRANSFER)
– Determines whether engineering items can be

transferred to manufacturing.
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